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Safety information
Connect the power cord to a properly grounded electrical outlet that is near the product and easily accessible.

Do not place or use this product near water or wet locations.

CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or performance of
procedures other than those specified herein may result in hazardous radiation exposure.

This product uses a printing process that heats the print media, and the heat may cause the media to release emissions.
You must understand the section in your operating instructions that discusses the guidelines for selecting print media
to avoid the possibility of harmful emissions.

Use care when you replace a lithium battery.

CAUTION—POTENTIAL INJURY: There is a danger of explosion if a lithium battery is incorrectly replaced.
Replace it only with the same or an equivalent type of lithium battery. Do not recharge, disassemble, or
incinerate a lithium battery. Discard used batteries according to the manufacturer's instructions and local
regulations.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to move it safely.

CAUTION—POTENTIAL INJURY:  Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the wall outlet.

• Disconnect all cords and cables from the printer before moving it.

• Lift the printer off the optional drawer, and set it aside instead of trying to lift the drawer and printer at the same
time.

Note: Use the handholds located on both sides and rear of the printer to lift it off the optional drawer.

• Make sure your fingers are not under the printer when you set it down.

• Before setting up the printer, make sure there is adequate clearance around it.

Use only the power cord provided with this product or the manufacturer's authorized replacement.

Use only the telecommunications (RJ‑11) cord provided with this product or a 26 AWG or larger replacement when
connecting this product to the public switched telephone network.

CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and telephone system
connections) are properly installed in their marked plug-in ports.

This product is designed, tested, and approved to meet strict global safety standards with the use of specific
manufacturer's components. The safety features of some parts may not always be obvious. The manufacturer is not
responsible for the use of other replacement parts.
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CAUTION—POTENTIAL INJURY:  Do not cut, twist, bind, crush, or place heavy objects on the power cord. Do not
subject the power cord to abrasion or stress. Do not pinch the power cord between objects such as furniture
and walls. If any of these things happen, a risk of fire or electrical shock results. Inspect the power cord regularly
for signs of such problems. Remove the power cord from the electrical outlet before inspecting it.

Refer service or repairs, other than those described in the user documentation, to a professional service person.

CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the printer, unplug
the power cord from the wall outlet and disconnect all cables from the printer before proceeding.

CAUTION—SHOCK HAZARD: Do not use the fax feature during a lightning storm. Do not set up this product or
make any electrical or cabling connections, such as the fax feature, power cord, or telephone, during a lightning
storm.

CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using a high-capacity input tray, a duplex unit and an input
option, or more than one input option. If you purchased a multifunction printer (MFP) that scans, copies, and
faxes, you may need additional furniture. For more information, see www.lexmark.com/multifunctionprinters.

SAVE THESE INSTRUCTIONS.
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Learning about the printer

Finding information about the printer

User's Guide, Help, and more information
• Check the User's Guide for information on:

– The touch screen and its applications.

– Setting up and using printer software.

– Caring for and maintaining the printer.

The User's Guide is available on our Web site at www.lexmark.com/publications.

• Windows or Mac Help—Open a printer software program or application, and then click Help.

Click ?  to view context‑sensitive information.

Notes:

– The Help installs automatically with the printer software.

– The printer software is located in the printer Program folder or on the desktop, depending on your operating
system.

• Lexmark Support Web site—support.lexmark.com

Note: Select your country or region, and then select your product to view the appropriate support site.

E‑mail support, live chat support, telephone support numbers, and hours of operation for your country or region
can be found on the Support Web site or on the printed warranty that came with your printer.

Record the following information (located on the store receipt and the back of the printer), and have it ready when
you contact support so that they may serve you faster:

– Machine Type number

– Serial number

– Date purchased

– Store where purchased

Selecting a location for the printer
When selecting a location for the printer, leave enough room to open trays, covers, and doors. If you plan to install any
options, leave enough room for them also. It is important to:

• Make sure airflow in the room meets the latest revision of the ASHRAE 62 standard.

• Provide a flat, sturdy, and stable surface.

• Keep the printer:

– Away from the direct airflow of air conditioners, heaters, or ventilators

– Free from direct sunlight, humidity extremes, or temperature fluctuations

– Clean, dry, and free of dust

• Allow the following recommended amount of space around the printer for proper ventilation:
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1

2
3

4

5

1 Right Side 31 cm (12 in.)

2 Left Side 31 cm (12 in.)

3 Front 51 cm (20 in.)

4 Rear 31 cm (12 in.)

5 Top12 137 cm (54 in.)

1 Allows for addition of all output options.
2 Without output options, clearance above the printer should be 12 cm (4.5 in.).
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Printer configurations

Basic model

1 2

3

4

1 2

3

4

Feature Paper Capacity1

1 Standard exit bin 550 sheets

2 Printer control panel with touch screen Not applicable

3 Multipurpose feeder 100 sheets

4 Standard tray (Tray 1) 550 sheets

1 Based on 75 g/m2 (20 lb) paper.

Fully configured model
CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using a high-capacity input tray, a duplex unit and an input
option, or more than one input option. If you purchased a multifunction printer (MFP) that scans, copies, and
faxes, you may need additional furniture. For more information, see www.lexmark.com/multifunctionprinters.
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4
3

2

5

6

1

Feature/Option Paper Capacity1

1 5‑bin mailbox2 500 sheets

2 5‑bin mailbox 500 sheets

3 Optional tray (Tray 2) 250 or 550 sheets

4 Optional tray (Tray 3) 250 or 550 sheets

5 Optional 2000‑sheet tray (Tray 4) 2000 sheets

6 Caster base Not applicable

1 Based on 75 g/m2 (20 lb) paper.
2 The printer supports up to three output expander units, two 5‑bin mailbox units, one high capacity output expander (not
depicted), and one stapler unit (not depicted). Other combinations of options are possible. Contact the place where you
purchased the printer.

Understanding the home screen
After the printer is turned on and a short warm-up period occurs, the display shows a basic screen which is referred to
as the home screen. Use the home screen buttons to initiate an action such as printing a form, opening the menu
screen, or responding to messages.

Note: Buttons appearing on the home screen may vary depending on home screen customization settings.
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Display item Description

1 Showroom Shows the functions of your printer

2 Change background Changes the background on the home screen

3 Menus Opens the menus. These menus are available only when the printer is in the Ready
state.

4 Eco‑Settings Determines how your printer saves paper, toner, and energy

5 Bookmarks Takes you to your bookmarks, where you can edit, access, or save bookmarks

6 Change Language Lets you select the language you prefer

7 Status message bar • Shows the current printer status, such as Ready or Busy

• Shows printer conditions such as Toner Low

• Shows intervention messages to give instructions on what you should do so the
printer can continue processing, such as Close door

8 Status/Supplies Appears on the display whenever the printer status includes a message requiring
intervention. Touch it to access the messages screen for more information on the
message, including how to clear it.

9 Forms and Favorites Provides access to frequently used forms and printed materials
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Other buttons may appear on the home screen, such as:

Display item Description

Search Held Jobs Searches on any of the following items and returns search results:

• User names for held or confidential print jobs

• Job names for held jobs, excluding confidential print jobs

• Profile names

• Bookmark container or job names

• USB container or job names for supported extensions only

Held Jobs Opens a screen containing all the held jobs

Lock Device Appears on the screen when the printer is unlocked and a Device Lockout Personal
Identification Number (PIN) has been set.

Touching this button opens a PIN entry screen. Entering the correct PIN locks the printer
control panel (touch screen and hard buttons).

Unlock Device Appears on the screen when the printer is locked. The printer control panel buttons
and shortcuts cannot be used while it appears.

Touching this button opens a PIN entry screen. Entering the correct PIN unlocks the
printer control panel (touch screen and hard buttons).

More Information Appears on the display when the user must interact with the printer to continue printing.
“More information” provides step‑by‑step instructions with clear drawings to show you
how to perform such tasks as changing the toner cartridges.
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Additional printer setup

Installing internal options
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

Available internal options
• Memory cards

– Printer memory

– Flash memory

– Fonts

• Firmware cards

– Bar Code and Forms

– IPDS and SCS/TNe

– PrintCryptionTM

• LexmarkTM Internal Solutions Ports (ISP)

– RS‑232‑C Serial ISP

– Parallel 1284‑B ISP

– MarkNetTM N8150 802.11 b/g/n Wireless ISP

– MarkNet N8130 10/100 Fiber ISP

– MarkNet N8120 10/100/1000 Ethernet ISP
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Accessing the system board to install internal options
Note: This task requires a flathead screwdriver.

CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

1 Open the system board door.

2 Loosen the screw(s) on the system board cover.
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3 Remove the system board cover.

4 Use the illustration below to locate the appropriate connector.

Warning—Potential Damage: System board electronic components are easily damaged by static electricity.
Touch something metal on the printer before touching any system board electronic components or connectors.

1

2

3

1 Firmware and flash memory card connectors

2 Memory card connector

3 Lexmark Internal Solutions Port or printer hard disk connector
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Installing a memory card
Note: This task requires a flathead screwdriver.

CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

Warning—Potential Damage: System board electronic components are easily damaged by static electricity. Touch
something metal on the printer before touching any system board electronic components or connectors.

An optional memory card can be purchased separately and attached to the system board. To install the memory card:

1 Access the system board.

1

3

2

2 Unpack the memory card.

Note: Avoid touching the connection points along the edge of the card.

3 Open the memory card connector latches.
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4 Align the notches on the memory card with the ridges on the connector.

2

1

1 Notches

2 Ridges

5 Push the memory card straight into the connector until it snaps into place.

6 Replace the system board cover and close the system board door.

2

3

1

Installing a flash memory or firmware card

Note: This task requires a flathead screwdriver.
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The system board has two connections for an optional flash memory or firmware card. Only one of each may be installed,
but the connectors are interchangeable.

CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

Warning—Potential Damage: System board electronic components are easily damaged by static electricity. Touch
something metal on the printer before touching any system board electronic components or connectors.

1 Access the system board.

1

3

2

2 Unpack the card.

Note: Avoid touching any electrical components on the card.

3 Holding the card by its sides, align the plastic pins on the card with the holes on the system board.

1

2

1 Plastic pins

2 Metal pins
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4 Push the card firmly into place.

Notes:

• The entire length of the connector on the card must touch and be flush against the system board.

• Be careful not to damage the connectors.

5 Replace the system board cover and close the system board door.

2

3

1
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Installing an Internal Solutions Port
The system board supports one optional Lexmark Internal Solutions Port (ISP). Install an ISP for additional connectivity
options.

Note: This task requires a flathead screwdriver.

CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

Warning—Potential Damage: System board electronic components are easily damaged by static electricity. Touch
something metal on the printer before touching any system board electronic components or connectors.

1 Access the system board.

1

3

2

2 Remove the hard disk:

a Unplug the printer hard disk interface cable from the system board, leaving the cable attached to the printer
hard disk. To unplug the cable, squeeze the paddle at the plug of the interface cable to disengage the latch
before pulling the cable out.
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b Remove the screws holding the printer hard disk in place.

c Remove the printer hard disk by pulling it upward to unseat the standoffs.

d Remove the thumbscrews that attach the printer hard disk mounting bracket to the printer hard disk, and then
remove the bracket. Set the printer hard disk aside.
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3 Unpack the ISP and plastic tee.

Note: Avoid touching the components on the card.

4 Locate the appropriate connector on the system board.

5 Remove the metal cover from the ISP opening.

2

1
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6 Align the posts of the plastic tee to the holes in the system board, and then press downward until the tee snaps
into place. Be sure each post of the tee has latched completely, and that the tee is seated firmly onto the system
board.

7 Install the ISP onto the plastic tee. Angle the ISP over the plastic tee, and then approach the plastic tee so that any
overhanging connectors will pass through the ISP opening in the system board cage.
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8 Lower the ISP toward the plastic tee until the ISP is seated between the guides of the plastic tee.

9 Insert the long thumbscrew and turn it clockwise enough to hold the ISP in place, but do not tighten the thumbscrew
at this time.

10 Attach the two provided screws to secure the ISP mounting bracket to the system board cage.

11 Tighten the long thumbscrew.

Note: Do not overtighten the thumbscrew.
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12 Insert the plug of the ISP interface cable into the receptacle of the system board.

Note: The plugs and receptacles are color coded.

13 Reattach the hard drive to the ISP.

a Align the standoffs of the printer hard disk with the holes in the ISP, and then press downward on the printer
hard disk until the standoffs have seated into place.

b Insert the plug of the printer hard disk interface cable into the receptacle of the ISP.

Note: The plugs and receptacles are color coded.
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14 Replace the system board cover and close the system board door.

2

3

1

Installing hardware options

Order of installation

CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using a high-capacity input tray, a duplex unit and an input
option, or more than one input option. If you purchased a multifunction printer (MFP) that scans, copies, and
faxes, you may need additional furniture. For more information, see www.lexmark.com/multifunctionprinters.

CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

Install the printer and any options you have purchased in the following order:

1 Printer stand or caster base

2 2000‑sheet tray

3 250‑ or 550‑sheet tray

4 Printer

CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to move it safely.

For more information on installing a printer stand, caster base, or 2000‑sheet tray, see the setup documentation that
came with the option.
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Installing drawers
The printer supports up to four optional drawers. A drawer consists of a tray and a support unit. All drawers are installed
the same way.

CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

1 Unpack the drawer, and then remove any packing material.

2 Place the drawer in the location chosen for the printer.

Note: If you have multiple options to install, then see the section about the recommended order of installation.
The 2000‑sheet drawer must be the bottom drawer.

3 Align the printer with the drawer, and then lower the printer into place.

CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to move it safely.

4 Update the options in the printer driver after you have completed installation.

Removing an optional drawer

Warning—Potential Damage: Lifting the printer from a drawer without pushing in the safety latches could damage
the latches.
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To remove an optional drawer, push in the safety latches on both sides of the drawer until they click. The safety latches
stay recessed, so it is easier to lift the printer.

Attaching cables
CAUTION—POTENTIAL INJURY: Do not use the fax feature during a lightning storm. Do not set up this product
or make any electrical or cabling connections, such as the fax feature, power cord, or telephone, during a
lightning storm.

Connect the printer to the computer using a USB cable or Ethernet cable.

Be sure to match the following:

• The USB symbol on the cable with the USB symbol on the printer

• The appropriate Ethernet cable to the Ethernet port
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1

2

1 USB port

Warning—Potential Damage: Do not touch the USB cable, any network adapter, or the printer in the area shown
while actively printing. A loss of data or a malfunction can occur.

2 Ethernet port
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Loading paper

Loading paper in the 250- and 550-sheet trays

2

1

Squeeze and move the width guide to the correct position for
the paper size being loaded.

1 2

3

Squeeze and move the length guide to the correct position
for the paper size being loaded.

Flex and fan the paper, and then straighten the edges on a
level surface before loading it in the tray.

Do not load paper past the fill line.
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Loading paper in the 2000‑sheet tray

Pull up and slide the width guide to the correct position for the paper
size being loaded.

Unlock the length guide.

Push the length guide release latch to raise the length guide, slide the guide to the correct position for the paper size being
loaded, and then lock the guide.
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Flex and fan the paper, and then straighten the edges on a level surface before loading
it in the tray.

Do not load paper past the fill line.

Loading paper in the multipurpose feeder

Note: From the home screen, set the Paper Size and Paper Type. To access the paper menus, touch  >Paper
Menu > Paper Size/Type.

Squeeze and slide the width guide to the far right.

Flex and fan the paper or specialty media, and then straighten the
edges on a level surface before loading it in the tray.
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Slide the paper gently into the multipurpose feeder until it comes to a
stop, and then adjust the width guide to lightly touch the edge of the
paper stack.

Notes:

• Make sure the paper fits loosely in the
multipurpose feeder, lies flat, and is not
bent or wrinkled.

• Do not exceed the maximum stack height by
forcing paper under the stack height limiter.

• Load only one size and type of media at a
time.

• Load envelopes with the flap side down and
to the left as shown on the tray.

Warning—Potential Damage: Never use
envelopes with stamps, clasps, snaps, windows,
coated linings, or self‑stick adhesives. These
envelopes may severely damage the printer.

Loading letterhead

In the 250‑ or 550‑sheet trays

Without an optional StapleSmartTM II Finisher With an optional StapleSmart II Finisher

LETTERHEAD

Single‑sided printing

LETTERHEAD

Single‑sided printing
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Without an optional StapleSmartTM II Finisher With an optional StapleSmart II Finisher

LETTERHEAD

Duplex (two‑sided) printing Duplex (two‑sided) printing

In the 2000‑sheet tray

Without an optional StapleSmart II Finisher With an optional StapleSmart II Finisher

LETTERHEAD

Single‑sided printing

LETTERHEAD

Single‑sided printing
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Without an optional StapleSmart II Finisher With an optional StapleSmart II Finisher

LETTERHEAD

Duplex (two‑sided) printing

LETTERHEAD
LETTERHEAD

Duplex (two‑sided) printing

In the multipurpose feeder

Without an optional StapleSmart II Finisher With an optional StapleSmart II Finisher

LETTERHEAD

Single‑sided printing

LETTERHEAD

Single‑sided printing
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Without an optional StapleSmart II Finisher With an optional StapleSmart II Finisher

LETTERHEAD

Duplex (two‑sided) printing

LETTERHEAD

Duplex (two‑sided) printing

Linking and unlinking trays

Linking trays
Tray linking is useful for large print jobs or multiple copies. When one linked tray is empty, paper feeds from the next
linked tray. When the Paper Size and Paper Type settings are the same for any trays, the trays are automatically linked.

The printer automatically senses the Paper Size setting according to the position of the paper guides in each tray except
the multipurpose feeder. The printer can sense A4, A5, JIS B5, Letter, Legal, Executive, and Universal paper sizes. The
multipurpose feeder and trays using other paper sizes can be linked manually using the Paper Size menu available from
the Paper Size/Type menu.

Note: To link the multipurpose feeder, Configure MP must be set to Cassette in the Paper menu in order for MP
Feeder Size to appear as a menu item.

The Paper Type setting must be set for all trays from the Paper Type menu available from the Paper Size/Type menu.

Unlinking trays
Unlinked trays have settings that are not the same as the settings of any other tray.
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To unlink a tray, change the following tray settings so that they do not match the settings of any other tray:

• Paper Type (for example: Plain Paper, Letterhead, Custom Type <x>)

Paper Type names describe the paper characteristics. If the name that best describes your paper is used by linked
trays, assign a different Paper Type name to the tray, such as Custom Type <x>, or define your own custom name.

• Paper Size (for example: letter, A4, statement)

Load a different paper size to change the Paper Size setting for a tray automatically. Paper Size settings for the
multipurpose feeder are not automatic; they must be set manually from the Paper Size menu.

Warning—Potential Damage: Do not assign a Paper Type name that does not accurately describe the type of paper
loaded in the tray. The temperature of the fuser varies according to the specified Paper Type. Paper may not be
properly processed if an inaccurate Paper Type is selected.

Linking exit bins
The standard exit bin holds up to 550 sheets of 20‑lb paper. If you need additional output capacity, you can purchase
other optional exit bins.

Note: Not all exit bins support every paper size and type.

Linking exit bins lets you create a single output source so the printer can automatically switch output to the next available
exit bin.

1 Make sure the printer is on and Ready appears.

2 On the home screen, touch .

3 Touch Paper Menu.

4 Touch Bin Setup.

5 Touch the correct bin or bins.

6 Touch Configure Bins.

7 Touch Link.

Verifying printer setup
Once all hardware and software options are installed and the printer is turned on, verify that the printer is set up
correctly by printing the following:

• Menu settings page—Use this page to verify that all printer options are installed correctly. A list of installed options
appears toward the bottom of the page. If an option you installed is not listed, then it is not installed correctly.
Remove the option and install it again.

• Network setup page—If your printer is a network model and is attached to a network, print a network setup page
to verify the network connection. This page also provides important information that aids network printing
configuration.
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Printing a menu settings page
Print a menu settings page to review the current menu settings and to verify printer options are installed correctly.

Note: If you have not made any menu item settings changes yet, then the menu settings page lists all the factory
default settings. Once you select and save other settings from the menus, they replace the factory default settings as
user default settings. A user default setting remains in effect until you access the menu again, choose another value,
and save it. To restore the factory default settings, see “Restoring the factory default settings” on page 169.

1 Make sure the printer is on and Ready appears.

2 On the home screen, touch .

3 Touch Reports.

4 Touch Menu Settings Page.

The menu settings page prints and the printer returns to the home screen.

Printing a network setup page
If the printer is attached to a network, then print a network setup page to verify the network connection. This page
also provides important information that aids network printing configuration.

1 Make sure the printer is on and Ready appears.

2 On the home screen, touch .

3 Touch Reports.

4 Touch Network Setup Page.

The network setup page prints and the printer returns to the home screen.

5 Check the first section on the network setup page, and confirm that Status is “Connected.”

If Status is “Not Connected,” then the LAN drop may not be active, the network cable may be malfunctioning, or,
if you have a wireless printer model, the wireless network may not be configured properly. Consult a system support
person for a solution, and then print another network setup page.

Setting up the printer software

Installing printer software
A printer driver is software that lets the computer communicate with the printer. The printer software is typically
installed during the initial printer setup. If you need to install the software after setup, follow these instructions:

For Windows users

1 Close all open software programs.

2 Insert the Software and Documentation CD.

3 From the main installation dialog, click Install.

4 Follow the instructions on the screen.
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For Macintosh users

1 Close all open software applications.

2 Insert the Software and Documentation CD.

3 From the Finder desktop, double-click the printer CD icon that automatically appears.

4 Double-click the Install icon.

5 Follow the instructions on the screen.

Using the World Wide Web

1 Go to the Lexmark Web site at www.lexmark.com.

2 From the Drivers & Downloads menu, click Driver Finder.

3 Select your printer, and then select your operating system.

4 Download the driver and install the printer software.

Updating available options in the printer driver
Once the printer software and any options are installed, it may be necessary to manually add the options in the printer
driver to make them available for print jobs.

For Windows users

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type control printers.

3 Press Enter, or click OK.

The printer folder opens.

4 Select the printer.

5 Right‑click the printer, and then select Properties.

6 Click the Install Options tab.

7 Under Available Options, add any installed hardware options.

8 Click Apply.

For Macintosh users

In Mac OS X version 10.5 or later

1 From the Apple menu, choose System Preferences.

2 Click Print & Fax.

3 Select the printer, and then click Options & Supplies.

4 Click Driver, and then add any installed hardware options.

5 Click OK.
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In Mac OS X version 10.4 and earlier

1 From the Finder desktop, choose Go > Applications.

2 Double‑click Utilities, and then double‑click Print Center or Printer Setup Utility.

3 Select the printer, and then from the Printers menu, choose Show Info.

4 From the pop‑up menu, choose Installable Options.

5 Add any installed hardware options, and then click Apply Changes.

Setting up wireless printing

Information you will need to set up the printer on a wireless network
Note: Do not connect the installation or network cables until prompted to do so by the setup software.

• SSID—The SSID is also referred to as the network name.

• Wireless Mode (or Network Mode)—The mode will be either infrastructure or ad hoc.

• Channel (for ad hoc networks)—The channel defaults to auto for infrastructure networks.

Some ad hoc networks will also require the auto setting. Check with your system support person if you are not sure
which channel to select.

• Security Method—There are three basic options for Security Method:

– WEP key
If your network uses more than one WEP key, enter up to four in the provided spaces. Select the key currently
in use on the network by selecting the Default WEP Transmit Key.
or

– WPA or WPA2 passphrase
WPA includes encryption as an additional layer of security. The choices are AES or TKIP. Encryption must be set
for the same type on the router and on the printer, or the printer will not be able to communicate on the
network.

– No security
If your wireless network does not use any type of security, then you will not have any security information.

Note: Using an unsecured wireless network is not recommended.

If you are installing the printer on an 802.1X network using the Advanced method, then you may need the following:

• Authentication type

• Inner authentication type

• 802.1X username and password

• Certificates

Note: For more information on configuring 802.1X security, see the Networking Guide on the Software and
Documentation CD.
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Installing the printer on a wireless network (Windows)
Before you install the printer on a wireless network, make sure that:

• An optional wireless card is installed in your printer.

• Your wireless network is set up and working properly.

• The computer you are using is connected to the same wireless network where you want to set up the printer.

1 Connect the power cable, and then turn the printer on.

2

2

 Make sure the printer and computer are fully on and ready.

 Do not connect the USB cable until instructed to do so on the screen.

2 Insert the Software and Documentation CD.

3 Click Install.

4 Click Agree.

5 Click Suggested.

6 Click Wireless Network Attach.
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7 Connect the cables in the following order:

a Temporarily connect a USB cable between the computer on the wireless network and the printer.

Note: After the printer is configured, the software will instruct you to disconnect the temporary USB cable
so you can print wirelessly.

b If your printer has faxing capabilities, then connect the telephone cable.

8 Follow the instructions on the computer screen to complete the software installation.

9 To allow other computers on the wireless network to use the wireless printer, follow steps 2 through 6 and step 8
for each computer.

Installing the printer on a wireless network (Macintosh)
Before you install the printer on a wireless network, make sure that:

• An optional wireless card is installed in your printer.

• Your wireless network is set up and working properly.

• The computer you are using is connected to the same wireless network where you want to set up the printer.

Prepare to configure the printer

1 Locate the printer MAC address on the sheet that came with the printer. Write the last six digits of the MAC address
in the space provided below:

MAC address: ___ ___ ___ ___ ___ ___

2 If your printer has faxing capabilities, then connect the telephone cable.

3 Connect the power cable, and then turn the power on.

2

2

Enter the printer information

1 Access the AirPort options:
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In Mac OS X version 10.5

a From the Apple menu, choose System Preferences.

b Click Network.

c Click AirPort.

In Mac OS X version 10.4 and earlier

a From the Go menu, choose Applications.

b Double‑click Internet Connect.

c From the toolbar, click AirPort.

2 From the Network pop‑up menu, select print server xxxxxx, where the x’s are the last six digits of the MAC address
located on the MAC address sheet.

3 Open the Safari browser.

4 From the Bookmarks drop-down menu, select Show.

5 Under Collections, select Bonjour or Rendezvous, and then double‑click the printer name.

Note: The application is referred to as Rendezvous in Mac OS X version 10.3, but is now called Bonjour by Apple
Computer.

6 From the main page of the Embedded Web Server, navigate to the page where the wireless settings information is
stored.

Configure the printer for wireless access

1 Type the name of your network (SSID) in the appropriate field.

2 Select Infrastructure as your Network Mode if you are using a wireless router.

3 Select the type of security you use to protect your wireless network.

4 Enter the security information necessary for the printer to join your wireless network.

5 Click Submit.

6 Open the AirPort application on your computer:

In Mac OS X version 10.5

a From the Apple menu, choose System Preferences.

b Click Network.

c Click AirPort.

In Mac OS X version 10.4 and earlier

a From the Go menu, choose Applications.

b Double‑click Internet Connect.

c From the toolbar, click AirPort.

7 From the Network pop‑up menu, select your wireless network.
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Configure your computer to use the printer wirelessly

To print to a network printer, each Macintosh user must install a custom PostScript Printer Description (PPD) file and
create a printer in the Print Center or Printer Setup Utility.

1 Install a PPD file on the computer:

a Insert the Software and Documentation CD in the CD or DVD drive.

b Double-click the installer package for the printer.

c From the Welcome screen, click Continue.

d Click Continue again after viewing the Readme file.

e Click Continue after viewing the license agreement, and then click Agree to accept the terms of the agreement.

f Select a Destination, and then click Continue.

g From the Easy Install screen, click Install.

h Type the user password, and then click OK.
All necessary software is installed on the computer.

i Click Close when installation is complete.

2 Add the printer:

a For IP printing:

In Mac OS X version 10.5
1 From the Apple menu, choose System Preferences.
2 Click Print & Fax.
3 Click +.
4 Select the printer from the list.
5 Click Add.

In Mac OS X version 10.4
1 From the Go menu, choose Applications.
2 Double‑click Utilities.
3 Locate and double‑click Printer Setup Utility or Print Center.
4 From the Printer List, choose Add.
5 Select the printer from the list.
6 Click Add.

b For AppleTalk printing:

In Mac OS X version 10.5
1 From the Apple menu, choose System Preferences.
2 Click Print & Fax.
3 Click +.
4 Click AppleTalk.
5 Select the printer from the list.
6 Click Add.

In Mac OS X version 10.4
1 From the Go menu, choose Applications.
2 Double‑click Utilities.
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3 Locate and double‑click Print Center or Printer Setup Utility.
4 From the Printer List, choose Add.
5 Choose the Default Browser tab.
6 Click More Printers.
7 From the first pop‑up menu, choose AppleTalk.
8 From the second pop‑up menu, select Local AppleTalk zone.
9 Select the printer from the list.

10 Click Add.

Installing the printer on a wired network
Use the following instructions to install the printer on a wired network. These instructions apply to Ethernet and fiber
optic network connections.

Before you install the printer on a wired network, make sure that:

• You have completed the initial setup of the printer.

• The printer is connected to your network with the appropriate type of cable.

For Windows users

1 Insert the Software and Documentation CD.

Wait for the Welcome screen to appear.

If the CD does not launch after a minute, then do the following:

a Click , or click Start and then click Run.

b In the Start Search or Run box, type D:\setup.exe, where D is the letter of your CD or DVD drive.

2 Click Install Printer and Software.

3 Click Agree to agree to the License Agreement.

4 Select Suggested, and then click Next.

Note: To configure the printer using a static IP address, using IPv6, or to configure printers using scripts, select
Custom and follow the on‑screen instructions.

5 Select Wired Network Attach, and then click Next.

6 Select the printer manufacturer from the list.

7 Select the printer model from the list, and then click Next.

8 Select the printer from the list of printers discovered on the network, and then click Finish.

Note: If your configured printer does not appear in the list of discovered printers, click Add Port and follow the
on‑screen instructions.

9 Follow the on‑screen instructions to complete the installation.
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For Macintosh users

1 Allow the network DHCP server to assign an IP address to the printer.

2 Print the network setup page from the printer. For information on printing a network setup page, see “Printing a
network setup page” on page 42.

3 Locate the printer IP address in the TCP/IP section of the network setup page. You will need the IP address if you
are configuring access for computers on a different subnet than the printer.

4 Install the drivers and add the printer:

a Install a PPD file on the computer:
1 Insert the Software and Documentation CD in the CD or DVD drive.
2 Double-click the installer package for the printer.
3 From the Welcome screen, click Continue.
4 Click Continue again after viewing the Readme file.
5 Click Continue after viewing the license agreement, and then click Agree to accept the terms of the

agreement.
6 Select a Destination, and then click Continue.
7 From the Easy Install screen, click Install.
8 Type the user password, and then click OK.

All the necessary software is installed on the computer.
9 Click Restart when installation is complete.

b Add the printer:

• For IP Printing:

In Mac OS X version 10.5 or later
1 From the Apple menu, choose System Preferences.
2 Click Print & Fax.
3 Click +.
4 Click IP.
5 Type the IP address of your printer in the Address field.
6 Click Add.

In Mac OS X version 10.4 and earlier
1 From the Finder desktop, choose Go > Applications.
2 Double‑click Utilities.
3 Double‑click Printer Setup Utility or Print Center.
4 From the Printer List, click Add.
5 Click IP.
6 Type the IP address of your printer in the Address field.
7 Click Add.

• For AppleTalk Printing:

In Mac OS X version 10.5
1 From the Apple menu, choose System Preferences.
2 Click Print & Fax.
3 Click +.
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4 Click AppleTalk.
5 Select the printer from the list.
6 Click Add.

In Mac OS X version 10.4 and earlier
1 From the Finder desktop, choose Go > Applications.
2 Double‑click Utilities.
3 Double‑click Print Center or Printer Setup Utility.
4 From the Printer List, click Add.
5 Choose the Default Browser tab.
6 Click More Printers.
7 From the first pop‑up menu, choose AppleTalk.
8 From the second pop‑up menu, choose Local AppleTalk zone.
9 Select the printer from the list.

10 Click Add.

Note: If the printer does not show up in the list, you may need to add it using the IP address. Contact your
system support person for assistance.

Changing port settings after installing a new network Internal
Solutions Port
When a new network Lexmark Internal Solutions Port (ISP) is installed in the printer, the printer configurations on
computers that access the printer must be updated because the printer will be assigned a new IP address. All computers
that access the printer must be updated with this new IP address in order to print to it over the network.

Notes:

• If the printer has a static IP address that will stay the same, then you do not need to make any changes to the
computer configurations.

• If the computers are configured to print to the printer by a network name that will stay the same, instead of by
IP address, then you do not need to make any changes to the computer configurations.

• If you are adding a wireless ISP to a printer previously configured for a wired connection, then make sure the
wired network is disconnected when you configure the printer to operate wirelessly. If the wired connection
remains connected, then the wireless configuration will complete, but the wireless ISP will not be active. In the
event that the printer was configured for a wireless ISP while still attached to a wired connection, disconnect
the wired connection, turn the printer off, and then turn the printer back on again. This will enable the wireless
ISP.

• Only one network connection at a time is active. If you want to switch the connection type between wired and
wireless, you must first turn the printer off, connect the cable (to switch to a wired connection) or disconnect
the cable (to switch to a wireless connection), and then turn the printer back on again.

For Windows users

1 Print a network setup page and make a note of the new IP address.

2 Click , or click Start and then click Run.

3 In the Start Search or Run box, type control printers.
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4 Press Enter, or click OK.

The printer folder opens.

5 Locate the printer that has changed.

Note: If there is more than one copy of the printer, then update all of them with the new IP address.

6 Right‑click the printer.

7 Click Properties.

8 Click the Ports tab.

9 Locate the port in the list, and then select it.

10 Click Configure Port.

11 Type the new IP address in the “Printer Name or IP Address” field. You can find the new IP address on the network
setup page you printed in step 1.

12 Click OK, and then click Close.

For Macintosh users

1 Print a network setup page and make a note of the new IP address.

2 Locate the printer IP address in the TCP/IP section of the network setup page. You will need the IP address if you
are configuring access for computers on a different subnet than the printer.

3 Add the printer:

• For IP printing:

In Mac OS X version 10.5 or later
a From the Apple menu, choose System Preferences.
b Click Print & Fax.
c Click +.
d Click IP.
e Type in the IP address of your printer in the Address field.
f Click Add.

In Mac OS X version 10.4 and earlier
a From the Go menu, choose Applications.
b Double‑click Utilities.
c Double‑click Printer Setup Utility or Print Center.
d From the Printer List, click Add.
e Click IP.
f Type in the IP address of your printer in the Address field.
g Click Add.

• For AppleTalk printing:

In Mac OS X version 10.5
a From the Apple menu, choose System Preferences.
b Click Print & Fax.
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c Click +.
d Click AppleTalk.
e Select the printer from the list.
f Click Add.

In Mac OS X version 10.4 and earlier
a From the Go menu, choose Applications.
b Double‑click Utilities.
c Double‑click Print Center or Printer Setup Utility.
d From the Printer List, click Add.
e Choose the Default Browser tab.
f Click More Printers.
g From the first pop‑up menu, choose AppleTalk.
h From the second pop‑up menu, select Local AppleTalk zone.
i Select the printer from the list.
j Click Add.
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Setting up and using the Home Screen applications

Making the home screen applications work for you
Your printer came with special applications to enable you to store, access, and display printed material and images on
the touch screen. You can also select environmentally friendly printer settings for saving paper and energy.

The touch‑screen applications that came with your printer are:

• Forms and Favorites

Access frequently used forms and bookmarks with this application. Create your own index of forms, information
sheets, and other materials you print often. The application works by linking the documents by their URL or Web
sites. When you want to print a form, touch Forms and Favorites, touch the form you want, and then print.

• Eco‑Settings

Alter printer settings to save energy and paper with this application. When you select the Energy Eco‑Setting, the
printer automatically conserves energy using a different Power Saver setting. When you select the Paper Eco‑Setting,
the printer saves paper by printing on both sides of the paper. When you select the Energy/Paper Eco‑Setting, the
printer uses all the settings for reducing your printer's impact on the environment.

• Background and Idle Screen

Make your own background and idle screens with this application. Your home screen displays the background, idle
screen, and button icons of your choice. You can tailor your home screen to look a certain way and you can determine
what icons show on the display. This way, you can show the icons you use most often and hide the others.

• Showroom

View the special features of your printer with this slide show application. Designed to acquaint users with the printer,
the slide show highlights the efficient, paper‑saving, and sustainable solutions of your printer.

You can set up and use the home screen applications by using the home screen buttons or the Embedded Web Server.
To open the Embedded Web Server, type your printer IP address into the address field of your Web browser. If you do
not know the IP address of the printer, then print a network setup page and locate the IP address in the TCP/IP section.
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Configuring the home screen or idle screen
The Background and Idle Screen application allows you to change the image used as the background on the printer
home screen as well as the images used on the printer idle screen.

Images used on the home or idle screens must meet the following requirements:

• GIF, JPEG, and PNG formats only

• A file size no larger than 128K

• A home screen background image size (in pixels) no larger than 800 x 405

• An idle screen image size (in pixels) no larger than 800 x 480

Adding a custom background image
1 From the Embedded Web Server, click Settings > Embedded Solutions  > Background and Idle Screen >

Configure.

2 Under Home Screen Image, beside Background Images, select Custom.

3 Beside Custom Image, click Browse.

4 Browse to the graphic you want to use, and then click Open.

5 Click Apply.

Notes:

• If you want to view the current custom image, click View Current Value under the Custom Image field.

• If you want to reset the custom image, select the Reset to default value check box, and then click Apply.

• If you do not want to use a custom background image on the home screen, select one of the other options
under Background Images, and then click Apply.

Changing the home screen background image using the printer control panel
1 From the home screen, touch the Change Background icon.

2 Select the background you want to use, and then click Apply.

Changing the home screen background image using the Embedded Web Server
1 From the Embedded Web Server, click Settings > Embedded Solutions  > Background and Idle Screen >

Configure.

2 Under Home Screen Background, beside Background Image, select the image you want to use.

3 Click Apply.

Adding idle screen images
1 From the Embedded Web Server, click Settings > Embedded Solutions  > Background and Idle Screen >

Configure.

2 Beside Idle Screen Images, click Add.
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3 Enter an Image Name.

4 Beside Image, click Browse.

5 Browse to the graphic you want to use, and then click Open.

6 Click Apply.

7 Repeat steps 3 through 6 to add additional idle screen images.

Note: You can add up to ten idle screen images.

8 Click Apply.

9 Click Apply.

Notes:

• If you want to view the current image, click View Current Value under the Image field.

• If you want to reset the image, select the Reset to default value check box, and then click Apply.

Editing idle screen images
1 From the Embedded Web Server, click Settings > Embedded Solutions  > Background and Idle Screen >

Configure.

2 Beside Idle Screen Images, select the image you want to edit, and then click Edit.

3 If desired, change the Image Name.

4 Beside Image, click Browse.

5 Browse to the graphic you want to use, and then click Open.

6 Click Apply.

7 Repeat steps 3 through 6 to edit additional idle screen images.

Notes:

• If you want to view the current image, then click View Current Value under the Image field.

• If you want to reset the image, then select the Reset to default value check box, and then click Apply.

8 Click Apply.

Deleting idle screen images
1 From the Embedded Web Server, click Settings > Embedded Solutions  > Background and Idle Screen >

Configure.

2 Beside Idle Screen Images, select the image you want to delete, and then click Delete.

3 Click Remove.

4 Click Apply.
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Changing the idle screen settings using the Embedded Web Server
1 From the Embedded Web Server, click Settings > Embedded Solutions  > Background and Idle Screen >

Configure.

2 Under Idle Screen Settings, make sure Enable is selected.

3 Beside Start Time, enter the number of seconds the printer is idle before the idle screen images appear.

4 Beside Image Interval, enter the number of seconds between image changes.

5 Click Apply.

Exporting and importing a configuration using the Embedded Web Server
You can export configuration settings into a text file that can then be imported and used to apply the settings to one
or more additional printers.

Exporting the configuration

1 From the Embedded Web Server, click Settings > Embedded Solutions.

2 From Installed Solutions, click the name of the application you want to configure.

3 Click Configure.

4 Click Export.

5 Follow the browser prompts to save the configuration file. You will have the option to enter a unique file name or
use the default name.

Note: If a JVM Out of Memory error occurs, repeat the export until the settings file is saved.

Importing the configuration

1 From the Embedded Web Server, click Settings > Embedded Solutions.

2 From Installed Solutions, click the name of the application you want to configure.

3 Click Configure.

4 Click Import.

5 Browse to the saved configuration file, and then load or preview it.

Note: If a timeout occurs and a blank screen appears, refresh the browser, and then click Apply.

Configuring Eco-Settings
The Eco‑Settings application lets you select energy‑ and paper‑saving settings that can help reduce the environmental
impact of your printer.
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Configuring Eco‑Settings using the printer control panel
1 From the printer home screen, touch Eco‑Settings.

2 Touch Eco‑Mode, and then touch Off, Energy (to reduce energy use, especially when the printer is idle),
Energy/Paper, or Paper (to turn off print log features).

Notes:

• Choosing Energy/Paper will automatically set 2‑Sided Printing and Power Saver to default levels. You will not
be able to modify those settings.

• When Energy or Energy/Paper is enabled, printer engine motors do not start until a job is ready to print. You
may therefore notice a short delay before the first page is printed.

3 Touch Done.

4 Touch 2‑Sided Printing, and then touch 1‑Sided, 2‑Sided Long Edge, or 2‑Sided Short Edge.

5 Touch Done.

6 Touch Quiet Mode, and then touch Off or On.

7 Touch Done.

Note: In Quiet Mode, printer engine motors do not start until a job is ready to print. You may notice a short
delay before the first page is printed, as well as a reduction in processing speed.

8 Use the Standby Mode left and right arrows to adjust the number of minutes (1‑240) the printer will wait before
darkening the home screen.

9 Use the Power Saver left and right arrows to adjust the number of minutes (1‑240) the printer will wait before
powering down the print engine.

Note: Standby Mode will engage automatically when the printer is in Power Saver mode.

10 Use the Screen Brightness left and right arrows to adjust the percentage of screen brightness (20‑100%).

11 Use the Toner Darkness left and right arrows to adjust the darkness of your printed documents.

12 Touch OK to save changes made to Standby Mode, Power Saver, Screen Brightness, or Toner Darkness settings.

Configuring Eco‑Settings using the Embedded Web Server

Home screen icons and text

You can customize how Eco‑Settings appears on the printer home screen by changing the text that appears with the
button, the image displayed on the button when it is not pressed, or the image that displays when the button is pressed.

1 From the Embedded Web Server, click Settings > Embedded Solutions > Eco‑Settings > Configure.

2 In the Text field, type the new button text you want to appear on the home screen.

3 In the Icon field, type a path or browse to the graphic you want to appear when the button on the home screen is
not pressed.

Note: Use a GIF, JPEG, or PNG image with dimensions of 120 x 75 pixels that is 11KB or smaller.
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4 In the Icon When Pressed field, type a path or browse to the graphic you want to appear when the button on the
home screen is pressed.

Note: Use a GIF, JPEG, or PNG image with dimensions of 120 x 75 pixels that is 11KB or smaller.

5 Click Apply.

Note: To restore the default appearance of Eco‑Settings, under the “Home Screen Button: Icon” field or the “Home
Screen Button: Icon When Pressed” field, select Reset to default value, and then click Apply.

Energy‑ and paper‑saving options

1 From the Embedded Web Server, click Settings > Embedded Solutions > Eco‑Settings > Configure. Adjust the
following settings as needed:

• Eco Mode—Choose Off, Energy (to reduce energy use, especially when the printer is idle), Energy/Paper, or
Paper (to turn off print log features).

Notes:

– Choosing Energy/Paper will automatically set 2‑Sided Printing and Power Saver to default levels.
Additional changes made to those settings through the Embedded Web Server will be ignored.

– When Energy or Energy/Paper is enabled, printer engine motors do not start until a job is ready to print.
You may therefore notice a short delay before the first page is printed.

• Standby Mode—Type the number of minutes (1‑240) the printer will wait before darkening the home screen.

• Power Saver—Type the number of minutes (1‑240) the printer will wait before powering down the print engine.

Note: Standby Mode will engage automatically when the printer is in Power Saver mode.

• Screen Brightness—Type a number for the desired percentage of screen brightness (20‑100).

• 2‑Sided Printing—Choose 1‑Sided, 2‑Sided Long Edge, or 2‑Sided Short Edge.

• Toner Darkness—From the menu choose a toner darkness value (1‑10).

• Quiet Mode—Click the check box to reduce the amount of noise produced by the printer.

Note: In Quiet Mode, printer engine motors do not start until a job is ready to print. You may notice a short
delay before the first page is printed, as well as a reduction in processing speed.

• Lock UI—Click the check box to prevent users from changing Eco‑Settings using the printer touch screen.

2 Click Apply to save changes, or Restore Defaults to return all settings to default values.

Exporting or importing configuration settings

You can export configuration settings into a text file that can then be imported and then used to apply the settings to
one or more additional printers.

1 From the Embedded Web Server, click Settings > Embedded Solutions > Eco‑Settings > Configure.

2 To export your current settings, click Export, and then follow the browser prompts to save the configuration file.
You will have the option to enter a unique file name or use the default name.

3 To import a previously saved configuration, click Import, browse to the saved configuration file, and then load or
preview it.
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Configuring Forms and Favorites
The Forms and Favorites solution provides users with quick and easy access to frequently used forms or other
information that is regularly printed.

The printer Bookmark function is used to create a link to a form or electronic file at a predetermined URL or network
location. These files are then accessed from the Forms and Favorites icon.

When adding bookmarks from the printer Embedded Web Server, more configuration options are available than when
adding bookmarks from the printer control panel.

Adding bookmarks using the printer control panel
Note: Bookmarks that are entered using this process must be edited from the printer Embedded Web Server.

1 From the printer control panel, touch Held Jobs.

2 Touch Bookmarks.

3 Touch Create Bookmark.

4 Enter a name for the new bookmark, and then touch Enter. This name will be displayed in the Forms menu when
selecting a form to print.

5 Enter the URL or network location of the form.

Note: The printer does not verify the validity of the URL or network location, so it is important to make sure that
the location is valid and is entered correctly.

6 Touch Done.

Adding bookmarks using the Embedded Web Server
1 From the Embedded Web Server, click Settings > Bookmark Setup.

2 Click New Bookmark.

3 In the Bookmark Properties section, type a Name and URL for the bookmark.

4 Configure optional bookmark settings:

• To require users to enter a PIN to print the bookmark, type a four‑digit number beside PIN.

• To change the default printer settings, adjust the settings in the Finishing Menu and Paper sections.

• If the bookmark URL refers to an HTML document, then you can change the default margin for printing the
document by changing the setting for Margin in the HTML Properties section.

• If the bookmark URL refers to an HTML document, then select whether to Print Background Images in the HTML
Properties section.

• If the bookmark URL refers to a PDF document, then select whether the document should Scale to Fit when
printed in the PDF Properties section.

5 Click Submit to save the new bookmark.
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Changing the display icons and labels
1 From the Embedded Web Server, click Settings > Embedded Solutions  > Forms and Favorites > Configure.

2 Select the Custom option next to each field that you want to change.

3 Enter text, or browse to the appropriate image file.

Notes:

• Replacement icons must be GIF, JPEG, or PNG files under 11KB in size.

• The standard size for welcome screen icons is 120 x 75 pixels. For best results, resize or crop source images
to the correct size before use.

4 Click either Apply to save the settings or Reset to return to the previous settings.

Printing forms
1 From the printer touch screen, touch Forms and Favorites.

2 Touch the desired form in the list.

3 Enter the number of copies, and then touch Print.
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Minimizing your printer's environmental impact
Lexmark is committed to environmental sustainability and is continually improving its printers to reduce their impact
on the environment. We design with the environment in mind, engineer our packaging to reduce materials, and provide
collection and recycling programs. For more information, see:

• The Notices chapter

• The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment

• The Lexmark recycling program at www.lexmark.com/recycling

By selecting certain printer settings or tasks, you may be able to further reduce your printer's impact on the environment.
This chapter outlines the settings and tasks that may yield a greater environmental benefit.

Saving paper and toner
Studies show that as much as 80% of the carbon footprint of a printer is related to paper usage. You can significantly
reduce your carbon footprint by using recycled paper and the following printing suggestions, such as printing on both
sides of the paper and printing multiple pages on one side of a single sheet of paper.

For information on how you can quickly save paper and energy using one printer setting, see "Using Eco-Mode".

Using recycled paper
As an environmentally conscious company, Lexmark supports the use of recycled office paper produced specifically for
use in laser printers. For more information on recycled papers that work well with your printer, see “Using recycled
paper” on page 68.

Conserving supplies
There are a number of ways you can reduce the amount of paper and toner you use. You can:

• Print on both sides of the paper.

• Print multiple pages on one sheet of paper. Use the Print dialog to print up to 16 pages of a multiple‑page document
on a single sheet of paper.

• Check your first draft for accuracy. Before printing:

– Use the Lexmark preview feature, which you can select from the Print dialog, the Lexmark Toolbar, or the printer
display, to see what the document will look like before you print it.

– Print one copy of the document to check its content and format for accuracy.

• Carefully select and load paper to avoid paper jams. For more information, see “Loading paper” on page 34.
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Saving energy
For additional information on saving power, see the Notices chapter.

Using Eco‑Mode
Use Eco‑Mode to quickly select one or more ways to reduce your printer's environmental impact.

Note: See the table for the multiple settings that change when you select an Eco‑Mode setting.

Choose To

Energy Reduce energy use, especially when the printer is idle.

• Printer engine motors do not start until a job is ready to print. You may notice a short delay before the
first page is printed.

• The printer enters Power Saver mode after one minute of inactivity.

• When the printer enters Power Saver mode, the printer control panel display and the standard exit bin
lights are turned off.

Paper • Enable the automatic duplex feature

• Turn off print log features.

Energy/Paper Use all the settings associated with Energy mode and Paper mode.

Off Use factory default settings for all settings associated with Eco‑Mode. This setting supports the performance
specifications for your printer.

To select an Eco‑Mode setting:

1 On the home screen, touch .

2 Touch Settings.

3 Touch General Settings.

4 Touch Eco‑Mode.

5 Touch the arrows to select a setting.

6 Touch Submit.

Adjusting Power Saver
To save energy, you can decrease the number of minutes before the printer enters Power Saver mode.

Available settings range from 1–240 minutes. The factory default setting is 30 minutes.

Using the Embedded Web Server

1 Type the printer IP address into the address field of your Web browser.

Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings, and then click General Settings.

3 Click Timeouts.
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4 In the Power Saver box, type in the number of minutes you want the printer to wait before it enters Power Saver
mode.

5 Click Submit.

Using the printer control panel

1 Make sure the printer is on and Ready appears.

2 On the home screen, touch .

3 Touch Settings.

4 Touch General Settings.

5 Touch the down arrow until Timeouts appears.

6 Touch Timeouts.

7 Touch the arrows next to Power Saver Mode to select the number of minutes you want the printer to wait
before it enters Power Saver mode.

8 Touch Submit.

9 Touch .

Adjusting the brightness of the display
To save energy, or if you are having trouble reading your display, you can adjust the brightness of the display.

Available settings range from 20–100 percent brightness. The factory default setting is 100 percent.

Using the Embedded Web Server

1 Type the printer IP address into the address field of your Web browser.

2 Click Settings, and then click General Settings.

3 In the Screen Brightness box, type in the brightness percentage you want for your home screen.

4 Click Submit.

Using the printer control panel

1 Make sure the printer is on and Ready appears.

2 On the home screen, touch .

3 Touch Settings.

4 Touch General Settings.

5 Touch the down arrow until Screen Brightness appears.

6 Touch the arrows to select a setting.

7 Touch Submit.

8 Touch .
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Recycling
Lexmark provides collection programs and environmentally progressive approaches to recycling. For more information,
see:

• The Notices chapter

• The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment

• The Lexmark recycling program at www.lexmark.com/recycle

Recycling Lexmark products
To return Lexmark products to Lexmark for recycling:

1 Visit our Web site at www.lexmark.com/recycle.

2 Find the product type you want to recycle, and then select your country from the list.

3 Follow the instructions on the computer screen.

Recycling Lexmark packaging
Lexmark continually strives to minimize packaging. Less packaging helps to ensure that Lexmark printers are transported
in the most efficient and environmentally sensitive manner and that there is less packaging to dispose of. These
efficiencies result in energy savings, natural resource savings, and fewer greenhouse emissions.

Lexmark cartons are 100% recyclable where corrugated recycling facilities exist. Facilities may not exist in your area.

Expanded polystyrene (EPS) foam used in Lexmark packaging is recyclable where foam recycling facilities exist. Facilities
may not exist in your area. For information on EPS foam recycling locations:

1 Visit EPS Recycling International's Web site at www.epsrecycling.org/pages/intcon.html.

2 Select your country or region from the list, and then click the links or use the contact information provided.

When you return a cartridge to Lexmark, you can reuse the box that the cartridge came in. Lexmark will recycle the
box.

Returning Lexmark cartridges for reuse or recycling
The Lexmark Cartridge Collection Program diverts millions of Lexmark cartridges from landfills annually by making it
both easy and free for Lexmark customers to return used cartridges to Lexmark for reuse or recycling. One hundred
percent of the empty cartridges returned to Lexmark are either reused or demanufactured for recycling. Boxes used
to return the cartridges are also recycled.

To return Lexmark cartridges for reuse or recycling, follow the instructions that came with your printer or cartridge and
use the pre‑paid shipping label. You can also:

1 Visit our Web site at www.lexmark.com/recycle.

2 From the Toner Cartridges section, select your country from the list.

3 Follow the instructions on the computer screen.
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Reducing printer noise
Use Quiet Mode to reduce the printer noise.

Note: See the table for the multiple settings that change when you select a Quiet Mode setting.

Choose To

On Reduce printer noise.

• You may notice a reduction in processing speed.

• Printer engine motors do not start until a job is ready to
print. You may notice a short delay before the first page
is printed.

• Fans run at a reduced speed or are turned off.

Off Use factory default settings. This setting supports the
performance specifications for your printer.

To select a Quiet Mode setting:

1 On the home screen, touch .

2 Touch Settings.

3 Touch General Settings.

4 Touch Quiet Mode.

5 Touch the arrows to select a setting.

6 Touch Submit.
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Paper and specialty media guidelines

Paper guidelines

Paper characteristics
The following paper characteristics affect print quality and reliability. Consider these characteristics when evaluating
new paper stock.

Note: For detailed information on card stock and labels, see the Card Stock & Label Guide available on the Lexmark
Web site at www.lexmark.com/publications.

Weight

The printer can automatically feed paper weights from 60–176 g/m2 (16–47 lb bond) grain long. Paper lighter than
60 g/m2 (16 lb) might not be stiff enough to feed properly, causing jams. For best performance, use 75 g/m2 (20 lb
bond) grain long paper. For paper smaller than 182 x 257 mm (7.2 x 10.1 in.), we recommend 90 g/m2 (24 lb) or heavier
paper.

Curl

Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can occur after
the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped in hot, humid,
cold, or dry conditions, even in the trays, can contribute to paper curling prior to printing and can cause feeding
problems.

Smoothness

Paper smoothness directly affects print quality. If paper is too rough, then toner cannot fuse to it properly. If paper is
too smooth, then it can cause paper feeding or print quality issues. Always use paper between 100 and 300 Sheffield
points; smoothness between 150 and 250 Sheffield points produces the best print quality.

Moisture content

The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper correctly.
Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to moisture changes that
can degrade its performance.

Condition paper before printing by storing it in its original wrapper in the same environment as the printer for 24 to
48 hours before printing. Extend the time several days if the storage or transportation environment is very different
from the printer environment. Thick paper may also require a longer conditioning period.

Grain direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of
the paper, or grain short, running the width of the paper.

For 60–176 g/m2 (16–47 lb bond) paper, grain long paper is recommended. For paper heavier than 176 g/m2, grain
short is recommended.
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Fiber content

Most high‑quality xerographic paper is made from 100% chemically treated pulped wood. This content provides the
paper with a high degree of stability resulting in fewer paper feeding problems and better print quality. Paper containing
fibers such as cotton can negatively affect paper handling.

For detailed information on paper with recycled fiber content, see “Using recycled paper” on page 68.

Selecting paper
Using appropriate paper prevents jams and helps ensure trouble‑free printing.

To help avoid jams and poor print quality:

• Always use new, undamaged paper.

• Before loading paper, know the recommended print side of the paper. This information is usually indicated on the
paper package.

• Do not use paper that has been cut or trimmed by hand.

• Do not mix paper sizes, types, or weights in the same source; mixing results in jams.

• Do not use coated papers unless they are specifically designed for electrophotographic printing.

Selecting preprinted forms and letterhead
Use these guidelines when selecting preprinted forms and letterhead:

• Use grain long for 60–90 g/m2 (16–24 lb) paper.

• Use only forms and letterhead printed using an offset lithographic or engraved printing process.

• Avoid papers with rough or heavily textured surfaces.

Use papers printed with heat‑resistant inks designed for use in xerographic copiers. The ink must be able to withstand
temperatures up to 230°C (446°F) without melting or releasing hazardous emissions. Use inks that are not affected by
the resin in toner. Inks that are oxidation‑set or oil‑based generally meet these requirements; latex inks might not.
When in doubt, contact the paper supplier.

Preprinted papers such as letterhead must be able to withstand temperatures up to 230°C (446°F) without melting or
releasing hazardous emissions.

Using recycled paper
As an environmentally conscientious company, Lexmark supports the use of recycled paper produced specifically for
use in laser (electro-photographic) printers.

While no blanket statement can be made that all recycled paper will feed well, Lexmark consistently tests papers that
represent recycled cut size copier papers available on the global market. This scientific testing is conducted with rigor
and discipline. Many factors are taken into consideration both separately and as a whole, including the following:

• Amount of post-consumer waste (Lexmark tests up to 100% post-consumer waste content.)

• Temperature and humidity conditions (Testing chambers simulate climates from all over the world.)

• Moisture content (Business papers should have low moisture: 4–5%.)

• Bending resistance and proper stiffness means optimum feeding through the printer.

• Thickness (impacts how much can be loaded into a tray)

• Surface roughness (measured in Sheffield units, impacts print clarity and how well toner fuses to the paper)
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• Surface friction (determines how easily sheets can be separated)

• Grain and formation (impacts curling, which also influences the mechanics of how the paper behaves as it moves
through the printer)

• Brightness and texture (look and feel)

Recycled papers are better than ever; however, the amount of recycled content in a paper affects the degree of control
over foreign matter. And while recycled papers are one good path to printing in an environmentally responsible manner,
they are not perfect. The energy required to de-ink and deal with additives such as colorants and “glue” often generates
more carbon emissions than does normal paper production. However, using recycled papers enables better resource
management overall.

Lexmark concerns itself with the responsible use of paper in general based on life cycle assessments of its products. To
gain a better understanding of the impact of printers on the environment, the company commissioned a number of
life cycle assessments and found that paper was identified as the primary contributor (up to 80%) of carbon emissions
caused throughout the entire life of a device (from design to end-of-life). This is due to the energy-intensive
manufacturing processes required to make paper.

Thus, Lexmark seeks to educate customers and partners on minimizing the impact of paper. Using recycled paper is
one way. Eliminating excessive and unnecessary paper consumption is another. Lexmark is well-equipped to help
customers minimize printing and copying waste. In addition, the company encourages purchasing paper from suppliers
who demonstrate their commitment to sustainable forestry practices.

Lexmark does not endorse specific suppliers, although a converter’s product list for special applications is maintained.
However, the following paper choice guidelines will help alleviate the environmental impact of printing:

1 Minimize paper consumption.

2 Be selective about the origin of wood fiber. Buy from suppliers who carry certifications such as the Forestry
Stewardship Council (FSC) or The Program for the Endorsement of Forest Certification (PEFC). These certifications
guarantee that the paper manufacturer uses wood pulp from forestry operators that employ environmentally and
socially responsible forest management and restoration practices.

3 Choose the most appropriate paper for printing needs: normal 75 or 80 g/m2 certified paper, lower weight paper,
or recycled paper.

Unacceptable paper
Test results indicate that the following paper types are at risk for use with laser printers:

• Chemically treated papers used to make copies without carbon paper, also known as carbonless papers

• Preprinted papers with chemicals that may contaminate the paper

• Preprinted papers that can be affected by the temperature in the printer fuser

• Preprinted papers that require a registration (the precise location on the page) greater than ± 2.3 mm (± 0.9 in.),
such as optical character recognition (OCR) forms. In some cases, registration can be adjusted with a software
application to successfully print on these forms.)

• Coated papers (erasable bond), synthetic papers, thermal papers

• Rough-edged, rough or heavily textured surface papers or curled papers

• Recycled papers that fail EN12281:2002 (European testing)

• Paper weighing less than 60 g/m2 (16 lb)

• Multiple part forms or documents

For more information about Lexmark, visit www.lexmark.com. General sustainability-related information can be found
at the Environmental Sustainability link.
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Storing paper
Use these paper storage guidelines to help avoid jams and uneven print quality:

• For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40%. Most label
manufacturers recommend printing in a temperature range of 18 to 24°C (65 to 75°F) with relative humidity between
40 and 60%.

• Store paper in cartons when possible, on a pallet or shelf, rather than on the floor.

• Store individual packages on a flat surface.

• Do not store anything on top of individual paper packages.

Supported paper sizes, types, and weights
The following tables provide information on standard and optional paper sources and the types of paper they support.

Note: For an unlisted paper size, select the closest larger listed size.

For information on card stock and labels, see the Card Stock & Label Guide on the Lexmark Web site.

Paper sizes supported by the printer

Paper size Dimensions 250‑ or
550‑sheet trays
(standard or
optional)

Optional
2000‑sheet tray

Multipurpose
feeder

Duplex
printing

A4 210 x 297 mm
(8.3 x 11.7 in.)

A5 148 x 210 mm
(5.8 x 8.3 in.)

X

A61,2 105 x 148 mm
(4.1 x 5.8 in.)

X X X

JIS B5 182 x 257 mm
(7.2 x 10.1 in.)

X

Letter 216 x 279 mm
(8.5 x 11 in.)

Legal 216 x 356 mm
(8.5 x 14 in.)

Executive 184 x 267 mm
(7.3 x 10.5 in.)

X

1 This size appears in the Paper Size menu only when the paper source does not support size sensing or when size sensing
is turned off.
2 Only the standard exit bin supports this size.
3This size setting formats the page for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software application.
4 To support duplexing, the Universal width must be between 148 mm (5.8 in) and 216 mm (8.5 in); Universal length must
be between 182 mm (7.2 in) and 356 mm (14 in).
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Paper size Dimensions 250‑ or
550‑sheet trays
(standard or
optional)

Optional
2000‑sheet tray

Multipurpose
feeder

Duplex
printing

Oficio1 216 x 340 mm
(8.5 x 13.4 in.)

X

Folio1 216 x 330 mm
(8.5 x 13 in.)

X

Statement1 140 x 216 mm
(5.5 x 8.5 in.)

X X

Universal3,4 138 x 210 mm
(5.5 x 8.3 in.) up to
216 x 356 mm
(8.5 x 14 in.)

X X

70 x 127 mm
(2.8 x 5 in.) up to
216 x 356 mm
(8.5 x 14 in.)

X X X

148 x 182 mm
(5.8 x 7.7 in.) up to
216 x 356 mm
(8.5 x 14 in.)

X

7 3/4 Envelope
(Monarch)

98 x 191 mm
(3.9 x 7.5 in.)

X X X

9 Envelope 98 x 225 mm
(3.9 x 8.9 in.)

X X X

10 Envelope 105 x 241 mm
(4.1 x 9.5 in.)

X X X

DL Envelope 110 x 220 mm
(4.3 x 8.7 in.)

X X X

Other Envelope 98 x 162 mm
(3.9 x 6.4 in.) to
176 x 250 mm
(6.9 x 9.8 in.)

X X X

1 This size appears in the Paper Size menu only when the paper source does not support size sensing or when size sensing
is turned off.
2 Only the standard exit bin supports this size.
3This size setting formats the page for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software application.
4 To support duplexing, the Universal width must be between 148 mm (5.8 in) and 216 mm (8.5 in); Universal length must
be between 182 mm (7.2 in) and 356 mm (14 in).

Note: An optional 250‑sheet Universally Adjustable Tray is available for sizes smaller than A5, such as index cards.
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Paper types and weights supported by the printer

The printer engine supports 60–176 g/m2 (16–47 lb) paper weights. The duplex path supports 63–170 g/m2 (17–45 lb)
paper weights.

Paper type 250‑ or 550‑sheet
trays (standard or
optional)

Optional 2000‑sheet
tray

Multipurpose feeder Duplex printing

Paper

• Plain

• Bond

• Colored

• Custom

• Letterhead

• Light

• Heavy

• Preprinted

• Rough/Cotton

• Recycled

Card stock

Envelopes X X X

Labels 1

• Paper

• Vinyl

Transparencies

1 Printing labels requires a special label fuser cleaner which is included with the special cartridge required for label
applications.

Paper types and weights supported by the output bins
Use this table to determine the possible output destinations of print jobs which use supported paper types and weights.
The paper capacity of each output bin is listed in parentheses. Paper capacity estimations are calculated based on
75 g/m2 (20 lb) paper.
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The finisher supports 60–176 g/m2 (16–47 lb) paper weights.

Paper type Standard exit bin
(350 or 550 sheets)

Optional hardware

Output Expander (550
sheets) or High
Capacity Output
Stacker (1850 sheets)

5‑Bin Mailbox

(500 sheets)1

StapleSmart II
Finisher

(500 sheets)2

Paper

• Plain

• Bond

• Colored

• Custom

• Letterhead

• Light

• Heavy

• Preprinted

• Rough/Cotton

• Recycled

Card stock X X

Envelopes X X

Labels 3

• Paper

• Vinyl

X X

Transparencies X X

1 Supports 60‑90 g/m2 (16‑24 lb) paper weights.
2 Maximum of 50 sheets of 75 g/m2 (20 lb) paper per stapled packet. Results may vary with heavier paper.
3 Printing labels requires a special label fuser cleaner which is included with the special cartridge required for label
applications.
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Printing

Printing a document

Printing a document
1 From the printer control panel Paper menu, set the Paper Type and Paper Size to match the loaded paper.

2 Send the print job:

For Windows users

a With a document open, click File > Print.

b Click Properties, Preferences, Options, or Setup, and then adjust the settings as needed.

Note: To print on a specific size or type of paper, adjust the paper size or type settings to match the loaded
paper, or select the appropriate tray or feeder.

c Click OK, and then click Print.

For Macintosh users

a Customize the settings as needed in the Page Setup dialog:
1 With a document open, choose File > Page Setup.
2 Choose a paper size or create a custom size to match the loaded paper.
3 Click OK.

b Customize the settings as needed in the Print dialog:
1 With a document open, choose File > Print.

If necessary, click the disclosure triangle to see more options.
2 From the Print dialog and pop‑up menus, adjust the settings as needed.

Note: To print on a specific paper type, adjust the paper type setting to match the loaded paper, or
select the appropriate tray or feeder.

3 Click Print.

Printing on a paper size not listed in the printer menus
To print on other sizes, set the Paper Size for the specified tray to Universal, and then specify all of the following settings
for your paper:

• Units of measure (millimeters or inches)

• Portrait width

• Portrait height

• Feed direction

Note: The smallest supported Universal size is 148 x 210 mm (5.8 x 8.3 in.); the largest is 216 x 356 mm (8.5 x 14 in.).
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Specify a unit of measurement

1 On the home screen, touch .

2 Touch Paper Menu.

3 Touch Universal Setup.

4 Touch the right or left arrows to select Units of Measure and the correct units of measure.

5 Touch Submit.

Submitting Selection appears, followed by the Universal Setup menu.

Specify the paper height and width

To define a specific height and width measurement for the Universal paper size in the portrait orientation:

1 From the Universal Setup menu, touch Portrait Width.

2 Touch the arrows to select the paper width setting.

Submitting Selection appears, followed by the Universal Setup menu.

3 Touch Portrait Height.

4 Touch the arrows to select the paper height setting.

Submitting Selection appears, followed by the Universal Setup menu.

Specify the feed direction

Feed direction appears only if the paper can be loaded in either direction. If this is the case, then you can define the
feed direction.

1 From the Universal Setup menu, touch Feed direction.

2 Touch Short edge or Long edge depending on how you would like the print to appear on the page.

3 Load the paper according to your feed direction selection.

4 Touch  to return to the home screen.

Printing on a different size or type of paper
The Paper Size setting is determined by the position of the paper guides in the tray for all trays except the multipurpose
feeder. The Paper Size setting for the multipurpose feeder must be set manually.

The factory default Paper Type setting is Plain Paper. The Paper Type setting must be set manually for all trays that do
not contain plain paper.

1 On the home screen, touch .

2 Touch Paper Menu.

3 Touch Paper Size/Type.

4 Touch the right and left arrows to select the paper size, type, and tray.

5 Touch Submit.

6 Touch  to return to the home screen.
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Printing on specialty media

Tips on using letterhead
• Use letterhead designed specifically for laser printers.

• Print samples on the letterhead being considered for use before buying large quantities.

• Before loading letterhead, fan the stack to prevent sheets from sticking together.

• Page orientation is important when printing on letterhead. For information on how to load letterhead, see:

– “Loading paper in the 250- and 550-sheet trays” on page 34

– “Loading paper in the 2000‑sheet tray” on page 35

– “Loading paper in the multipurpose feeder” on page 36

Tips on using transparencies
Print samples on the transparencies being considered for use before buying large quantities.

When printing on transparencies:

• Feed transparencies from a 250‑sheet tray, a 550‑sheet tray, or the multipurpose feeder.

• Use transparencies designed specifically for laser printers. Check with the manufacturer or vendor to ensure
transparencies are able to withstand temperatures up to 230°C (446°F) without melting, discoloring, offsetting, or
releasing hazardous emissions.

• Use transparencies that are 138–146 g/m2 (37–39 lb. bond) in weight.

• To prevent print quality problems, avoid getting fingerprints on the transparencies.

• Before loading transparencies, fan the stack to prevent sheets from sticking together.

• We recommend Lexmark part number 12A5010 for A4‑size transparencies and Lexmark part number 70X7240 for
letter‑size transparencies.

Tips on using envelopes
Print samples on the envelopes being considered for use before buying large quantities.

When printing on envelopes:

• Feed envelopes from the multipurpose feeder or the optional envelope feeder.

• Set the Paper Type to Envelope, and select the envelope size.

• Use envelopes designed specifically for laser printers. Check with the manufacturer or vendor to ensure the
envelopes can withstand temperatures up to 230°C (446°F) without sealing, wrinkling, curling excessively, or
releasing hazardous emissions.

• For the best performance, use envelopes made from 90 g/m2 (24 lb bond) paper. Use up to 105 g/m2 (28 lb bond)
weight for envelopes as long as the cotton content is 25% or less. All‑cotton envelopes must not exceed 90 g/m2

(24 lb bond) weight.

• Use only new envelopes.

• To optimize performance and minimize jams, do not use envelopes that:

– Have excessive curl or twist

– Are stuck together or damaged in any way
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– Have windows, holes, perforations, cutouts, or embossing

– Have metal clasps, string ties, or folding bars

– Have an interlocking design

– Have postage stamps attached

– Have any exposed adhesive when the flap is in the sealed or closed position

– Have bent corners

– Have rough, cockle, or laid finishes

• Adjust the width guide to fit the width of the envelopes.

Note: A combination of high humidity (over 60%) and the high printing temperature may wrinkle or seal envelopes.

Tips on using labels
Print samples on the labels being considered for use before buying large quantities.

Notes:

• Paper, dual‑web paper, polyester, and vinyl labels are supported.

• When using the duplex unit, specially‑designed, integrated, and dual‑web paper labels are supported.

• Printing labels requires a special label fuser cleaner which is included with the special cartridge required for
label applications. For more information, see “Ordering supplies” on page 163.

For detailed information on label printing, characteristics, and design, see the Card Stock & Label Guide available on
the Lexmark Web site at www.lexmark.com/publications.

When printing on labels:

• Feed labels from a 250‑sheet tray, a 550‑sheet tray, or the multipurpose feeder.

• Use labels designed specifically for laser printers. Check with the manufacturer or vendor to verify that:

– The labels can withstand temperatures up to 230°C (446°F) without sealing, excessive curling, wrinkling, or
releasing hazardous emissions.

– Label adhesives, face sheet (printable stock), and topcoats can withstand up to 25 psi (172 kPa) pressure without
delaminating, oozing around the edges, or releasing hazardous fumes.

• Do not use labels with slick backing material.

• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets
also contaminate the printer and the cartridge with adhesive, and could void the printer and cartridge warranties.

• Do not use labels with exposed adhesive.

• Do not print within 1 mm (0.04 in.) of the edge of the label, of the perforations, or between die‑cuts of the label.

• Be sure adhesive backing does not reach to the sheet edge. Zone coating of the adhesive at least 1 mm (0.04 in.)
away from edges is recommended. Adhesive material contaminates the printer and could void the warranty.

• If zone coating of the adhesive is not possible, remove a 1.6‑mm (0.06‑in.) strip on the leading and driver edge, and
use a non‑oozing adhesive.

• Portrait orientation works best, especially when printing bar codes.
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Tips on using card stock
Card stock is heavy, single‑ply specialty media. Many of its variable characteristics, such as moisture content, thickness,
and texture, can significantly impact print quality. Print samples on the card stock being considered for use before
buying large quantities.

When printing on card stock:

• Feed card stock from a 250‑sheet tray, a 550‑sheet tray, or the multipurpose feeder.

• Make sure the Paper Type is Card Stock.

• Select the appropriate Paper Texture setting.

• Be aware that preprinting, perforation, and creasing may significantly affect the print quality and cause jams or
other paper handling problems.

• Check with the manufacturer or vendor to ensure the card stock can withstand temperatures up to 230°C (446°F)
without releasing hazardous emissions.

• Do not use preprinted card stock manufactured with chemicals that may contaminate the printer. Preprinting
introduces semi‑liquid and volatile components into the printer.

• Use grain short card stock when possible.

Printing confidential and other held jobs

Holding jobs in the printer
When sending a job to the printer, you can specify that you want the printer to hold the job in memory until you start
the job from the printer control panel. All print jobs that can be initiated by the user at the printer are called held jobs.

Note: Confidential, Verify, Reserve, and Repeat print jobs may be deleted if the printer requires extra memory to
process additional held jobs.

Job type Description

Confidential When you send a Confidential print job to the printer, you must create a PIN from
the computer. The PIN must be four digits using the numbers 0–9. The job is held
in printer memory until you enter the PIN from the printer control panel and
choose to print or delete the job.

Verify When you send a Verify print job, the printer prints one copy and holds the
remaining copies in printer memory. Verify lets you examine the first copy to see
if it is satisfactory before printing the remaining copies. Once all copies are printed,
the job is automatically deleted from printer memory.

Reserve When you send a Reserve print job, the printer does not print the job immediately.
It stores the job in memory so you can print the job later. The job is held in memory
until you delete it from the Held Jobs menu.

Repeat When you send a Repeat print job, the printer prints all requested copies of the
job and stores the job in memory so you can print additional copies later. You can
print additional copies as long as the job remains stored in memory.

Other types of held jobs include:

• Profiles from various sources including Lexmark Document Solutions Suite (LDSS)

• Forms from a kiosk
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• Bookmarks

• Jobs not printed, which are called parked jobs

Printing confidential and other held jobs from Windows

Note: Confidential and Verify print jobs are automatically deleted from memory after they print. Repeat and Reserve
jobs continue to be held in the printer until you choose to delete them.

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Click Other Options, and then click Print and Hold.

4 Select your job type (Confidential, Reserve, Repeat, or Verify), and then assign a user name. For a confidential job,
also enter a four‑digit PIN.

5 Click OK or Print, and then go to the printer to release the job.

6 On the home screen, touch Held jobs.

7 Touch your user name.

Note: A maximum of 500 results can be displayed for held jobs. If your name does not appear, touch the down
arrow until your name appears, or touch Search Held Jobs if there are a large number of held jobs in the printer.

8 Touch Confidential Jobs.

9 Enter your PIN.

10 Touch Done.

11 Touch the job you want to print.

12 Touch Print, or touch the arrows to increase or decrease the number of copies, and then touch Print.

Printing confidential and other held jobs from a Macintosh computer

Note: Confidential and Verify print jobs are automatically deleted from memory after they print. Repeat and Reserve
jobs continue to be held in the printer until you choose to delete them.

1 With a document open, choose File > Print.

If necessary, click the disclosure triangle to see more options.

2 From the print options or Copies & Pages pop‑up menu, choose Job Routing.

3 Select your job type (Confidential, Reserve, Repeat, or Verify), and then assign a user name. For a confidential job,
also enter a four‑digit PIN.

4 Click OK or Print, and then go to the printer to release the job.

5 On the home screen, touch Held jobs.

6 Touch your user name.

Note: A maximum of 500 results can be displayed for held jobs. If your name does not appear, touch the down
arrow until your name appears, or touch Search Held Jobs if there are a large number of held jobs in the printer.

7 Touch Confidential Jobs.
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8 Enter your PIN.

9 Touch the job you want to print.

10 Touch Print, or touch the arrows to increase or decrease the number of copies, and then touch Print.

Printing from a flash drive
A USB port is located on the printer control panel. Insert a flash drive to print supported file types. Supported file types
include: .pdf, .gif, .jpeg, .jpg, .bmp, .png, .tiff, .tif, .pcx, and .dcx.

The following flash drives are tested and approved for use with the printer:

• Lexar FireFly (512 MB or 1GB)

• SanDisk Cruizer Micro (512 MB or 1 GB)

• Sony (512 MB or 1GB)

Notes:

• Hi‑Speed flash drives must support the USB 2.0 specification, specifically supporting the High Speed mode.

• USB devices must support the FAT (File Allocation Tables) system. Flash drives formatted with NTFS (New
Technology File System) or any other file system are not supported.

• Before printing an encrypted .pdf file, you will be prompted to enter the file password from the printer control
panel.

• You cannot print files for which you do not have printing permissions.

• Some USB drives and USB hubs are not supported.

To print from a flash drive:

1 Make sure the printer is on and Ready appears.

2 Insert a flash drive into the USB port.
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Notes:

• If you insert the flash drive when the printer requires attention, such as when a jam has occurred, then the
printer ignores the flash drive.

• If you insert the flash drive while the printer is printing other jobs, then Printer Busy appears. When
the current job is completed, touch the USB icon to print documents from the flash drive.

3 Touch the document you want to print.

Note: Folders found on the flash drive appear as folders. File names are appended by the extension type (for
example, .jpg).

4 Touch the arrows if you want to increase the number of printed copies.

5 Touch Print.

Note: Do not remove the flash drive from the USB port until the document has finished printing.

If you leave the flash drive in the printer after leaving the initial USB menu screen, but you still want to print files
from the flash drive, then go to the home screen, touch the USB icon, and print the files.

Printing information pages

Printing a font sample list
To print samples of the fonts currently available for your printer:

1 Make sure the printer is on and Ready appears.

2 On the home screen, touch .

3 Touch Reports.

4 Touch the down arrow until Print Fonts appears.

5 Touch Print Fonts.

6 Touch PCL Fonts or PostScript Fonts.

A font sample list prints.

7 Touch  to return to the home screen.

Printing a directory list
A directory list shows the resources stored in flash memory or on the printer hard disk.

1 Make sure the printer is on and Ready appears.

2 On the home screen, touch .

3 Touch Reports.

4 Touch the down arrow until Print Directory appears.

5 Touch Print Directory.
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Printing the print quality test pages
Print the print quality test pages to isolate print quality problems.

1 Turn the printer off.

2 Hold down  and 6MNO  while turning the printer on.

3 Release the buttons when the screen with the progress bar appears.

The printer performs a power‑on sequence, and then the Configuration menu appears.

4 Touch the down arrow until Print Quality Pages appears.

5 Touch Print Quality Pages.

The print quality test pages print.

6 Touch Back.

7 Touch Exit Config menu.

Canceling a print job

Canceling a print job from the printer control panel

1 Touch Cancel Jobs on the touch screen, or press  on the keypad.

2 Touch the job you want to cancel.

3 Touch Delete Selected Jobs.

Canceling a print job from the computer
To cancel a print job, do one of the following:

For Windows users

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type control printers.

3 Press Enter, or click OK.

The printer folder opens.

4 Double‑click the printer icon.

5 Select the job to cancel.

6 From the keyboard, press Delete.

From the Windows taskbar:
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When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1 Double‑click the printer icon.

A list of print jobs appears in the printer window.

2 Select a job to cancel.

3 From the keyboard, press Delete.

For Macintosh users

In Mac OS X version 10.5 or later:

1 From the Apple menu, choose System Preferences.

2 Click Print & Fax, and then double‑click the printer icon.

3 From the printer window, select the job to cancel.

4 From the icon bar at the top of the window, click the Delete icon.

In Mac OS X version 10.4 and earlier:

1 From the Go menu, choose Applications.

2 Double‑click Utilities, and then double‑click Print Center or Printer Setup Utility.

3 Double‑click the printer icon.

4 From the printer window, select the job to cancel.

5 From the icon bar at the top of the window, click the Delete icon.
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Clearing jams
Jam error messages appear on the printer control panel display and include the area of the printer where the jam
occurred. When there is more than one jam, the number of jammed pages is displayed.

Understanding jam numbers and locations
When a jam occurs, a message indicating the jam location appears on the display. Open doors and covers and remove
trays to access jam locations. To resolve any paper jam message, you must clear all jammed paper from the paper path
and then touch Continue.

Jam numbers Area

200–203, 230 Printer

241–245 Paper trays

250 Multipurpose feeder

271–279 Optional output bins

280–282 StapleSmart II Finisher

283 Staple cartridge

200 and 201 paper jams
1 Lower the multipurpose feeder door, and then push the release latch to open the front cover.

2

1

3

4

2 Lift and pull the print cartridge out of the printer.

Warning—Potential Damage: Do not touch the photoconductor drum on the underside of the cartridge. Use
the cartridge handle whenever you are holding the cartridge.
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3 Place the print cartridge aside on a flat, smooth surface.

Warning—Potential Damage: Do not leave the cartridge exposed to light for extended periods.

Warning—Potential Damage: The jammed paper may be covered with unfused toner which can stain garments
and skin.

4 Remove the jammed paper.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

Note: If the paper is not easy to remove, then open the rear door and remove the paper from there.

5 Align and reinstall the print cartridge.

6 Close the front cover.

7 Close the multipurpose feeder door.

8 Touch Continue.

202 and 203 paper jams
Touch Status/Supplies to identify the location of the jam. If the paper is exiting the printer, then pull the paper out,
and then touch Continue.

If the paper is not exiting the printer:

1 Open the upper rear door.

2 Slowly remove the jammed paper to avoid tearing it.
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3 Close the upper rear door.

4 Touch Continue.

230 paper jam

Rear paper jams

1 Remove the standard tray.

2 Open the lower rear door.

3 If you do not find the jam, push the tab down.

4 Remove the jammed paper.

5 Close the lower rear door.

6 Insert the standard tray.

7 Touch Continue.

Front paper jams

1 Remove the standard tray from the printer.

2 Push the tab down.

2

1

Clearing jams 86



3 Remove the jammed paper.

4 Insert the standard tray.

5 Touch Continue.

241–245 paper jams
1 Pull out the tray indicated on the display.

2 Remove any jammed paper, and then insert the tray.

3 Touch Continue.

4 If the jam message persists for a 250‑ or 550‑sheet tray, then remove the tray from the printer.

5 Remove the jammed paper, and then insert the tray.

6 Touch Continue.

250 paper jam
1 Touch Status/Supplies to identify the location of the jam.

2 Remove the paper from the multipurpose feeder.

3 Flex the sheets of paper back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten
the edges on a level surface.

4 Load the paper into the multipurpose feeder.
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5 Slide the paper guide toward the inside of the tray until it lightly rests against the edge of the paper.

6 Touch Continue.

270–279 paper jams
To clear a jam in the high‑capacity output stacker or the 5‑bin mailbox:

1 Touch Status/Supplies to identify the location of the jam.

2 If the paper is exiting into a bin, then pull the paper straight out, and then touch Continue.

If not, then continue with step 3.

3 Pull down the output bin door or doors.

4 Remove the jammed paper.

5 Close the output bin door or doors.

6 Touch Continue.

280–282 paper jams
1 Touch Status/Supplies to identify the location of the jam.

2 Pull down the StapleSmart finisher door.

3 Remove the jammed paper.

4 Close the StapleSmart finisher door.

5 Touch Continue.
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283 staple jams
1 Touch Status/Supplies to identify the location of the jam.

2 Press the latch to open the stapler door.

3 Pull the latch of the staple cartridge holder down, and then pull the holder out of the printer.

4 Use the metal tab to lift the staple guard, and then remove any loose staples.

5 Close the staple guard.
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6 Press down on the staple guard until it snaps into place.

7 Push the cartridge holder firmly back into the stapler unit until the cartridge holder clicks into place.

8 Close the stapler door.
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Understanding printer menus

Menus list
Paper Menu Reports Network/Ports

Default Source

Paper Size/Type

Configure MP

Envelope Enhance

Substitute Size

Paper Texture

Paper Weight

Paper Loading

Custom Types

Custom Names

Custom Bin Names

Universal Setup

Bin Setup

Menu Settings Page

Device Statistics

Network Setup Page1

Profiles List

NetWare Setup Page

Print Fonts

Print Directory

Asset Report

Active NIC

Standard Network2

Standard USB

Parallel <x>

Serial <x>

SMTP Setup

1 Depending on the printer setup, this menu item appears as Network Setup Page or Network <x> Setup Page.
2 Depending on the printer setup, this menu item appears as Standard Network or Network <x>.

Security Settings Help

Edit Security Setups

Miscellaneous Security Settings

Confidential Print

Disk Wiping

Security Audit Log

Set Date/Time

General Settings

Flash Drive Menu

Setup Menu

Finishing Menu

Quality Menu

Utilities Menu

XPS Menu

PDF Menu

PostScript Menu

PCL Emul Menu

HTML Menu

Image Menu

Print Defects

Supplies Guide
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Paper menu

Default Source menu

Menu item Description

Default Source
Tray <x>
MP Feeder
Manual Paper
Manual Envelope

Sets a default paper source for all print jobs

Notes:

• Tray 1 (standard tray) is the factory default setting.

• Only an installed paper source will appear as a menu setting.

• A paper source selected by a print job will override the Default Source
setting for the duration of the print job.

• If the same size and type of paper are in two trays and the Paper Size and
Paper Type settings match, then the trays are automatically linked. When
one tray is empty, the job prints using the linked tray.

• From the Paper menu, Configure MP must be set to Cassette in order for
MP Feeder to appear as a menu setting.

Paper Size/Type menu

Menu item Description

Tray <x> Size
A4
A5
A6
JIS B5
Letter
Legal

Executive*

Oficio*

Folio

Statement*

Universal

Specifies the paper size loaded in each tray

Notes:

• A4 is the international factory default setting. Letter is the US factory
default setting.

• For trays with automatic size sensing, only the size detected by the
hardware appears.

• Use this menu item to configure automatic tray linking. If the same size
and type of paper are in two trays and the Paper Size and Paper Type
settings match, then the trays are automatically linked. When one tray
is empty, the job prints using the linked tray.

• Automatic size sensing is not supported for Oficio, Folio, or Statement
paper sizes.

• The 2000‑sheet tray supports A4, Letter, and Legal paper sizes.

* Appears only if Tray Size Sensing is turned off.

Note: Only installed trays, drawers, and feeders are listed in this menu.
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Menu item Description

Tray <x> Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Vinyl Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton Paper
Custom Type <x>

Specifies the type of paper loaded in each tray

Notes:

• Plain Paper is the factory default setting for Tray 1. Custom Type <x> is
the factory default setting for all other trays.

• If available, a user‑defined name will appear instead of Custom
Type <x>.

• Use this menu item to configure automatic tray linking. If the same size
and type of paper are in two trays and the Paper Size and Paper Type
settings match, then the trays are automatically linked. When one tray
is empty, the job prints using the linked tray.

MP Feeder Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio
Folio
Statement
Universal
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
Other Envelope

Specifies the paper size loaded in the multipurpose feeder

Notes:

• From the Paper menu, Configure MP must be set to Cassette in order
for MP Feeder Size to appear as a menu item.

• A4 is the international factory default setting. Letter is the US factory
default setting.

• The multipurpose feeder does not automatically sense paper size. The
paper size value must be set.

* Appears only if Tray Size Sensing is turned off.

Note: Only installed trays, drawers, and feeders are listed in this menu.
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Menu item Description

MP Feeder Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Vinyl Labels
Bond
Envelope
Rough Envelope
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton Paper
Custom Type <x>

Specifies the type of paper loaded in the multipurpose feeder

Notes:

• From the Paper menu, Configure MP must be set to Cassette in order
for MP Feeder Type to appear as a menu item.

• Plain Paper is the factory default setting.

Manual Paper Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio
Folio
Statement
Universal

Specifies the size of the paper being manually loaded

Note: A4 is the international factory default setting. Letter is the US factory
default setting.

* Appears only if Tray Size Sensing is turned off.

Note: Only installed trays, drawers, and feeders are listed in this menu.
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Menu item Description

Manual Paper Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Vinyl Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton Paper
Custom Type <x>

Specifies the type of paper being manually loaded

Note: Plain Paper is the factory default setting.

Manual Envelope Size
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
Other Envelope

Specifies the size of the envelope being manually loaded

Note: DL Envelope is the international factory default setting. 10 Envelope is
the US factory default setting.

Manual Envelope Type
Envelope
Rough Envelope
Custom Type <x>

Specifies the type of envelope being manually loaded

Note: Envelope is the factory default setting.

* Appears only if Tray Size Sensing is turned off.

Note: Only installed trays, drawers, and feeders are listed in this menu.

Configure MP menu

Menu item Description

Configure MP
Cassette
Manual
First

Determines when the printer selects paper from the multipurpose feeder

Notes:

• Cassette is the factory default setting.

• The Cassette setting configures the multipurpose feeder as an automatic
paper source.

• When Manual is selected, the multipurpose feeder can be used only for
manual feed print jobs.

• If paper is loaded in the multipurpose feeder and First is selected, then
paper always feeds from the multipurpose feeder first.
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Envelope Enhance
The envelope conditioner significantly reduces the wrinkling of some envelopes.

Menu item Description

Envelope Enhance
Off
1 (Least)
2
3
4
5
6 (Most)

Enables or disables the envelope conditioner

Notes:

• The factory default setting is 5.

• If noise reduction is more important than wrinkle reduction, then
decrease the setting.

Substitute Size menu

Menu item Description

Substitute Size
Off
Statement/A5
Letter/A4
All Listed

Substitutes a specified paper size if the requested paper size is not available

Notes:

• All Listed is the factory default setting. All available substitutions are
allowed.

• The Off setting indicates no size substitutions are allowed.

• Setting a substitution lets the job print without a Change Paper message
appearing.

Paper Texture menu

Menu item Description

Plain Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Note: Normal is the factory default setting.

Card Stock Texture
Smooth
Normal
Rough

Specifies the relative texture of the card stock loaded in a specific tray

Notes:

• Normal is the factory default setting.

• Settings appear only if card stock is supported.

Transparency Texture
Smooth
Normal
Rough

Specifies the relative texture of the transparencies loaded in a specific tray

Note: Normal is the factory default setting.
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Menu item Description

Recycled Texture
Smooth
Normal
Rough

Specifies the relative texture of the recycled paper loaded in a specific tray

Note: Normal is the factory default setting.

Labels Texture
Smooth
Normal
Rough

Specifies the relative texture of the labels loaded in a specific tray

Note: Normal is the factory default setting.

Vinyl Labels Texture
Smooth
Normal
Rough

Specifies the relative texture of the vinyl labels loaded in a specific tray

Note: Normal is the factory default setting.

Bond Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Note: Rough is the factory default setting.

Envelope Texture
Smooth
Normal
Rough

Specifies the relative texture of the envelopes loaded in a specific tray

Note: Normal is the factory default setting.

Rough Envelope Texture
Smooth
Normal
Rough

Specifies the relative texture of the rough envelopes loaded in a specific tray

Note: Rough is the factory default setting.

Letterhead Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Note: Normal is the factory default setting.

Preprinted Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Note: Normal is the factory default setting.

Colored Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Note: Normal is the factory default setting.

Light Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Note: Normal is the factory default setting.
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Menu item Description

Heavy Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Note: Normal is the factory default setting.

Rough Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Note: Rough is the factory default setting.

Custom <x> Texture
Smooth
Normal
Rough

Specifies the relative texture of the custom paper loaded in a specific tray

Note: Normal is the factory default setting.

Paper Weight menu

Menu item Description

Plain Weight
Light
Normal
Heavy

Specifies the relative weight of the paper loaded in a specific tray

Note: Normal is the factory default setting.

Card Stock Weight
Light
Normal
Heavy

Specifies the relative weight of the card stock loaded in a specific tray

Note: Normal is the factory default setting.

Transparency Weight
Light
Normal
Heavy

Specifies the relative weight of the paper loaded in a specific tray

Note: Normal is the factory default setting.

Recycled Weight
Light
Normal
Heavy

Specifies the relative weight of the recycled paper loaded in a specific tray

Note: Normal is the factory default setting.

Labels Weight
Light
Normal
Heavy

Specifies the relative weight of the labels loaded in a specific tray

Note: Normal is the factory default setting.

Vinyl Labels Weight
Light
Normal
Heavy

Specifies the relative weight of the vinyl labels loaded in a specific tray

Note: Normal is the factory default setting.
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Menu item Description

Bond Weight
Light
Normal
Heavy

Specifies the relative weight of the paper loaded in a specific tray

Note: Normal is the factory default setting.

Envelope Weight
Light
Normal
Heavy

Specifies the relative weight of the envelopes loaded in a specific tray

Note: Normal is the factory default setting.

Rough Envelope Weight
Light
Normal
Heavy

Specifies the relative weight of the rough envelopes loaded in a specific tray

Note: Normal is the factory default setting.

Letterhead Weight
Light
Normal
Heavy

Specifies the relative weight of the paper loaded in a specific tray

Note: Normal is the factory default setting.

Preprinted Weight
Light
Normal
Heavy

Specifies the relative weight of the paper loaded in a specific tray

Note: Normal is the factory default setting.

Colored Weight
Light
Normal
Heavy

Specifies the relative weight of the paper loaded in a specific tray

Note: Normal is the factory default setting.

Light Weight
Light

Specifies the relative weight of the paper loaded in a specific tray

Heavy Weight
Heavy

Specifies the relative weight of the paper loaded in a specific tray

Rough Weight
Light
Normal
Heavy

Specifies the relative weight of the paper loaded in a specific tray

Note: Normal is the factory default setting.

Custom <x>
Light
Normal
Heavy

Specifies the relative weight of the custom paper type loaded in a specific tray

Notes:

• Normal is the factory default setting.

• Settings appear only if the custom type is supported.
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Paper Loading menu

Menu item Description

Card Stock Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Card Stock as the paper type

Note: Off is the factory default setting.

Recycled Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Recycled as the paper type

Note: Off is the factory default setting.

Labels Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Labels as the paper type

Note: Off is the factory default setting.

Vinyl Labels Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Vinyl Labels as the paper type

Note: Off is the factory default setting.

Bond Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Bond as the paper type

Note: Off is the factory default setting.

Letterhead Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Letterhead as the paper type

Note: Off is the factory default setting.

Preprinted Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Preprinted as the paper type

Note: Off is the factory default setting.

Colored Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Colored as the paper type

Note: Off is the factory default setting.

Light Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Light as the paper type

Note: Off is the factory default setting.

Heavy Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Heavy as the paper type

Note: Off is the factory default setting.

Rough Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Rough as the paper type

Note: Off is the factory default setting.

Note: Duplex sets the printer default to 2‑sided printing for every print job unless 1‑sided printing is selected from Print
Properties in Windows or the Print dialog in Macintosh.
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Menu item Description

Custom <x> Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Custom <x> as the paper type

Notes:

• Off is the factory default setting.

• Custom <x> Loading is available only if the custom type is
supported.

Note: Duplex sets the printer default to 2‑sided printing for every print job unless 1‑sided printing is selected from Print
Properties in Windows or the Print dialog in Macintosh.

Custom Types menu

Menu item Description

Custom Type <x>
Paper
Card Stock
Transparency
Labels
Vinyl Labels
Envelope

Associates a paper or specialty media type with a factory default Custom
Type <x> name or a user‑defined Custom Name created from the Embedded
Web Server or MarkVisionTM Professional

Notes:

• Paper is the factory default setting.

• The custom media type must be supported by the selected tray or
multipurpose feeder in order to print from that source.

Recycled
Paper
Card Stock
Transparency
Labels
Vinyl Labels
Envelope

Specifies a paper type when the Recycled setting is selected in other menus

Notes:

• Paper is the factory default setting.

• The custom media type must be supported by the selected tray or
multipurpose feeder in order to print from that source.

Custom Names menu

Menu item Definition

Custom Name <x>
<none>

Specify a custom name for a paper type. This name replaces a Custom Type
<x> name in the printer menus.

Custom Bin Names menu

Menu Item Description

Standard Bin Specifies a custom name for the Standard Bin

Bin [x] Specifies a custom name for Bin [x]
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Universal Setup menu
These menu items are used to specify the height, width, and feed direction of the Universal Paper Size. The Universal
Paper Size is a user‑defined paper size setting. It is listed with the other paper size settings and includes similar options,
such as support for duplex printing and printing multiple pages on one sheet.

Menu item Description

Units of Measure
Inches
Millimeters

Identifies the units of measure

Notes:

• Inches is the US factory default setting.

• Millimeters is the international factory default setting.

Portrait Width
3–14 inches
76–360 mm

Sets the portrait width

Notes:

• If the width exceeds the maximum, the printer uses the maximum
width allowed.

• 8.5 inches is the US factory default setting. Inches can be increased
in 0.01‑inch increments.

• 216 mm is the international factory default setting. Millimeters can
be increased in 1‑mm increments.

Portrait Height
3–14 inches
76–360 mm

Sets the portrait height

Notes:

• If the height exceeds the maximum, the printer uses the maximum
height allowed.

• 14 inches is the US factory default setting. Inches can be increased in
0.01‑inch increments.

• 356 mm is the international factory default setting. Millimeters can
be increased in 1‑mm increments.

Feed Direction
Short Edge
Long Edge

Specifies the feed direction if the paper can be loaded in either direction

Notes:

• Short Edge is the factory default setting.

• Long Edge appears only if the longest edge is shorter than the
maximum width supported in the tray.

Bin Setup menu

Menu Item Description

Output Bin
Standard Bin
Bin <x>

Specifies the default output bin

Note: Standard Bin is the factory default setting.
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Menu Item Description

Configure Bins
Mailbox
Link
Mail Overflow
Link Optional
Type Assignment

Specifies configuration options for output bins

Notes:

• Mailbox is the factory default setting.

• Bins assigned the same name are automatically
linked unless Link Optional is selected.

• The Mailbox setting treats each bin as a separate
mailbox.

• The Link setting links together all available output
bins.

• The Link Optional setting links together all available
output bins except the standard bin and only appears
when at least two optional bins are installed.

• The Type Assignment setting assigns each paper type
to an output bin or linked bin set.

Overflow Bin
Standard Bin
Bin <x>

Specifies an alternate output bin when a designated bin is
full

Note: Standard Bin is the factory default setting.

Assign Type/Bin
Plain Paper Bin
Card Stock Bin
Transparency Bin
Recycled Bin
Labels Bin
Vinyl Labels Bin
Bond Bin
Envelope Bin
Rough Envelope Bin
Letterhead Bin
Preprinted Bin
Colored Bin
Light Bin
Heavy Bin
Rough/Cotton Bin
Custom <x> Bin

Selects an output bin for each supported paper type

Available selections for each type are:
Disabled
Standard Bin
Bin <x>

Note: Standard Bin is the factory default setting.

Reports menu

Menu item Description

Menu Settings Page Prints a report containing information about paper loaded into trays, installed
memory, the total page count, alarms, timeouts, the printer control panel
language, the TCP/IP address, the status of supplies, the status of the network
connection, and other information
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Menu item Description

Device Statistics Prints a report containing printer statistics such as supply information and details
about printed pages

Network Setup Page Prints a report containing information about the network printer settings, such
as the TCP/IP address information

Note: This menu item appears only for network printers or printers connected
to print servers.

Network <x> Setup Page Prints a report containing information about the network printer settings, such
as the TCP/IP address information

Notes:

• This menu item is available when more than one network option is
installed.

• This menu item appears only for network printers or printers connected to
print servers.

Profiles List Prints a list of profiles stored in the printer

NetWare Setup Page Prints a report containing NetWare‑specific information about the network
settings

Note: This menu item appears only for printers with an internal print server
installed.

Print Fonts
PCL Fonts
PostScript Fonts

Prints a report in English of all the fonts available for the printer language currently
set in the printer

Note: A separate list is available for PCL and PostScript emulations. Each
emulator report contains print samples and information about the language's
available fonts.

Print Directory Prints a list of all the resources stored on an optional flash memory card or printer
hard disk

Notes:

• Job Buffer Size must be set to 100%.

• The optional flash memory or printer hard disk must be installed correctly
and working properly.

Asset Report Prints a report containing asset information including the printer serial number
and model name. The report contains text and UPC barcodes that can be scanned
into an asset database.
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Network/Ports menu

Active NIC menu

Menu item Description

Active NIC
Auto
<list of available network cards>

Notes:

• Auto is the factory default setting.

• This menu item appears only if an optional network card is installed.

Standard Network or Network <x> menus
Note: Only active ports appear in this menu; all inactive ports are omitted.

Menu item Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job requires
it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PostScript emulation if PS
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PS SmartSwitch is set to Off.

PS SmartSwitch
On
Off

Sets the printer to automatically switch to PS emulation when a print job requires
it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PCL emulation if PCL
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PCL SmartSwitch is set to Off.

NPA Mode
Off
Auto

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol

Notes:

• Auto is the factory default setting.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
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Menu item Description

Network Buffer
Auto
3K to <maximum size allowed>

Sets the size of the network input buffer

Notes:

• Auto is the factory default setting.

• The value can be changed in 1‑K increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the Network Buffer, disable or
reduce the size of the parallel, serial, and USB buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.

Job Buffering
Off
On
Auto

Temporarily stores jobs on the printer hard disk before printing. This menu only
appears if a formatted disk is installed.

Notes:

• Off is the factory default setting.

• The On value buffers jobs on the printer hard disk. This menu selection
appears only when a formatted disk is installed and is not defective.

• The Auto setting buffers print jobs only if the printer is busy processing data
from another input port.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.

Mac Binary PS
On
Off
Auto

Sets the printer to process Macintosh binary PostScript print jobs

Notes:

• Auto is the factory default setting.

• The Off setting filters print jobs using the standard protocol.

• The On setting processes raw binary PostScript print jobs.
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Menu item Description

Standard Network Setup
Reports or Network Reports
Network Card
TCP/IP
IPv6
AppleTalk
NetWare
LexLink

Network <x> Setup
Reports or Network Reports
Network Card
TCP/IP
IPv6
Wireless
AppleTalk
NetWare
LexLink

For descriptions and settings of the network setup menus, see the following:

• “Network Reports menu” on page 107

• “Network Card menu” on page 107

• “TCP/IP menu” on page 108

• “IPv6 menu” on page 109

• “Wireless menu” on page 110

• “AppleTalk menu” on page 110

• “NetWare menu” on page 111

• “LexLink menu” on page 111

Note: The Wireless menu appears only when the printer is connected to a wireless
network.

Network Reports menu
This menu is available from the Network/Ports menu:

Network/Ports > Standard Network or Network <x> > Standard Network Setup or Network <x> Setup > Reports or
Network Reports

Menu item Description

Print Setup Page

Print NetWare Setup
Page

Prints a report containing information about the current network setup

Notes:

• The Setup Page contains information about the network printer settings, such as the
TCP/IP address.

• The NetWare Setup Page menu item appears only on models that support NetWare and
shows information about NetWare settings.

Network Card menu
This menu is available from the Network/Ports menu:

Network/Ports > Standard Network or Network <x> > Standard Network Setup or Network <x> Setup > Network Card

Menu item Description

View Card Status
Connected
Disconnected

Shows the connection status of the Network Card

View Card Speed Shows the speed of a currently active network card
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Menu item Description

View Network Address
UAA
LAA

Shows the network addresses

End‑of‑Job Timeout

0‑225 seconds

Sets the amount of time in seconds that a network print job can take before it
is canceled

Notes:

• 90 seconds is the factory default setting.

• A setting value of 0 disables the timeout.

• If a value of 1–9 is selected, then the setting is saved as 10.

Banner Page
Off
On

Allows the printer to print a banner page

Note: Off is the factory default setting.

TCP/IP menu
Use the following menu items to view or set the TCP/IP information.

Note: This menu is available only for network models or printers attached to print servers.

This menu is available from the Network/Ports menu:

Network/Ports > Standard Network or Network <x> > Standard Network Setup or Network <x> Setup > TCP/IP

Menu item Description

Activate
On
Off

Activates TCP/IP

Note: On is the factory default setting.

View Hostname Shows the current TCP/IP hostname

Note: This can be changed only from the Embedded Web Server.

IP Address Shows the current TCP/IP Address

Note: Manually setting the IP address sets the Enable DHCP and Enable Auto IP
settings to Off. It also sets Enable BOOTP and Enable RARP to Off on systems that
support BOOTP and RARP.

Netmask Shows the current TCP/IP Netmask

Gateway Shows the current TCP/IP Gateway

Enable DHCP
On
Off

Specifies the DHCP address and parameter assignment setting

Enable RARP
On
Off

Specifies the RARP address assignment setting

Note: On is the factory default setting.
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Menu item Description

Enable BOOTP
On
Off

Specifies the BOOTP address assignment setting

Note: On is the factory default setting.

Enable AutoIP
Yes
No

Specifies the Zero Configuration Networking setting

Note: Yes is the factory default setting.

Enable FTP/TFTP
Yes
No

Enables the built-in FTP server, which allows you to send files to the printer using the
File Transfer Protocol

Note: Yes is the factory default setting.

Enable HTTP Server
Yes
No

Enables the built-in Web server (Embedded Web Server). When enabled, the printer
can be monitored and managed remotely using a Web browser.

Note: Yes is the factory default setting.

WINS Server Address Shows the current WINS Server Address

Enable DDNS
Yes
No

Enables DDNS in the printer

Note: Yes is the factory default setting.

Enable mDNS
Yes
No

Enables mDNS in the printer

Note: Yes is the factory default setting.

DNS Server Address Shows the current DNS Server Address

Enable HTTPS
Yes
No

Enables HTTPS in the printer

Note: Yes is the factory default setting.

IPv6 menu
Use the following menu items to view or set the Internet Protocol version 6 (IPv6) information.

Note: This menu is available only for network models or printers attached to print servers.

This menu is available from the Network/Ports menu:

Network/Ports > Standard Network or Network <x> > Standard Network Setup or Network <x> Setup > IPv6

Menu item Description

Enable IPv6
On
Off

Enables IPv6 in the printer

Note: On is the factory default setting.

Auto Configuration
On
Off

Specifies whether the network adapter accepts the automatic IPv6
address configuration entries provided by a router

Note: On is the factory default setting.
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Menu item Description

View Hostname

View Address

View Router Address

Shows the current setting

Note: These settings can be changed only from the Embedded Web
Server.

Enable DHCPv6
On
Off

Enables DHCPv6 in the printer

Note: On is the factory default setting.

Wireless menu
Use the following menu items to view or configure the wireless internal print server settings.

Note: This menu is available only for models connected to a wireless network.

This menu is available from the Network/Ports menu:

Network/Ports > Network <x> > Network <x> Setup > Wireless

Menu item Description

Network Mode
Infrastructure
Ad hoc

Specifies the network mode

Notes:

• Infrastructure mode lets the printer access a network using an
access point.

• Ad hoc is the factory default setting. Ad hoc mode configures the
printer for wireless networking directly between it and a computer.

Compatibility
802.11n
802.11b/g
802.11b/g/n

Specifies the wireless standard for the wireless network

Note: 802.11b/g/n is the factory default setting.

Choose Network
<list of available networks>

Shows an available network for the printer to use

View Signal Quality Shows the quality of the wireless connection

View Security Mode Shows the encryption method for the wireless connection. “Disabled”
indicates that the wireless network is not encrypted.

AppleTalk menu
This menu is available from the Network/Ports menu:

Network/Ports > Standard Network or Network <x> > Standard Network Setup or Network <x> Setup > AppleTalk

Menu item Description

Activate
Yes
No

Activates AppleTalk support

Note: Yes is the factory default setting.
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Menu item Description

View Name Shows the assigned AppleTalk name

Note: The name can be changed only from the Embedded Web Server.

View Address Shows the assigned AppleTalk address

Note: The address can be changed only from the Embedded Web Server.

Set Zone
<list of zones available on the
network>

Provides a list of AppleTalk zones available on the network

Note: The default setting is the default zone for the network. If no default
zone exists, the zone marked with an * is the default setting.

NetWare menu
This menu is available from the Network/Ports menu:

Network/Ports > Standard Network or Network <x> > Standard Network Setup or Network <x> Setup > NetWare

Menu item Description

Activate
Yes
No

Activates NetWare support

Note: No is the factory default setting.

View Login Name Shows the assigned NetWare login name

Note: This can be changed only from the Embedded Web Server.

Print Mode Shows the assigned NetWare print mode

Note: This can be changed only from the Embedded Web Server.

Network Number Shows the assigned NetWare network number

Note: This can be changed only from the Embedded Web Server.

Select IPX Frame Types
Ethernet 802.2
Ethernet 802.3
Ethernet Type II
Ethernet SNAP

Enables the Ethernet frame type setting

Note: On is the factory default setting for all menu items.

Packet Burst
Yes
No

Reduces network traffic by allowing the transfer and acknowledgement of
multiple data packets to and from the NetWare server

Note: Yes is the factory default setting.

NSQ/GSQ Mode
Yes
No

Specifies the NSQ/GSQ Mode setting

Note: No is the factory default setting.

LexLink menu
This menu is available from the Network/Ports menu:

Understanding printer menus 111



Network/Ports > Standard Network or Network <x> > Standard Network Setup or Network <x> Setup > LexLink menu

Menu item Description

Activate
On
Off

Activates LexLink support

Note: Off is the factory default setting.

View Nickname Shows the assigned LexLink nickname

Note: The LexLink nickname can be changed only from the Embedded Web
Server.

Standard USB menu

Menu item Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job received
through a USB port requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PostScript emulation if the PS
SmartSwitch setting is On. It uses the default printer language specified in the
Setup menu if the PS SmartSwitch setting is Off.

PS SmartSwitch
On
Off

Sets the printer to automatically switch to PS emulation when a print job received
through a USB port requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PCL emulation if the PCL
SmartSwitch setting is On. It uses the default printer language specified in the
Setup menu if the PCL SmartSwitch setting is Off.

NPA Mode
On
Off
Auto

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol

Notes:

• Auto is the factory default setting.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
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Menu item Description

USB Buffer
Disabled
Auto
3K to <maximum size allowed>

Sets the size of the USB input buffer

Notes:

• Auto is the factory default setting.

• The Disabled setting turns off job buffering. Any jobs already buffered on the
disk are printed before normal processing is resumed.

• The USB buffer size value can be changed in 1‑K increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether the Resource Save setting is On
or Off.

• To increase the maximum size range for the USB Buffer, disable or reduce the
size of the parallel, serial, and network buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.

Job Buffering
Off
On
Auto

Temporarily stores jobs on the printer hard disk before printing

Notes:

• Off is the factory default setting.

• The On setting buffers jobs on the printer hard disk.

• The Auto setting buffers print jobs only if the printer is busy processing data
from another input port.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.

Mac Binary PS
On
Off
Auto

Sets the printer to process Macintosh binary PostScript print jobs

Notes:

• Auto is the factory default setting.

• The Off setting filters print jobs using the standard protocol.

• The On setting processes raw binary PostScript print jobs.

USB With ENA
ENA Address
ENA Netmask
ENA Gateway

Sets the network address, netmask, or gateway information for an external print
server that is attached to the printer using a USB cable.

Note: This menu item is available only if the printer is attached to an external print
server through the USB port.
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Parallel <x> menu
This menu appears only if an optional parallel card is installed.

Menu item Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job received
through a parallel port requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PostScript emulation if PS
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PS SmartSwitch is set to Off.

PS SmartSwitch
On
Off

Sets the printer to automatically switch to PS emulation when a print job received
through a parallel port requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PCL emulation if PCL
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PCL SmartSwitch is set to Off.

NPA Mode
On
Off
Auto

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol

Notes:

• Auto is the factory default setting.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.

Parallel Buffer
Disabled
Auto
3K to <max size allowed>

Sets the size of the parallel input buffer

Notes:

• Auto is the factory default setting.

• The Disabled setting turns off job buffering. Any jobs already buffered on the
disk are printed before normal processing is resumed.

• The parallel buffer size setting can be changed in 1K increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the Parallel Buffer, disable or reduce
the size of the USB, serial, and network buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
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Menu item Description

Job Buffering
Off
On
Auto

Temporarily stores jobs on the printer hard disk before printing

Notes:

• Off is the factory default setting.

• The Off setting does not buffer print jobs to the printer hard disk.

• The On setting buffers jobs on the printer hard disk.

• The Auto setting buffers print jobs only if the printer is busy processing data
from another input port.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.

Advanced Status
On
Off

Enables bidirectional communication through the parallel port

Notes:

• On is the factory default setting.

• The Off setting disables parallel port negotiation.

Protocol
Standard
Fastbytes

Specifies the parallel port protocol

Notes:

• Fastbytes is the factory default setting. It provides compatibility with most
existing parallel ports and is the recommended setting.

• The Standard setting tries to resolve parallel port communication problems.

Honor Init
On
Off

Determines whether or not the printer honors printer hardware initialization
requests from the computer

Notes:

• Off is the factory default setting.

• The computer requests initialization by activating the Init signal from the
parallel port. Many personal computers activate the Init signal each time the
computer is turned on.

Parallel Mode 2
On
Off

Determines whether the parallel port data is sampled on the leading or trailing edge
of strobe

Notes:

• On is the factory default setting.

• This menu appears only if a standard or optional parallel port is available.

Mac Binary PS
On
Off
Auto

Sets the printer to process Macintosh binary PostScript print jobs

Notes:

• Auto is the factory default setting.

• The Off setting filters print jobs using the standard protocol.

• The On setting processes raw binary PostScript print jobs.

Parallel With ENA
ENA Address
ENA Netmask
ENA Gateway

Sets the network address, netmask, or gateway information for an external print
server that is attached to the printer using a parallel cable.

Note: This menu item is available only if the printer is attached to an external print
server through a parallel port.
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Serial <x> menu
This menu appears only if an optional serial card is installed.

Menu item Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job received
through a serial port requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PostScript emulation if PS
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PS SmartSwitch is set to Off.

PS SmartSwitch
On
Off

Sets the printer to automatically switch to PS emulation when a print job received
through a serial port requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PCL emulation if PCL
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PCL SmartSwitch is set to Off.

NPA Mode
On
Off
Auto

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol

Notes:

• Auto is the factory default setting.

• When the On setting is used, the printer performs NPA processing. If the data
is not in NPA format, it is rejected as bad data.

• When the Off setting is used, the printer does not perform NPA processing.

• When the Auto setting is used, the printer examines data, determines the
format, and then processes it appropriately.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
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Menu item Description

Serial Buffer
Disabled
Auto
3K to <maximum size allowed>

Sets the size of the serial input buffer

Notes:

• Auto is the factory default setting.

• The Disabled setting turns off job buffering. Any jobs already buffered on the
disk are printed before normal processing is resumed.

• The serial buffer size setting can be changed in 1‑K increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the Serial Buffer, disable or reduce
the size of the parallel, USB, and network buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.

Job Buffering
Off
On
Auto

Temporarily stores jobs on the printer hard disk before printing

Notes:

• Off is the factory default setting.

• The Off setting does not buffer print jobs to the hard disk.

• The On setting buffers jobs on the printer hard disk.

• The Auto setting buffers print jobs only if the printer is busy processing data
from another input port.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.

Serial Protocol
DTR
DTR/DSR
XON/XOFF
XON/XOFF/DTR
XON/XOFF/DTRDSR

Selects the hardware and software handshaking settings for the serial port

Notes:

• DTR is the factory default setting.

• DTR/DSR is a hardware handshaking setting.

• XON/XOFF is a software handshaking setting.

• XON/XOFF/DTR and XON/XOFF/DTR/DSR are combined hardware and
software handshaking settings.

Robust XON
On
Off

Determines whether or not the printer communicates availability to the computer

Notes:

• Off is the factory default setting.

• This menu item applies only to the serial port if Serial Protocol is set to
XON/XOFF.

Understanding printer menus 117



Menu item Description

Baud
1200
2400
4800
9600
19200
38400
57600
115200
138200
172800
230400
345600

Specifies the rate at which data can be received through the serial port

Notes:

• 9600 is the factory default setting.

• 138200, 172800, 230400, and 345600 baud rates are displayed only in the
Standard Serial menu. These settings do not appear in the Serial Option or
Serial Option 2 menus.

Data Bits
7
8

Specifies the number of data bits that are sent in each transmission frame

Note: 8 is the factory default setting.

Parity
Even
Odd
None
Ignore

Sets the parity for serial input and output data frames

Note: None is the factory default setting.

Honor DSR
On
Off

Determines whether the printer uses the DSR Signal. DSR is a handshaking signal used
by most serial cables.

Notes:

• Off is the factory default setting.

• The serial port uses DSR to distinguish data sent by the computer from data
created by electrical noise in the serial cable. The electrical noise can cause
stray characters to print. Select On to prevent stray characters from printing.

• This menu item appears only if Serial RS‑232/RS‑422 is set to RS 232.

SMTP Setup menu
Use the following menu to configure the SMTP server.

Menu item Description

Primary SMTP Gateway

Primary SMTP Gateway Port

Secondary SMTP Gateway

Secondary SMTP Gateway Port

Specifies SMTP server port information

Note: 25 is the default SMTP gateway port. The range of possible port
numbers is 1‑65536.

SMTP Timeout
5–30

Specifies the amount of time in seconds before the server stops trying to
send the e‑mail

Note: 30 seconds is the factory default setting.
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Menu item Description

Reply Address Specifies a reply address of up to 128 characters in e-mail sent by the
printer

Use SSL
Disabled
Negotiate
Required

Sets the printer to use SSL for increased security when connecting to the
SMTP server

Notes:

• Disabled is the factory default setting for Use SSL.

• When the Negotiate setting is used, your SMTP server determines if
SSL will be used.

SMTP Server Authentication
No authentication required
Login/Plain
CRAM‑MD5
Digest‑MD5
NTLM
Kerberos 5

Specifies the type of user authentication required

Note: “No authentication required” is the factory default setting.

Device‑Initiated E‑mail

User‑Initiated E‑mail

Device Userid

Device Password

Kerberos 5 Realm

NTLM Domain

Specifies what credentials will be used when communicating to the SMTP
server. Some SMTP servers require credentials in order to send e-mail.

Notes:

• None is the factory default setting for Device‑Initiated E‑mail.

• Device Userid and Device Password are used to log in to the SMTP
server when "Use Device SMTP Credentials" is selected.

Security menu

Editing Security Setups menu

Menu item Description

Edit Backup Password Creates a backup password

Note: This menu item will only appear if a backup password exists.

Edit Building Blocks Edits the Internal Accounts, NTLM, various Setups, Password, and PIN

Edit Security Templates Adds or edits a Security Template

Edit Access Controls Controls access to printer menus, firmware updates, held jobs, and other access
points
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Miscellaneous menu

Menu item Description

Panel Logins
Login failures
Failure time frame
Lockout time
Panel Login Timeout
Remote Login Timeout

Limits the number and time frames of failed login attempts from the printer control
panel before all users are locked out

Notes:

• “Login failures” specifies the number of failed login attempts before users are
locked out. Settings range from 1–50. 3 attempts is the factory default setting.

• “Failure time frame” specifies the time frame during which failed login attempts
can be made before users are locked out. Settings range from 1–60 minutes. 5
minutes is the factory default setting.

• “Lockout time” specifies how long users are locked out after exceeding the login
failures limit. Settings range from 0–60 minutes. 5 minutes is the factory default
setting. 0 indicates the printer does not impose a lockout time.

• “Panel Login Timeout” specifies how long the printer remains idle on the Home
screen before automatically logging the user off. Settings range from 1–900
seconds. 3 seconds is the factory default setting.

• “Remote Login Timeout” specifies how long the printer remains idle before
automatically logging the user off the remote interface. Settings range from 1–
120 seconds. 10 seconds is the factory default setting.

Security Reset Jumper
No Effect
No Security
Reset to Defaults

Returns to default security values and templates

LDAP Certificate Verification
Demand
Try
Allow
Never

Determines how the printer accepts certificates

Minimum PIN Length
4‑16 digits

Specifies how many digits must be in the PIN number

Note: Four digits is the factory default setting.

Confidential Print menu

Menu item Description

Max Invalid PIN
Off
2–10

Limits the number of times an invalid PIN can be entered

Notes:

• Off is the default setting.

• This menu item appears only if a printer hard disk is installed.

• Once a limit is reached, the jobs for that user name and that PIN are deleted.
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Menu item Description

Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Limits the amount of time a confidential job stays in the printer before it is deleted

Notes:

• Off is the default setting.

• If the Job Expiration setting is changed while confidential jobs reside on the
printer RAM or printer hard disk, the expiration time for those print jobs does
not change to the new default value.

• If the printer is turned off, all confidential jobs held in printer RAM are
deleted.

Disk Wiping menu

Menu item Description

Wiping Mode
Off
Auto
Manual

Disk Wiping erases only print job data that is not currently in use by the file system
from the printer hard disk. All permanent data on the printer hard disk is preserved,
such as downloaded fonts, macros, and held jobs.

Notes:

• This menu item appears only if a formatted, non-defective printer hard disk is
installed.

• Off is the factory default setting.

• Due to the large amount of resources required for Automatic Wiping,
activating this option may decrease printer performance, especially if the
printer requires hard disk space faster than it can be wiped and returned to
service.

Scheduled Wiping
Time
Day(s)

Specifies times and days for disk wiping

Note: This setting does not appear when Wiping Mode is set to Off or Auto.

Manual Wiping
Start now
Do not start now

Disk Wiping erases only print job data that is not currently in use by the file system
from the printer hard disk. All permanent data on the printer hard disk is preserved,
such as downloaded fonts, macros, and held jobs.

Manual Wiping overwrites all disk space that has been used to hold data from a print
job that has been processed. This type of wipe does not erase any information related
to an unprocessed print job.

Notes:

• This setting does not appear when Wiping Mode is “Off.”

• "Do not start now" is the factory default setting.

• If the Disk Wiping access control is activated, then a user must successfully
authenticate and have the required authorization in order to initiate the disk
wipe.
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Menu item Description

Automatic Method
Single pass
Multiple pass

Disk Wiping erases only print job data that is not currently in use by the file system
from the printer hard disk. All permanent data on the printer hard disk is preserved,
such as downloaded fonts, macros, and held jobs.

Automatic Wiping marks all disk space used by a previous job and does not permit
the file system to reuse this space until it has been sanitized.

Only Automatic Wiping enables users to activate disk wiping without having to take
the printer offline for an extended amount of time.

Notes:

• This menu item appears only if a formatted, non-defective printer hard disk is
installed.

• Single pass is the factory default setting.

• Highly confidential information should be wiped using the Multiple pass
method only.

Manual Method
Single pass
Multiple pass

Disk Wiping erases only print job data that is not currently in use by the file system
from the printer hard disk. All permanent data on the printer hard disk is preserved,
such as downloaded fonts, macros, and held jobs.

Both manual and scheduled wiping allow the file system to reuse marked disk space
without first having to wipe it.

Notes:

• This menu item appears only if a formatted, non-defective printer hard disk is
installed.

• Single pass is the factory default setting.

• Highly confidential information should be wiped using the Multiple Pass
method only.

Scheduled Method
Single pass
Multiple pass

Disk Wiping erases only print job data that is not currently in use by the file system
from the printer hard disk. All permanent data on the printer hard disk is preserved,
such as downloaded fonts, macros, and held jobs.

Both manual and scheduled wiping allow the file system to reuse marked disk space
without first having to wipe it.

Notes:

• This menu item appears only if a formatted, non-defective printer hard disk is
installed.

• Single pass is the factory default setting.

• Highly confidential information should be wiped using the Multiple Pass
method only.

• Scheduled wipes are initiated without displaying a user warning or
confirmation message.
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Security Audit Log menu

Menu item Description

Export Log Enables an authorized user to export the security log

Notes:

• To export the log from the printer control panel, a flash drive must be
attached to the printer.

• From the Embedded Web Server, the log can be downloaded to a computer.

Delete Log
Delete now
Do not delete

Specifies whether audit logs are deleted

Note: Delete Now is the factory default setting.

Configure Log
Enable Audit
Enable Remote Syslog
Remote Syslog Facility
Severity of events to log

Determines whether and how the audit logs are created as well as what will be
included in the audit logs

Note: Factory default settings enable the security audit log.

Set Date and Time menu

Menu item Description

Current Date and Time Shows the current date and time settings for the printer

Manually Set Date and Time
<input date/time>

Notes:

• Date and Time is set in YYYY-MM-DD HH:MM format.

• Manually setting the date and time changes the Enable NTP setting to No.

Time Zone
<list of time zones>

Note: GMT is the factory default setting.

Automatically observe DST
On
Off

Note: On is the factory default setting and uses the applicable Daylight Saving Time
associated with the Time Zone setting.

Custom Time Zone Setup Specifies a custom time zone

Enable NTP
On
Off

Enables Network Time Protocol, which synchronizes the clocks of devices on a
network

Notes:

• On is the factory default setting.

• The setting will turn to Off if you manually set the date and time.

NTP Server Specifies the NTP Server Address

Enable Authentication
On
Off

Note: Off is the factory default setting.
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Settings menu

General Settings menu

Menu item Description

Display Language
English
Francais
Deutsch
Italiano
Espanol
Dansk
Norsk
Nederlands
Svenska
Portuguese
Suomi
Russian
Polski
Magyar
Turkce
Cesky
Simplified Chinese
Traditional Chinese
Korean

Sets the language of the text appearing on the display

Note: All languages may not be available for all printers.

Eco‑Mode
Eco‑Mode

Minimizes the use of energy, paper, or specialty media

Notes:

• Off is the factory default setting. Off resets the printer to its
factory default settings.

• The Energy setting minimizes the power used by the printer.
Performance may be affected, but print quality is not.

• Paper minimizes the amount of paper and specialty media
needed for a print job by duplexing each page. Performance
may be affected, but print quality is not.

• Energy/Paper minimizes the use of power and of paper and
specialty media.

Quiet Mode
Quiet Mode

Reduces the amount of noise produced by the printer

Notes:

• Off is the factory default setting.

• On configures the printer to produce as little noise as
possible.
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Menu item Description

Run Initial setup
Yes
No

Instructs the printer to run the setup wizard

Notes:

• Yes is the factory default setting.

• After completing the setup wizard by selecting Done at the
Country select screen, the default becomes No.
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Menu item Description

Keyboard
Keyboard Type

English
Francais
Francais Canadien
Deutsch
Italiano
Espanol
Dansk
Norsk
Nederlands
Svenska
Suomi
Portuguese
Russian
Polski
Swiss German
Swiss French
Korean
Turkce
Simplified Chinese
Traditional Chinese
Japanese

Custom Key 1
Custom Key 2
Accents/Symbols Tab

On
Off

Russian/Polish Tab
On
Off

Korean Tab
On
Off

Chinese PinyinTab
On
Off

Chinese Zhuyin Tab
On
Off

Specifies a language and custom key information for the printer
control panel keyboard. The additional tabs enable access to accent
marks and symbols from the printer control panel keyboard.

Paper Sizes
U.S.
Metric

Specifies the printer factory default measurements. The default is
determined by the country/region selection in the initial setup
wizard.
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Menu item Description

Displayed Information
Left side
Right side
Custom Text 1

<text entry>
Custom Text 2

<text entry>
Cartridge levels on status screen

On
Off

Black Toner
Paper Jam
Load Paper
Service Errors

Display
Display
Do not display

Message to Display
Default
Alternate

Default Message
<text entry>

Alternate Message
<text entry>

Specifies what is displayed on the upper left and right corners of the
home screen

For the Left side and Right side options, choose from the following
options:

IP Address
Hostname
Contact Name
Location
Date/Time
mDNS/DDNS Service Name
Zero Configuration Name
Custom Text 1
Custom Text 2
Model Name

Notes:

• IP Address is the factory default setting for Left side.

• Date/Time is the factory default setting for Right side.

• Do not display is the factory default setting for Display.

• Default is the factory default setting for Message to Display.

Home screen customization
Change Language
Search Held Jobs
Held Jobs
USB Drive
Profiles
Jobs by user

Determines which icons appear on the home screen

Additional buttons can be added to the Home screen, and default
buttons can be removed.

Available selections for each button are:
Display
Do Not Display

Date Format
MM‑DD‑YYYY
DD‑MM‑YYYY
YYYY‑MM‑DD

Formats the printer date

Time Format
12 hour A.M./P.M.
24 hour clock

Formats the printer time

Screen Brightness
20–100

Specifies the brightness of the printer control panel screen
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Menu item Description

Output Lighting
Standard Bin LED

Normal/Standby Mode
Off
Dim
Bright

Power Saver
Off
Dim
Bright

Sets the amount of light from the standard bin or an optional output
bin

Notes:

• Dim is the factory default setting if Eco‑Mode is set to Energy
or Energy/Paper.

• Bright is the factory default setting if Eco‑Mode is set to Off or
Paper.

Web Page Refresh Rate
30–300

Specifies the number of seconds between Embedded Web Server
refreshes

Note: 120 seconds is the factory default setting.

Contact Name Specifies a contact name for the printer

Location Specifies the location of the printer

Note: The location will be stored on the Embedded Web Server.

Alarms
Alarm Control
Cartridge Alarm
Staple Alarm

Sets an alarm to sound when the printer requires operator
intervention

Available selections for each alarm type are:
Off
Single
Continuous

Notes:

• Single is the factory default setting for Alarm Control. Single
sounds three quick beeps.

• Off is the factory default setting for Toner Alarm. Off means
no alarm will sound.

Timeouts
Standby Mode

Disabled
2–240

Specifies the number of minutes of inactivity before the system
enters a lower power state

Note: 15 minutes is the factory default setting.

Timeouts
Power Saver Mode

Disabled
1–240

Specifies the number of minutes of inactivity before some systems
begin entering a minimum power state.

Notes:

• 30 minutes is the factory default setting.

• Power Saver does not interact with Standby Mode.

Timeouts
Screen Timeout

15–300

Sets the amount of time in seconds the printer waits before returning
the printer display to a Ready state

Note: 30 seconds is the factory default setting.
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Menu item Description

Timeouts
Print Timeout

Disabled
1–255

Sets the amount of time in seconds the printer waits to receive an
end‑of‑job message before canceling the remainder of the print job

Notes:

• 90 seconds is the factory default setting.

• When the timer expires, any partially printed page still in the
printer is printed, and then the printer checks to see if any
new print jobs are waiting.

• Print Timeout is available only when using PCL or PPDS
emulation. This setting has no effect on PostScript emulation
print jobs.

Timeouts
Wait Timeout

Disabled
15–65535

Sets the amount of time in seconds the printer waits for additional
data before canceling a print job

Notes:

• 40 seconds is the factory default setting.

• Wait Timeout is available only when the printer is using
PostScript emulation. This setting has no effect on PCL or
PPDS emulation print jobs.

Timeouts
Job Hold Timeout

Disabled
5–255

Sets the amount of time the printer waits for user intervention
before it holds jobs that require unavailable resources and continues
to print other jobs in the print queue

Notes:

• 30 seconds is the factory default setting.

• This menu item appears only when a printer hard disk is
installed.

Print Recovery
Auto Continue

Disabled
5–255

Lets the printer automatically continue printing from certain offline
situations when not resolved within the specified time period

Notes:

• Disabled is the factory default setting.

• 5–255 is a range of time in seconds.

Print Recovery
Jam Recovery

On
Off
Auto

Specifies whether the printer reprints jammed pages

Notes:

• Auto is the factory default setting. The printer reprints
jammed pages unless the memory required to hold the pages
is needed for other printer tasks.

• On sets the printer to always reprint jammed pages.

• Off sets the printer to never reprint jammed pages.
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Menu item Description

Print Recovery
Page Protect

On
Off

Lets the printer successfully print a page that may not have printed
otherwise

Notes:

• Off is the factory default setting. Off prints a partial page
when there is not enough memory to print the whole page.

• On sets the printer to process the whole page so that the
entire page prints.

Factory Defaults
Do Not Restore
Restore Now

Returns the printer settings to the factory default settings

Notes:

• Do Not Restore is the factory default setting. Do Not Restore
keeps the user‑defined settings.

• Restore returns all printer settings to the factory default
settings except Network/Ports menu settings. All downloads
stored in RAM are deleted. Downloads stored in flash memory
or on a printer hard disk are not affected.

Flash Drive menu

Menu item Description

Copies
1–999

Specifies a default number of copies for each print job

Note: 1 is the factory default setting.

Paper Source
Tray <x>
Manual Feeder

Sets a default paper source for all print jobs

Note: Tray 1 (standard tray) is the factory default setting.

Collate
Off (1,1,1,2,2,2)
On (1,2,1,2,1,2)

Stacks the pages of a print job in sequence when printing multiple copies

Note: On is the factory default setting.

Sides (Duplex)
1 sided
2 sided

Controls whether the job prints on one side or both sides of the paper

Note: 1 sided is the factory default setting.

Staple
Off
On

Specifies whether print jobs are stapled

Notes:

• This menu item is available only when the StapleSmart II Finisher is installed.

• Off is the factory default setting. Print jobs are not stapled.
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Menu item Description

Duplex Binding
Long Edge
Short Edge

Defines the way duplexed pages are bound and how the printing on the back of the
page is oriented in relation to the printing on the front of the page

Notes:

• Long Edge is the factory default setting.

• Long Edge specifies that binding be placed on the left edge of portrait pages
and the top edge of landscape pages.

• Short Edge specifies that binding be placed on the top edge of portrait pages
and the left edge of landscape pages.

Orientation
Auto
Long Edge
Short Edge

Specifies the orientation of a multiple‑page sheet

Notes:

• Auto is the factory default setting. The printer chooses between portrait and
landscape.

• Long Edge uses landscape.

• Short Edge uses portrait.

N‑up (pages per side)
Off
2‑Up
3‑Up
4‑Up
6‑Up
9‑Up
12‑Up
16‑Up

Specifies that multiple‑page images be printed on one side of a sheet of paper

Notes:

• Off is the factory default setting.

• The number selected is the number of page images that will print per side.

N‑up Border
None
Solid

Prints a border around each page image when using N‑up (pages‑side)

Note: None is the factory default setting.

N‑up Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specifies the positioning of multiple‑page images when using N‑up (pages‑side)

Notes:

• Horizontal is the factory default setting.

• Positioning depends on the number of images and whether the images are in
portrait or landscape orientation.
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Menu item Description

Separator Sheets
None
Between Copies
Between Jobs
Between Pages

Specifies whether blank separator sheets are inserted

Notes:

• None is the factory default setting.

• Between Copies inserts a blank sheet between each copy of a print job if
Collation is set to On. If Collation is set to Off, then a blank page is inserted
between each set of printed pages, such as after all page 1's and after all page
2's.

• Between Jobs inserts a blank sheet between print jobs.

• Between Pages inserts a blank sheet between each page of the print job. This
setting is useful when printing transparencies or inserting blank pages in a
document for notes.

Separator Source
Tray <x>
Manual Feeder

Specifies the paper source for separator sheets

Notes:

• Tray 1 (standard tray) is the factory default setting.

• From the Paper menu, Configure MP must be set to Cassette in order for
Manual Feeder to appear as a menu setting.

Blank Pages
Do Not Print
Print

Specifies whether blank pages are inserted in a print job

Note: Do Not Print is the factory default setting.

Setup menu

Menu item Description

Printer Language
PCL Emulation
PS Emulation

Sets the default printer language

Notes:

• PCL emulation uses a PCL interpreter for processing print
jobs. PostScript emulation uses a PS interpreter for
processing print jobs.

• PCL is the factory default printer language.

• Setting a printer language as the default does not prevent a
software program from sending print jobs that use another
printer language.

Job Waiting
On
Off

Specifies that print jobs be removed from the print queue if they
require unavailable printer options or custom settings. They are
stored in a separate print queue, so other jobs print normally. When
the missing information and/or options are obtained, the stored
jobs print.

Notes:

• Off is the factory default setting.

• This menu appears only if a non-Read Only printer hard disk
is installed. This requirement ensures that stored jobs are
not deleted if the printer loses power.
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Menu item Description

Print Area
Normal
Whole Page

Sets the logical and physical printable area

Notes:

• This menu does not appear if Edge to Edge is enabled in the
printer Setup menu.

• Normal is the factory default setting. When attempting to
print data in the non‑printable area defined by the Normal
setting, the printer clips the image at the boundary.

• The Whole Page setting allows the image to be moved into
the non‑printable area defined by the Normal setting, but
the printer will clip the image at the Normal setting
boundary.

• The Whole Page setting only affects pages printed using a
PCL 5e interpreter. This setting has no effect on pages
printed using the PCL XL or PostScript interpreter.

Download Target
RAM
Flash
Disk

Sets the storage location for downloads

Notes:

• RAM is the factory default setting.

• Storing downloads in flash memory or on a printer hard disk
places them in permanent storage. Downloads remain in
flash memory or on the printer hard disk even when the
printer is turned off.

• Storing downloads in RAM is temporary.

• This menu appears only if a flash and/or disk option is
installed.

Job Accounting
On
Off

Specifies whether the printer stores statistical information about
the most recent print jobs on the hard disk

Notes:

• Off is the factory default setting. Off means the printer does
not store job statistics.

• The statistics include a record of print errors, the print time,
the job size in bytes, the requested paper size and type, the
total number of printed pages, and the total number of
copies requested.

• Job Accounting is available only when a printer hard disk is
installed and working properly. It should not be Read/Write
or Write protected. Job Buffer Size should not be set to
100%.

• Changing this setting from the printer control panel and then
exiting the menus causes the printer to reset. The menu
selection is updated.
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Menu item Description

Resource Save
On
Off

Specifies how the printer handles temporary downloads, such as
fonts and macros stored in RAM, when the printer receives a job
that requires more memory than is available

Notes:

• Off is the factory default setting. Off sets the printer to retain
the downloads only until memory is needed. Downloads are
deleted in order to process print jobs.

• The On setting retains the downloads during language
changes and printer resets. If the printer runs out of
memory, 38 Memory Full appears, and downloads are
not deleted.

Print All Order
Alphabetically
Newest First
Oldest First

Specifies the order in which held and confidential jobs are printed
when Print All is selected

Notes:

• Alphabetically is the factory default setting.

• Print jobs always appear in alphabetical order on the printer
control panel.

Finishing menu

Menu item Description

Sides (Duplex)
2 sided
1 sided

Specifies whether duplex (2‑sided) printing is set as the default for all print jobs

Notes:

• 1 sided is the factory default setting.

• To set 2‑sided printing from the software program: for Windows users, click
File > Print, and then click Properties, Preferences, Options, or Setup; for
Macintosh users, choose File > Print, and then adjust the settings from the
Print dialog and pop‑up menus.

Duplex Binding
Long Edge
Short Edge

Defines the way duplexed pages are bound and how the printing on the back of the
page is oriented in relation to the printing on the front of the page

Notes:

• Long Edge is the factory default setting.

• Long Edge specifies that binding be placed on the left edge of portrait pages
and the top edge of landscape pages.

• Short Edge specifies that binding be placed on the top edge of portrait pages
and the left edge of landscape pages.

Copies
1–999

Specifies a default number of copies for each print job

Note: 1 is the factory default setting.

Blank Pages
Do Not Print
Print

Specifies whether blank pages are inserted in a print job

Note: Do Not Print is the factory default setting.
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Menu item Description

Collate
Off (1,1,1,2,2,2)
On (1,2,1,2,1,2)

Stacks the pages of a print job in sequence when printing multiple copies

Notes:

• Off is the factory default setting. No pages will be collated.

• The On setting stacks the print job sequentially.

• Both settings print the entire job the number of times specified by the Copies
menu setting.

Separator Sheets
None
Between Copies
Between Jobs
Between Pages

Specifies whether blank separator sheets are inserted

Notes:

• None is the factory default setting.

• Between Copies inserts a blank sheet between each copy of a print job if
Collation is set to On. If Collation is set to Off, a blank page is inserted between
each set of printed pages, such as after all page 1's and after all page 2's.

• Between Jobs inserts a blank sheet between print jobs.

• Between Pages inserts a blank sheet between each page of the print job. This
setting is useful when printing transparencies or inserting blank pages in a
document for notes.

Separator Source
Tray <x>
Multi‑Purpose Feeder

Specifies the paper source for separator sheets

Notes:

• Tray 1 (standard tray) is the factory default setting.

• From the Paper menu, Configure MP must be set to Cassette in order for
Multi‑Purpose Feeder to appear as a menu setting.

N‑up (pages per side)
Off
2‑Up
3‑Up
4‑Up
6‑Up
9‑Up
12‑Up
16‑Up

Specifies that multiple‑page images be printed on one side of a sheet of paper

Notes:

• Off is the factory default setting.

• The number selected is the number of page images that will print per side.

N‑up Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specifies the positioning of multiple‑page images when using N‑up (pages‑sides)

Notes:

• Horizontal is the factory default setting.

• Positioning depends on the number of images and whether the images are in
portrait or landscape orientation.

Orientation
Auto
Landscape
Portrait

Specifies the orientation of a multiple‑page sheet

Note: Auto is the factory default setting. The printer chooses between portrait and
landscape.
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Menu item Description

N‑up Border
None
Solid

Prints a border around each page image when using N‑up (pages‑sides)

Note: None is the factory default setting.

Staple Job
Off
On

Specifies whether print jobs are stapled

Notes:

• This menu item is available only when the StapleSmart Finisher is installed.

• Off is the factory default setting. Print jobs are not stapled.

• Envelopes are not stapled.

Offset Pages
Off
Between Jobs
Between Copies

Stacks copies or print jobs into staggered sets in an output bin

Notes:

• This menu item appears only when the StapleSmart Finisher is installed.

• Off is the factory default setting. No pages are offset during the print job.

• Between Jobs offsets each print job.

• Between Copies offsets each copy of a print job.

Quality menu

Menu item Description

Print Resolution
300 dpi
600 dpi
1200 dpi
1200 Image Q
2400 Image Q

Specifies the printed output resolution

Note: 600 dpi is the factory default setting. The printer driver default is 1200 IQ.

Pixel Boost
Off
Fonts
Horizontally
Vertically
Both Directions
Isolated

Enhances the printed quality of small fonts and graphics

Notes:

• Off is the factory default setting.

• Fonts applies this setting only to text.

• Horizontally darkens horizontal lines of text and images.

• Vertically darkens vertical lines of text and images.

• Both Directions darkens horizontal and vertical lines on text and images.

• Isolated darkens discrete places on text and images.

Toner Darkness
1–10

Lightens or darkens the printed output

Notes:

• 8 is the factory default setting.

• Selecting a smaller number can help conserve toner.
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Menu item Description

Enhance Fine Lines
On
Off

Enables a print mode preferable for files such as architectural drawings, maps, electrical
circuit diagrams, and flow charts

Notes:

• Off is the factory default setting.

• To set Enhance Fine Lines using the Embedded Web Server, type the network
printer IP address in a browser window.

Gray Correction
Auto
Off

Adjusts the gray value of printed output

Note: Auto is the factory default setting.

Brightness
‑6 to +6

Adjusts or darkens printed output and conserves toner

Notes:

• 0 is the factory default setting.

• A negative value darkens text, images, and graphics. A positive value lightens
them and conserves toner.

Contrast
0–5

Adjusts the degree of difference between levels of gray in printed output

Notes:

• 0 is the factory default setting.

• Higher settings show more difference between levels of gray.

Utilities menu

Menu item Description

Remove Held Jobs
Confidential
Held
Not Restored
All

Removes confidential and held jobs from the printer hard disk

Notes:

• Selecting a setting affects only print jobs that are resident in the printer.
Bookmarks, jobs on flash drives, and other types of held jobs are not affected.

• Selecting Not Restored removes all Print and Hold jobs that were not restored
from the disk.

Format Flash
Yes
No

Formats the flash memory. Flash memory refers to the memory added by installing
a flash memory option card in the printer.

Warning—Potential Damage: Do not turn off the printer while the flash memory is
formatting.

Notes:

• A flash memory option card must be installed in the printer and operating
properly for this menu item to be available. The flash memory option card
must not be Read/Write or Write protected.

• Selecting Yes deletes all data stored in flash memory.

• No cancels the format request.

Understanding printer menus 137



Menu item Description

Delete Downloads on Disk
Delete Now
Do Not Delete

Removes downloads from the printer hard disk, including all held Jobs, buffered jobs,
and parked jobs. Job accounting information is not affected.

Note: Delete Now is the factory default setting.

Job Acct Stat
Print
Clear

Prints a list of all stored job statistics or deletes the information from the printer hard
disk

Notes:

• A printer hard disk must be installed in the printer and operating properly for
this menu item to be available.

• Selecting Print prints a list of statistics.

• Clear deletes all job statistics stored on the printer hard disk.

• The Clear selection will not appear if Job Accounting is set to MarkTrackTM

using NPA.

Activate Hex Trace Assists in isolating the source of a print job problem

Note: To exit or deactivate Hex Trace, turn the printer off or reset the printer.

Coverage Estimator
Off
On

Provides an estimate of the percentage coverage of black on a page. The estimate is
printed on a separate page at the end of each print job.

Note: Off is the factory default setting.

XPS menu

Menu item Description

Print Error Pages
Off
On

Prints a page containing information on errors, including XML markup errors

Note: Off is the factory default setting.

PDF menu

Menu item Description

Scale to Fit
Yes
No

Scales page content to fit the selected paper size

Note: No is the factory default setting.

Annotations
Do Not Print
Print

Prints annotations in a PDF

Note: Do Not Print is the factory default setting.
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PostScript menu

Menu item Description

Print PS Error
On
Off

Prints a page containing the PostScript error

Note: Off is the factory default setting.

Font Priority
Resident
Flash/Disk

Establishes the font search order

Notes:

• Resident is the factory default setting.

• A formatted flash memory option card or printer hard disk must be
installed in the printer and operating properly for this menu item to be
available.

• The flash memory option or printer hard disk cannot be Read/Write,
Write, or password protected.

• Job Buffer Size must not be set to 100%.

PCL Emul menu

Menu item Description

Font Source
Resident
Disk
Download
Flash
All

Specifies the set of fonts used by the Font Name menu item

Notes:

• Resident is the factory default setting. It shows the factory default set of
fonts downloaded into printer RAM.

• Flash and Disk settings appear only if applicable and show all fonts
resident in that option.

• Flash and Disk options must be properly formatted and cannot be
Read/Write, Write, or password protected.

• Download appears only if applicable and shows all the fonts downloaded
into printer RAM.

• All shows all fonts available to any option.

Font Name
<list of available fonts>

Identifies a specific font and the option where it is stored

Notes:

• Courier 10 is the factory default setting.

• The font source abbreviation is R for Resident, F for Flash, K for Disk, and
D for download.
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Menu item Description

Symbol Set
10U PC‑8
12U PC‑850

Specifies the symbol set for each font name

Notes:

• 10U PC‑8 is the US factory default setting.

• 12U PC‑850 is the international factory default setting.

• A symbol set is a set of alphabetic and numeric characters, punctuation,
and special symbols. Symbol sets support the different languages or
specific programs such as math symbols for scientific text. Only the
supported symbol sets are shown.

PCL Emulation Settings
Point Size

1.00–1008.00

Changes the point size for scalable typographic fonts

Notes:

• 12 is the factory default setting.

• Point Size refers to the height of the characters in the font. One point
equals approximately 1/72 of an inch.

• Point sizes can be increased or decreased in 0.25‑point increments.

PCL Emulation Settings
Pitch

0.08–100

Specifies the font pitch for scalable monospaced fonts

Notes:

• 10 is the factory default setting.

• Pitch refers to the number of fixed‑space characters per inch (cpi).

• Pitch can be increased or decreased in 0.01‑cpi increments.

• For nonscalable monospaced fonts, the pitch appears on the display but
cannot be changed.

PCL Emulation Settings
Orientation

Portrait
Landscape

Specifies the orientation of text and graphics on the page

Notes:

• Portrait is the factory default setting.

• Portrait prints text and graphics parallel to the short edge of the page.

• Landscape prints text and graphics parallel to the long edge of the page.

PCL Emulation Settings
Lines per Page

1–255

Specifies the number of lines that print on each page

Notes:

• 60 is the US factory default setting. 64 is the international default setting.

• The printer sets the amount of space between each line based on the
Lines per Page, Paper Size, and Orientation settings. Select the desired
Paper Size and Orientation before setting Lines per Page.

PCL Emulation Settings
A4 Width

198 mm
203 mm

Sets the printer to print on A4‑size paper

Notes:

• 198 mm is the factory default setting.

• The 203‑mm setting sets the width of the page to allow the printing of
eighty 10‑pitch characters.
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Menu item Description

PCL Emulation Settings
Auto CR after LF

On
Off

Specifies whether the printer automatically performs a carriage return after a
line feed control command

Note: Off is the factory default setting.

PCL Emulation Settings
Auto LF after CR

On
Off

Specifies whether the printer automatically performs a line feed after a carriage
return control command

Note: Off is the factory default setting.

Tray Renumber
Assign MP Feeder

Off
None
0–199

Assign Tray <x>
Off
None
0–199

Assign Manual Paper
Off
None
0–199

Assign Manual Env
Off
None
0–199

Configures the printer to work with printer software or programs that use
different source assignments for trays, drawers, and feeders

Notes:

• Off is the factory default setting.

• None is not an available selection. It is only displayed when it is selected
by the PCL 5 interpreter.

• None ignores the Select Paper Feed command.

• 0–199 allows a custom setting to be assigned.

Tray Renumber
View Factory Default

MPF Default = 8
T1 Default = 1
T2 Default = 4
T3 Default = 5
T4 Default = 20
T5 Default = 21
Env Default = 6
MPaper Default = 2
MEnv Default = 3

Shows the factory default setting assigned to each tray, drawer, or feeder, even
if it has not been installed

Tray Renumber
Restore Defaults

Yes
No

Returns all tray, drawer, and feeder assignments to the factory default settings
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HTML menu

Menu item Description

Font Name
Albertus MT
Antique Olive
Apple Chancery
Arial MT
Avant Garde
Bodoni
Bookman
Chicago
Clarendon
Cooper Black
Copperplate
Coronet
Courier
Eurostile
Garamond
Geneva
Gill Sans
Goudy
Helvetica
Hoefler Text

Intl CG Times
Intl Courier
Intl Univers
Joanna MT
Letter Gothic
Lubalin Gothic
Marigold
MonaLisa Recut
Monaco
New CenturySbk
New York
Optima
Oxford
Palatino
StempelGaramond
Taffy
Times
TimesNewRoman
Univers
Zapf Chancery

Sets the default font for HTML documents

Notes:

• The Times font will be used in HTML documents that do not specify a
font.

• The following fonts appear only if the appropriate DBCS font card is
installed: HG-GothicB, MSung-Light, MD_DotumChe, and MingMT-
Light.

Menu item Description

Font Size
1–255 pt

Sets the default font size for HTML documents

Notes:

• 12 pt is the factory default setting.

• Font size can be increased in 1‑point increments.

Scale
1–400%

Scales the default font for HTML documents

Notes:

• 100% is the factory default setting.

• Scaling can be increased in 1% increments.

Orientation
Portrait
Landscape

Sets the page orientation for HTML documents

Note: Portrait is the factory default setting.

Margin Size
8–255 mm

Sets the page margin for HTML documents

Notes:

• 19 mm is the factory default setting.

• Margin size can be increased in 1‑mm increments.
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Menu item Description

Backgrounds
Do Not Print
Print

Specifies whether to print backgrounds on HTML documents

Note: Print is the factory default setting.

Image menu

Menu item Description

Auto Fit
On
Off

Selects the optimal paper size, scaling, and orientation

Notes:

• On is the factory default setting.

• The On setting overrides scaling and orientation settings for some images.

Invert
On
Off

Inverts bi‑tonal monochrome images

Notes:

• Off is the factory default setting.

• The font size can be increased in 1‑point increments.

• This setting does not apply to GIF or JPEG images.

Scaling
Anchor Top Left
Best Fit
Anchor Center
Fit Height/Width
Fit Height
Fit Width

Scales the image to fit the selected paper size

Notes:

• Best Fit is the factory default setting.

• When Auto Fit is set to On, Scaling is automatically set to Best Fit.

Orientation
Portrait
Landscape
Rev Portrait
Rev Landscape

Sets the image orientation

Note: Portrait is the factory default setting.

Help menu
The Help menu consists of Help pages that are stored in the printer as PDFs. They contain information about using the
printer and performing printing tasks.

English, French, German, and Spanish translations are stored in the printer. Other translations are available on the
Software and Documentation CD.

Menu item Description

Print Defects Provides information about resolving print defects

Understanding printer menus 143



Understanding printer messages

List of status and error messages

Activating Menu Changes
Wait for the message to clear.

Busy
Wait for the message to clear.

Cancel not available
Wait for the message to clear.

Canceling
Wait for the message to clear.

Change <src> to <x>
<src> is a tray or feeder, and <x> is a paper size or type.

You can change the current paper source for the remainder of the print job. The formatted page will print on the paper
loaded in the selected tray. This may cause clipping of text or images. Try one or more of the following:

• Select the paper tray with the correct paper size or type.

• Touch Use current [src] to ignore the message and print from the tray selected for the print job.

• Touch Continue to continue the job if the correct size and type are loaded in the tray, and this size and type are
specified in the printer control panel Paper menu.

Note: If you touch Continue when there is no paper in the tray, the job is not continued.

• Touch Cancel job to cancel the current job.

Check tray <x> connection
Try one or more of the following:

• Turn the printer off and then back on.

If the error occurs a second time:

1 Turn the printer off.

2 Unplug the power cord from the wall outlet.

3 Remove the tray.

4 Reattach the tray.
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5 Connect the power cord to a properly grounded outlet.

6 Restart the printer.

If the error occurs again:

1 Turn the printer off.

2 Unplug the power cord from the wall outlet.

3 Remove the tray.

4 Contact Customer Support.

• Touch Continue to clear the message and print without using the tray.

Clearing job accounting statistics
Wait for the message to clear.

Close door or insert cartridge
The cartridge is missing or not installed correctly. Insert the cartridge and close all doors and covers.

Close finisher side door
Close the finisher side door to clear the message.

Defragmenting Flash DO NOT POWER OFF
Wait for the message to clear.

Warning—Potential Damage: Do not turn the printer off while this message appears on the display.

Deleting
Wait for the message to clear.

Deleting held jobs
Wait for the message to clear.

Deletion complete
Wait for the message to clear.

Deletion failed
Your attempt to delete a file failed.

1 Wait for the message to clear.

2 Try to delete the file again.
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Disabling DLEs
Wait for the message to clear.

Disabling Menus
Wait for the message to clear.

Note: While the menus are disabled, printer settings cannot be changed from the printer control panel.

Disk corrupted
The printer attempted a hard disk recovery on a corrupted hard disk, and the hard disk cannot be repaired. The hard
disk must be reformatted.

Touch Reformat disk to reformat the hard disk and clear the message.

Note: Reformatting the disk deletes all the files currently stored on the disk.

Disk recovery x/y XX% DO NOT POWER OFF
Wait for the message to clear.

Warning—Potential Damage: Do not power off while the printer is attempting to recover the printer hard disk.

Disk recovery takes place in several phases. The percentage completed during each phase appears on the display.

Enabling Menus
Wait for the message to clear.

Encrypting disk x/y XX% DO NOT POWER OFF
Wait for the message to clear.

Warning—Potential Damage: Do not power off while the printer is encrypting the printer hard disk.

The percentage completed appears on the display.

Enter PIN
Enter the PIN you created in Print Properties when the confidential job was sent for printing.

Error reading USB drive
Remove the device and wait for the message to clear. The USB drive may be corrupted.

Flushing buffer
Wait for the message to clear.
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Formatting Disk x/y XX% DO NOT POWER OFF
Wait for the message to clear.

Warning—Potential Damage: Do not power off while the printer is formatting the printer hard disk.

The percentage completed appears on the display.

Formatting Flash DO NOT POWER OFF
Wait for the message to clear.

Warning—Potential Damage: Do not power off while the printer is formatting the flash memory.

Hex Trace Ready
The printer is in the Ready state, and Hex Trace is active. You can use Hex Trace to troubleshoot printer problems.

Insert staple cartridge
Try one or more of the following:

• Insert a staple cartridge to clear the message.

• Touch Continue to clear the message and print without using the staple feature.

Insert Tray <x>
Insert the specified tray into the printer.

Install bin <x>
Try one or more of the following:

• Install the specified bin:

1 Turn the printer off.

2 Unplug the power cord from the wall outlet.

3 Install the specified bin.

4 Connect the power cord to a properly grounded outlet.

5 Restart the printer.

• Cancel the current job.

Install Tray <x>
Try one or more of the following:

• Install the specified tray:

1 Turn the printer off.

2 Unplug the power cord from the wall outlet.

3 Install the specified tray.
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4 Connect the power cord to a properly grounded outlet.

5 Restart the printer.

• Cancel the current job.

Install MICR Cartridge
The printer does not have a MICR cartridge installed. Install a MICR cartridge to continue printing.

Invalid Engine Code
You need to download valid engine code for the printer.

For more information, visit the Lexmark Web site at www.lexmark.com, or contact customer support.

Note: Engine code may be downloaded while this message appears on the display.

Invalid Network Code
You need to download valid network printing code for the internal print server. The internal print server is a hardware
option installed inside the printer.

Note: Network code may be downloaded while this message appears on the display.

Invalid PIN
Enter a valid PIN.

Load manual feeder with <x>
<x> is a paper type or size.

Try one or more of the following:

• Load the specified paper in the multipurpose feeder.

• Touch Continue to clear the message and continue printing.

If the printer finds a tray that has the correct paper type and size, then it feeds from that tray. If the printer cannot
find a tray with the correct paper type and size, then it prints from the default source.

• Cancel the current job.

Load <src> with <x>
<src> is a tray or feeder, and <x> is a paper type or size.

Try one or more of the following:

• Load the paper tray or other source with the correct paper type and size.

• Cancel the current job.
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Load staples
Try one or more of the following:

• Replace the specified staple cartridge in the finisher.

• Touch Continue to clear the message and continue printing.

• Touch Cancel job to cancel the print job.

Maintenance
Replace the maintenance items and, if necessary, reset the printer maintenance counter.

For information on purchasing supplies, see “Ordering supplies” on page 163.

Menu access turned off by system administrator
The printer menus cannot be accessed because your system support person disabled the menus. Wait for the message
to clear.

Menus are Disabled
The printer menus are disabled. The printer settings cannot be changed from the printer control panel. Contact your
system support person for help.

Note: When menus are disabled, it is still possible to cancel a print job, print a confidential job, or print a held job.

Network/Network <x>/Network <x>, <y>
The printer is connected to the network, so the network interface is the active communication link.

• Network indicates that the printer is using the standard network port built into the printer system board.

• Network <x> indicates that an internal print server is installed inside the printer or that the printer is connected
to an external print server.

• Network <x>, <y> indicates a network interface is the active communication link, where <x>, <y> indicates
the active interface is connected to the printer through channel y on PCI connector x. If x equals 0, then the standard
network interface is active.

Note: The current interface displays on the menus settings page.

Wait for the message to clear.

No held jobs
Wait for the message to clear.

No jobs to cancel
Wait for the message to clear.
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Not Ready
The printer is not ready to receive or process data, or the printer ports are offline.

No recognized file types
Either there are no files saved on the flash drive, or the files saved are not supported. Convert files to any of the following
supported file types: .pdf, .gif, .jpeg, .jpg, .bmp, .png, .tiff, .tif, .pcx, or .dcx.

Overflow bin full
Remove the stack of paper from the bin to clear the message.

Parallel/Parallel <x>
The printer is using a parallel cable connection. The parallel port is the active communication link.

[PJL RDYMSG]
This is the Printer Job Language (PJL) Ready message. It appears after the Ready or Power Saver message. If the
message string is too long, it is truncated.

Wait for the message to clear.

Printing
Wait for the message to clear.

Printing from USB drive DO NOT REMOVE
Warning—Potential Damage: Do not turn the printer off or remove the flash drive while this message is displayed.

Wait for the message to clear.

Programming disk DO NOT POWER OFF
Wait for the message to clear.

Warning—Potential Damage: Do not turn the printer power off while Programming disk appears on the
display.

Programming flash DO NOT POWER OFF
Wait for the message to clear.

Warning—Potential Damage: Do not turn the printer power off while Programming flash appears on the
display.
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Reading USB drive DO NOT REMOVE
Wait for the message to clear.

Ready
The printer is ready to receive print jobs.

Reattach bin <x>
Try one or more of the following:

• Turn the printer off and then back on.

If the error occurs a second time:

1 Turn the printer off.

2 Unplug the power cord from the wall outlet.

3 Remove the specified bin.

4 Reattach the bin.

5 Connect the power cord to a properly grounded outlet.

6 Restart the printer.

If the error occurs again:

1 Turn the printer off.

2 Unplug the power cord from the wall outlet.

3 Remove the specified bin.

4 Contact Customer Support.

• Touch Continue to clear the message and print without using the specified bin.

Reattach bin <x> – <y>
Try one or more of the following:

• Turn the printer off and then back on.

If the error occurs a second time:

1 Turn the printer off.

2 Unplug the power cord from the wall outlet.

3 Remove the specified bins.

4 Reattach the bins.

5 Connect the power cord to a properly grounded outlet.

6 Restart the printer.

If the error occurs again:

1 Turn the printer off.

2 Unplug the power cord from the wall outlet.
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3 Remove the specified bins.

4 Contact Customer Support.

• Touch Continue to clear the message and print without using the specified bins.

Remote Management Active DO NOT POWER OFF
The printer settings are being configured. Wait for the message to clear.

Warning—Potential Damage: Do not turn the printer power off while Remote Management Active appears
on the display.

Remove packaging material, check <x>
Remove any remaining packaging material from the specified location.

Remove paper from all bins
Remove the paper from all of the bins. The printer automatically senses paper removal and resumes printing.

If removing the paper does not clear the message, then touch Continue.

Remove paper from bin <x>
Remove the paper from the specified bin. The printer automatically senses paper removal and resumes printing.

If removing the paper does not clear the message, then touch Continue.

Remove paper from standard output bin
Remove the stack of paper from the standard exit bin.

Remove paper from <linked bin set name>
Remove the paper from the specified bin. The printer automatically senses paper removal and resumes printing.

If removing the paper does not clear the message, then touch Continue.

Replace wiper
Replace the fuser wiper, or try one or more of the following:

• Touch Continue to clear the message and continue printing.

• Touch Ignore to clear the message, but at the next power-on, the message appears again.

Resetting active bin
Wait for the message to clear.
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Resetting the printer
Wait for the message to clear.

Restoring Factory Defaults
Wait for the message to clear.

When factory default settings are restored:

• All downloaded resources in the printer memory are deleted. This includes fonts, macros, and symbol sets.

• All settings return to the factory defaults except the Display Language setting in the Setup menu and the custom
settings in the Serial <x>, Network, Infrared, LocalTalk, and USB menus.

Restore Held Jobs?
Try one or more of the following:

• Touch Continue to restore all held jobs stored on the printer hard disk.

• Touch Do not restore if you do not want any print jobs to be restored.

Routine maintenance needed
The printer needs to have routine maintenance done. Order a maintenance kit, which contains all the items necessary
to replace the pick rollers, the charge roll, the transfer roller, and the fuser.

Securely clearing disk space
The printer hard disk wiping process needs to recover. The message clears when all blocks are cleared.

Serial <x>
The printer is using a serial cable connection. The serial port is the active communication link.

Some held jobs were not restored
Touch Continue to delete the specified job.

Note: Some held jobs are not restored. They stay on the hard disk and are inaccessible.

Staples <x> empty or misfed
Load the specified staple cartridge into the finisher to clear the message and continue stapling.

Staples <x> low or missing
Load the specified staple cartridge in the finisher to clear the message.
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Standard Bin Full
Remove the stack of paper from the standard exit bin to clear the message.

Submitting selection
Wait for the message to clear.

Too many failed panel logins
The printer is now in a lockout mode because:

• You attempted to log in too many times with an incorrect PIN

• You attempted to log in using an incorrect password number for access to a printer feature, setting, or menu that
you do not have access to.

Note: There is a defined limit on the number of login attempts. Once the limit is reached, this message appears and
the printer enters a lockout mode. The message remains on the printer control panel, and any further attempts to
enter menus is denied until the defined time out expires. The time out duration is set by your system support
person.

Wait for the message to clear once the time out expires, and then:

• Enter the correct PIN to access any held jobs

• See your system support person if you need a password number to enter a specific printer feature, setting, or menu
that is blocked from your use without the number.

Tray <x> Empty
Load paper in the tray to clear the message.

Tray <x> Low
Load paper in the specified tray to clear the message.

Tray <x> Missing
Insert the specified tray into the printer.

Unsupported disk
An unsupported printer hard disk has been installed. Remove the unsupported device, and then install a supported
one.

Unsupported USB device, please remove
Remove the unrecognized USB device.
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Unsupported USB hub, please remove
Remove the unrecognized USB hub.

USB/USB <x>
The printer is using a USB cable connection. The USB port is the active communication link.

USB drive removed
Try one or more of the following:

• Wait for the message to clear.

• Insert the flash drive.

View supplies
This message shows the current level of supplies.

30 Invalid refill, change cartridge
Remove the print cartridge, and then install a supported one.

31 Replace defective cartridge
Remove the defective print cartridge, and then install a new one.

32 Cartridge part number unsupported by device
Remove the print cartridge, and then install a supported one.

34 Short paper
Try one or more of the following:

• Load the appropriate paper or other specialty media in the proper tray.

• Touch Continue to clear the message and print the job using a different paper tray.

• Check tray length and width guides and make sure the paper is properly loaded in the tray.

• Check the Print Properties or Print dialog settings to make sure the print job is requesting the correct paper size
and type.

• Check that the paper size is correctly set. For example, if the MP Feeder Size is set to Universal, make sure the paper
is large enough for the data being printed.

• Cancel the current print job.
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37 Insufficient memory for Flash Memory Defragment operation
Try one or more of the following:

• Touch Continue to stop the defragment operation and continue printing.

• Delete fonts, macros, and other data in printer memory.

• Install additional printer memory.

35 Insufficient memory to support Resource Save feature
Try one or more of the following:

• Touch Continue to disable Resource Save and continue printing.

• To enable Resource Save after receiving this message, make sure the link buffers are set to Auto, and then exit the
menus to activate the link buffer changes. When Ready appears, enable Resource Save.

• Install additional memory.

37 Insufficient memory to collate job
Try one or more of the following:

• Touch Continue to print the portion of the job already stored and begin collating the rest of the print job.

• Cancel the current print job.

37 Insufficient memory, some Held Jobs were deleted
The printer deleted some held jobs in order to process current jobs.

Touch Continue to clear the message.

37 Insufficient memory, some held jobs will not be restored
The printer was unable to restore some or all of the confidential or held jobs on the printer hard disk.

Touch Continue to clear the message.

38 Memory full
Try one or more of the following:

• Touch Continue to clear the message.

• Cancel the current print job.

• Install additional printer memory.

39 Complex page, some data may not have printed
Try one or more of the following:

• Touch Continue to clear the message and continue printing.

• Cancel the current print job.
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• Install additional printer memory.

42.xy Cartridge region mismatch
Install a print cartridge that matches the region number of the printer. x indicates the value of the printer region. y
indicates the value of the cartridge region. x and y can have the following values:

1 US

2 Europe, the Middle East, and Africa

3 Asia

4 Latin America

9 Invalid region

50 PPDS font error
Try one or more of the following:

• Touch Continue to clear the message and continue printing.

• The printer cannot find a requested font. From the PPDS menu, select Best Fit, and then select On. The printer will
find a similar font and reformat the affected text.

• Cancel the current print job.

51 Defective flash detected
Try one or more of the following:

• Touch Continue to clear the message and continue printing.

• Cancel the current print job.

52 Not enough free space in flash memory for resources
Try one or more of the following:

• Touch Continue to clear the message and continue printing.

Downloaded fonts and macros not previously stored in flash memory are deleted.

• Delete fonts, macros, and other data stored in flash memory.

• Upgrade to a larger capacity flash memory card.

53 Unformatted flash detected
Try one or more of the following:

• Touch Continue to stop the defragment operation and continue printing.

• Format the flash memory. If the error message remains, the flash memory may be defective and require replacing.
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54 Network <x> software error
<x> is the number of the network connection.

Try one or more of the following:

• Touch Continue to continue printing.

• Turn the printer off and then back on to reset the printer.

• Upgrade (flash) the network firmware in the printer or print server.

54 Serial option <x> error
<x> is the number of the serial option.

Try one or more of the following:

• Check that the serial cable is connected correctly and is the proper one for the serial port.

• Check that the serial interface parameters (protocol, baud, parity, and data bits) are set correctly on the printer
and host computer.

• Touch Continue to continue printing.

• Turn the printer power off and then back on to reset the printer.

54 Standard network software error
Try one or more of the following:

• Touch Continue to continue printing.

• Turn the printer off and then back on to reset the printer.

• Upgrade (flash) the network firmware in the printer or print server.

55 Unsupported option in slot <x>
<x> is a slot on the printer system board.

Try one or more of the following:

1 Turn the printer power off.

2 Unplug the power cord from the wall outlet.

3 Remove the unsupported option card from the printer system board.

4 Connect the power cord to a properly grounded outlet.

5 Turn the printer power back on.
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56 Parallel port <x> disabled
<x> is the number of the parallel port.

Try one or more of the following:

• Touch Continue to clear the message.

The printer discards any data received through the parallel port.

• Make sure the Parallel Buffer menu item is not set to Disabled.

56 Serial port <x> disabled
<x> is the number of the serial port.

Try one or more of the following:

• Touch Continue to clear the message.

The printer discards any data received through the serial port.

• Make sure the Serial Buffer menu item is not set to Disabled.

56 Standard parallel port disabled
Try one or more of the following:

• Touch Continue to clear the message.

The printer discards any data received through the parallel port.

• Make sure the Parallel Buffer menu item is not set to Disabled.

56 Standard USB port disabled
Try one or more of the following:

• Touch Continue to clear the message.

The printer discards any data received through the USB port.

• Make sure the USB Buffer menu item is not set to Disabled.

57 Configuration change, held jobs were not restored
Since the time the jobs were stored on the printer hard disk something has changed in the printer to invalidate the
held jobs. Possible changes include:

• The printer firmware has been updated.

• Paper input, output, or duplex options needed for the print job were removed.

• The print job was created using data from a device in the USB port and the device is no longer in the port.

• The printer hard disk contains jobs that were stored while installed in a different printer model.

Touch Continue to clear the message.
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58 Too many bins attached
1 Turn the printer power off.

2 Unplug the power cord from the wall outlet.

3 Remove the additional bins.

4 Connect the power cord to a properly grounded outlet.

5 Turn the printer power back on.

58 Too many disks installed
1 Turn the printer off.

2 Unplug the power cord from the wall outlet.

3 Remove the extra disks.

4 Connect the power cord to a properly grounded outlet.

5 Turn the printer back on.

58 Too many flash options installed
1 Turn the printer off.

2 Unplug the power cord from the wall outlet.

3 Remove the excess flash memory.

4 Connect the power cord to a properly grounded outlet.

5 Turn the printer back on.

58 Too many trays attached
1 Turn the printer off.

2 Unplug the power cord from the wall outlet.

3 Remove the additional trays.

4 Connect the power cord to a properly grounded outlet.

5 Turn the printer back on.

59 Incompatible output bin <x>
Try one or more of the following:

• Remove the specified output bin.

• Touch Continue to clear the message and continue printing without using the specified output bin.
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59 Incompatible tray <x>
Try one or more of the following:

• Remove the specified tray.

• Touch Continue to clear the message and continue printing without using the specified tray.

80 Routine maintenance needed
The printer needs to have routine maintenance done. Order a maintenance kit, which contains all the items necessary
to replace the pick rollers, the charge roll, the transfer roller, and the fuser.

88 Cartridge low
The toner is low. Replace the toner cartridge, and then touch Continue to clear the message and continue printing.

88.yy Cartridge nearly low
The toner is low. Replace the toner cartridge, and then touch Continue to clear the message and continue printing.

88.yy Replace cartridge
The toner cartridge is empty.

1 Replace the toner cartridge.

2 Touch Continue to clear the message.

200–282.yy paper jam
1 Clear the paper path.

2 Touch Continue to continue printing.

283 Staple jam
1 Clear the jam from the specified stapler area(s).

2 Touch Continue to continue printing.

1565 Emulation error, load emulation option
The printer automatically clears the message in 30 seconds and then disables the download emulator on the firmware
card.

To fix this, download the correct download emulator version from the Lexmark Web site at www.lexmark.com.
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Maintaining the printer
Periodically, certain tasks are required to maintain optimum print quality.

Cleaning the exterior of the printer
1 Make sure that the printer is turned off and unplugged from the wall outlet.

CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the printer,
unplug the power cord from the wall outlet and disconnect all cables to the printer before proceeding.

2 Remove paper from the standard exit bin.

3 Dampen a clean, lint‑free cloth with water.

Warning—Potential Damage: Do not use household cleaners or detergents, as they may damage the finish of
the printer.

4 Wipe only the outside of the printer, making sure to include the standard exit bin.

Warning—Potential Damage: Using a damp cloth to clean the interior may cause damage to your printer.

5 Make sure the paper support and standard exit bin are dry before beginning a new print job.

Storing supplies
Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original packing until you
are ready to use them.

Do not expose supplies to:

• Direct sunlight

• Temperatures above 35°C (95°F)

• High humidity above 80%

• Salty air

• Corrosive gases

• Heavy dust
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Ordering supplies
To order supplies in the U.S., contact Lexmark at 1-800-539-6275 for information about Lexmark authorized supplies
dealers in your area. In other countries or regions, visit the Lexmark Web Site at www.lexmark.com or contact the
place where you purchased the printer.

Note: All life estimates for printer supplies assume printing on letter‑ or A4‑size plain paper.

Ordering print cartridges
When 88 Cartridge low appears or when the print becomes faded:

1 Remove the print cartridge.

2 Firmly shake the cartridge side‑to‑side and front‑to‑back several times to redistribute toner.

3 Reinsert the cartridge and continue printing.

Note: Repeat this procedure multiple times until the print remains faded, and then replace the cartridge.

Recommended print cartridges

Part name Lexmark Return Program Cartridge Regular cartridge

For the US and Canada

Print Cartridge T650A11A T650A21A

High Yield Print Cartridge T650H11A T650H21A

Extra High Yield Print Cartridge T654X11A T654X21A

High Yield Print Cartridge for Label
Applications

T650H04A Contact Lexmark

Extra High Yield Print Cartridge for Label
Applications

T654X04A Contact Lexmark

For Europe, the Middle East, and Africa

Print Cartridge T650A11E T650A21E

High Yield Print Cartridge T650H11E T650H21E

Extra High Yield Print Cartridge T654X11E T654X21E

High Yield Print Cartridge for Label
Applications

T650H04E Contact Lexmark

Extra High Yield Print Cartridge for Label
Applications

T654X04E Contact Lexmark
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Part name Lexmark Return Program Cartridge Regular cartridge

For the Asia Pacific Region

Print Cartridge T650A11P T650A21P

High Yield Print Cartridge T650H11P T650H21P

Extra High Yield Print Cartridge T654X11P T654X21P

High Yield Print Cartridge for Label
Applications

T650H04P Contact Lexmark

Extra High Yield Print Cartridge for Label
Applications

T654X04P Contact Lexmark

For Latin America

Print Cartridge T650A11L T650A21L

High Yield Print Cartridge T650H11L T650H21L

Extra High Yield Print Cartridge T654X11L T654X21L

High Yield Print Cartridge for Label
Applications

T650H04L Contact Lexmark

Extra High Yield Print Cartridge for Label
Applications

T654X04L Contact Lexmark

Ordering a maintenance kit
When 80 Routine maintenance needed appears, order a maintenance kit. The maintenance kit contains all
the items necessary to replace the pick rollers, the charge roll assembly, the transfer roll assembly, and the fuser.

Notes:

• Using certain types of paper may require more frequent replacement of the maintenance kit. The charge roll
assembly, fuser, pick rollers, and transfer roll assembly can also be individually ordered and replaced as
necessary.

• To check the fuser type (T1 or T2) installed in the printer, remove the print cartridge to view the label on the
fuser.

Part name Part number

Maintenance kit 40X4723 (100 V T1 fuser)

40X4724 (110 V T1 fuser)

40X4765 (220 V T1 fuser)

40X4766 (100 V T2 fuser)

40X4767 (110 V T2 fuser)

40X4768 (220 V T2 fuser)
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Ordering a charge roll assembly
When toner fog or background shading appears on printed pages, order a replacement charge roll assembly.

Part name Part number

Charge roll assembly 40X5852

Ordering a fuser
To check the fuser type (T1 or T2) installed in the printer, remove the print cartridge to view the label on the fuser.

Part name Part number

T1 fuser 40X1870 (100 V)

40X4418 (110 V)

40X1871 (220 V)

T2 fuser 40X5853 (100 V)

40X5854 (110 V)

40X5855 (220 V)

Ordering a fuser wiper
When Replace wiper appears on the display, order a fuser wiper.

Part name Part number

Fuser wiper 40X2665

Ordering pick rollers
When the paper fails to properly feed from the tray, order new pick rollers.

Part name Part number

Pick rollers (set of two) 40X4308

Ordering staple cartridges
When Staples Low or Staples Empty appears, order the specified staple cartridge.

For more information, see the illustrations inside the stapler door.

Part name Part number

Staple Cartridges–3 pack

(Since a pack contains 5,000 staples, a 3‑pack contains 15,000 staples.)

25A0013
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Ordering a transfer roll assembly
When toner smudges appear on the front or back of printed pages, order a replacement transfer roll assembly.

Part name Part number

Transfer roll assembly 40X1886

Checking the status of supplies
A message appears on the display when a replacement supply item is needed or when maintenance is required.

Checking the status of supplies from the printer control panel
1 Make sure the printer is on and Ready appears.

2 On the home screen, touch Status/Supplies.

Note: If Status/Supplies is not on the home screen, then print a menu settings page to review the status of the
supplies.

3 Touch View supplies.

The View supplies screen appears, showing a summary of supply levels.

Note: The Black Cartridge gauge is only an estimate of how much toner is left in your cartridge.

Checking the status of supplies from a network computer
Note: The computer must be connected to the same network as the printer.

1 Type the printer IP address into the address field of your Web browser.

Note: If you do not know the IP address of the printer, print a network setup page and locate the IP address in
the TCP/IP section.

2 Click Device Status. The Device Status page appears, displaying a summary of supply levels.

Moving the printer to another location
Warning—Potential Damage: Damage to the printer caused by improper moving is not covered by the printer
warranty.

CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to move it safely.

CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the wall outlet.

• Disconnect all cords and cables from the printer before moving it.
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• Lift the printer off the optional drawer, and set it aside instead of trying to lift the drawer and printer at the same
time.

Note: Use the handholds located on both sides of the printer to lift it off the optional drawer.

• Make sure your fingers are not under the printer when you set it down.

• Before setting up the printer, make sure there is adequate clearance around it.

The printer and options can be safely moved to another location by following these precautions:

• Any cart used to move the printer must be able to support its weight and have a large enough surface to support
the full footprint of the printer.

• Keep the printer in an upright position.

• Avoid severe jarring movements.

• See “Installing drawers” on page 31 for help unlocking, moving, or locking drawers.

• Update the options in the printer driver after you have completed installation.

Shipping the printer
When shipping the printer, use the original packaging or call the place of purchase for a relocation kit.
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Administrative support

Using the Embedded Web Server
To access the Embedded Web Server, type the printer IP address into the address field of your Web browser. The IP
address of your printer may appear on the top left corner of your touch screen.

Notes:

• If you do not know the IP address of the printer, then print a network setup page and locate the IP address in
the TCP/IP section. For information on printing a network setup page, see “Printing a network setup page” on
page 42.

• For more information, see the Networking Guide on the Software and Documentation CD and the Embedded
Web Server Administrator's Guide on the Lexmark Web site at www.lexmark.com/publications.

Checking the device status
From the Device Status page of the Embedded Web Server, it is possible to see paper tray settings, the level of toner
in the toner cartridge, the percentage of life remaining in the photoconductor kit, and capacity measurements of certain
printer parts. To view the device status:

1 Type the printer IP address in the address field of your Web browser.

Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Device Status.

Setting up e‑mail alerts
You can have the printer send you an e‑mail when the supplies are getting low or when the paper needs to be changed,
added, or unjammed.

To set up e‑mail alerts:

1 Type the printer IP address into the address field of your Web browser.

Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.

3 Under Other Settings, click E‑mail Alert Setup.

4 Select the items for notification, and type in the e‑mail addresses.

5 Click Submit.

Note: See your system support person to set up the e‑mail server.
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Viewing reports
You can view some reports from the Embedded Web Server. These reports are useful for assessing the status of the
printer, the network, and supplies.

To view reports from a network printer:

1 Type the printer IP address into the address field of your Web browser.

Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Reports, and then click the type of report you want to view.

Restoring the factory default settings
If you want to retain a list of the current menu settings for reference, then print a menu settings page before you restore
the factory default settings. For more information, see “Printing a menu settings page” on page 42.

Warning—Potential Damage: Restoring factory defaults returns most printer settings to the original factory default
setting. Exceptions include the display language, custom sizes and messages, and Network/Port menu settings. All
downloads stored in RAM are deleted. Downloads stored in flash memory or on a printer hard disk are not affected.

1 Make sure the printer is on and Ready appears.

2 On the home screen, touch .

3 Touch Settings.

4 Touch General Settings.

5 Touch the down arrow until Factory Defaults appears.

6 Touch the left or right arrow until Restore Now appears.

7 Touch Submit.

8 Touch .
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Troubleshooting

Solving basic problems

Solving basic printer problems
If there are basic printer problems, or the printer is unresponsive, make sure:

• The power cord is plugged into the printer and a properly grounded electrical outlet.

• The electrical outlet is not turned off by any switch or breaker.

• The printer is not plugged into any surge protectors, uninterrupted power supplies, or extension cords.

• Other electronic equipment plugged into the outlet is working.

• The printer is turned on. Check the printer power switch.

• The printer cable is securely attached to the printer and the host computer, print server, option, or other network
device.

• All options are properly installed.

• The printer driver settings are correct.

Once you have checked each of these possibilities, turn the printer off, wait for about 10 seconds, and then turn the
printer back on. This often fixes the problem.

Printer control panel display is blank or displays only diamonds
The printer self test failed. Turn the printer off, wait about 10 seconds, and then turn the printer back on.

If Performing Self Test and Ready do not appear, turn the printer off and contact Customer Support.

Embedded Web Server does not open
These are possible solutions. Try one or more of the following:

CHECK THE NETWORK CONNECTIONS

Make sure the printer and computer are turned on and connected to the same network.

CHECK THE NETWORK SETTINGS

Depending on the network settings, you may need to type https:// instead of http:// before the printer IP
address to access the Embedded Web Server. For more information, see your system administrator.
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Solving printing problems

Multiple‑language PDFs do not print
The documents contain unavailable fonts.

1 Open the document you want to print in Adobe Acrobat.

2 Click the printer icon.

The Print dialog appears.

3 Select Print as image.

4 Click OK.

Error message about reading USB drive appears
Make sure the USB drive is supported. For information regarding tested and approved USB flash memory devices, visit
the Lexmark Web site at www.lexmark.com.

Jobs do not print
These are possible solutions. Try one or more of the following:

MAKE SURE THE PRINTER IS READY TO PRINT

Make sure Ready or Power Saver appears on the display before sending a job to print.

CHECK TO SEE IF THE STANDARD EXIT BIN IS FULL

Remove the stack of paper from the standard exit bin.

CHECK TO SEE IF THE PAPER TRAY IS EMPTY

Load paper in the tray.

MAKE SURE THE CORRECT PRINTER SOFTWARE IS INSTALLED

• Verify that you are using the correct printer software.

• If you are using a USB port, make sure you are running a supported operating system and using compatible printer
software.

MAKE SURE THE INTERNAL PRINT SERVER IS INSTALLED PROPERLY AND WORKING

• Make sure the internal print server is properly installed and that the printer is connected to the network.

• Print a network setup page and check that the status shows Connected. If the status is Not Connected, check the
network cables, and then try printing the network setup page again. Contact your system support person to make
sure the network is functioning correctly.

Copies of the printer software are also available on the Lexmark Web site at www.lexmark.com.
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MAKE SURE YOU ARE USING A RECOMMENDED USB, SERIAL, OR ETHERNET CABLE

For more information, visit the Lexmark Web site at www.lexmark.com.

MAKE SURE PRINTER CABLES ARE SECURELY CONNECTED

Check the cable connections to the printer and print server to make sure they are secure.

For more information, see the setup documentation that came with the printer.

Confidential and other held jobs do not print
These are possible solutions. Try one or more of the following:

PARTIAL JOB, NO JOB, OR BLANK PAGES PRINT

The print job may contain a formatting error or invalid data.

• Delete the print job, and then print it again.

• For PDF documents, recreate the PDF and then print it again.

MAKE SURE THE PRINTER HAS SUFFICIENT MEMORY

Free up additional printer memory by scrolling through the list of held jobs and deleting some of them.

Job takes longer than expected to print
These are possible solutions. Try one or more of the following:

REDUCE THE COMPLEXITY OF THE PRINT JOB

Reduce the number and size of fonts, the number and complexity of images, and the number of pages in the job.

CHANGE THE PAGE PROTECT SETTING TO OFF

1 On the home screen, touch .

2 Touch Settings.

3 Touch General Settings.

4 Touch the down arrow until Print Recovery appears.

5 Touch Print Recovery.

6 Touch the arrows next to Page Protect until Off appears.

7 Touch Submit.

8 Touch  to return to the home screen.
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CHANGE ENVIRONMENTAL SETTINGS

When using Eco‑Mode or Quiet Mode settings, you may notice a short delay before the first page is printed. If you
want to change the settings and need more information, then see “Using Eco‑Mode” on page 63 or “Reducing printer
noise” on page 66.

Job prints from the wrong tray or on the wrong paper

CHECK THE PAPER TYPE SETTING

Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Type setting from the Paper menu.

2 Before sending the job to print, specify the correct type setting:

• For Windows users, specify the type from Print Properties.

• For Macintosh users, specify the type from the Print dialog.

Incorrect characters print

MAKE SURE THE PRINTER IS NOT IN HEX TRACE MODE

If Ready Hex appears on the display, then you must exit Hex Trace mode before you can print your job. Turn the
printer off and back on to exit Hex Trace mode.

Tray linking does not work
These are possible solutions. Try one or more of the following:

LOAD THE SAME SIZE AND TYPE OF PAPER

• Load the same size and type of paper in each tray to be linked.

• Move the paper guides to the correct positions for the paper size loaded in each tray.

USE THE SAME PAPER SIZE AND PAPER TYPE SETTINGS

• Print a menu settings page and compare the settings for each tray.

• If necessary, adjust the settings from the Paper Size/Type menu.

Note: The multipurpose feeder does not automatically sense the paper size. You must set the size from the Paper
Size/Type menu.
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Large jobs do not collate
These are possible solutions. Try one or more of the following:

MAKE SURE COLLATE IS SET TO ON

From the Finishing menu or Print Properties, set Collate to On.

Note: Setting Collate to Off in the software overrides the setting in the Finishing menu.

REDUCE THE COMPLEXITY OF THE PRINT JOB

Reduce the complexity of the print job by eliminating the number and size of fonts, the number and complexity of
images, and the number of pages in the job.

MAKE SURE THE PRINTER HAS ENOUGH MEMORY

Add printer memory.

Unexpected page breaks occur

INCREASE THE PRINT TIMEOUT VALUE

1 Make sure the printer is on and Ready appears.

2 On the home screen, touch .

3 Touch Settings.

4 Touch General Settings.

5 Touch the down arrow until Timeouts appears.

6 Touch Timeouts.

7 Touch the left or right arrow next to Print Timeout until the desired value appears.

8 Touch Submit.

9 Touch .
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Solving option problems
Settings chosen from the software program or application can change or override settings chosen from the printer
control panel. If an option is not functioning, then make sure it is selected in the software as well as the printer control
panel.

Option does not operate correctly or quits after it is installed
These are possible solutions. Try one or more of the following:

RESET THE PRINTER

Turn the printer off, wait about 10 seconds, and then turn the printer on.

CHECK TO SEE IF THE OPTION IS CONNECTED TO THE PRINTER

1 Turn the printer off.

2 Unplug the printer.

3 Check the connection between the option and the printer.

MAKE SURE THE OPTION IS INSTALLED CORRECTLY

Print a menu settings page and check to see if the option is listed in the Installed Options list. If the option is not
listed, then reinstall it. For more information, see the hardware setup documentation that came with the option, or
see the latest comprehensive User's Guide available on our Web site at www.lexmark.com/publications.

MAKE SURE THE OPTION IS SELECTED

From the computer you are printing from, select the option. For more information, see “Updating available options
in the printer driver” on page 43.

Paper trays
These are possible solutions. Try one or more of the following:

MAKE SURE THE PAPER IS LOADED CORRECTLY

1 Open the paper tray.

2 Check for paper jams or misfeeds.

3 Make sure paper guides are aligned against the edges of the paper.

4 Make sure the paper tray closes properly.

RESET THE PRINTER

Turn the printer off, wait about 10 seconds, and then turn the printer on.
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MAKE SURE THE PAPER TRAY IS INSTALLED CORRECTLY

If the paper tray is listed on the menu settings page, but paper jams when it enters or exits the tray, then it may not
be properly installed. Reinstall the paper tray. For more information, see the hardware setup documentation that
came with the paper tray, or see the latest comprehensive User's Guide available on our Web site at
www.lexmark.com/publications.

MAKE SURE THE LIST OF OPTIONS IN THE PRINTER DRIVER IS UP TO DATE

From the computer you are printing from, verify that the paper tray is among the options listed in the printer driver.
For more information, see “Updating available options in the printer driver” on page 43.

2000‑sheet tray
These are possible solutions. Try one or more of the following:

THE ELEVATOR TRAY IS NOT WORKING PROPERLY

• Make sure the printer is properly connected to the 2000‑sheet tray.

• Make sure the printer is turned on.

THE PAPER FEED ROLLERS DO NOT TURN TO ADVANCE PAPER

• Make sure the printer is properly connected to the 2000‑sheet tray.

• Make sure the printer is turned on.

5‑bin mailbox
If the 5‑bin mailbox is listed on the menu settings page, but paper jams when it exits the printer and enters the mailbox,
then it may not be properly installed. Reinstall the 5‑bin mailbox. For more information, see the hardware setup
documentation that came with the 5‑bin mailbox, or see the latest comprehensive User's Guide available on our Web
site at www.lexmark.com/publications.

Output options
If the Output Expander, High Capacity Output Stacker, or StapleSmart II Finisher is listed on the menu settings page,
but paper jams when it exits the printer or enters the output option, then it may not be properly installed. Reinstall
the option. For more information, see the hardware setup documentation that came with the option, or see the latest
comprehensive User's Guide available on our Web site at www.lexmark.com/publications.

Memory card
Make sure the memory card is securely connected to the printer system board.

Flash memory card
Make sure the flash memory card is securely connected to the printer system board.
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Hard disk with adapter
Make sure the hard disk is securely connected to the printer system board.

Internal Solutions Port
If the Lexmark Internal Solutions Port (ISP) does not operate correctly, then these are possible solutions. Try one or
more of the following:

CHECK THE ISP CONNECTIONS

• Make sure the ISP is securely attached to the printer system board.

• Make sure the cable is securely connected to the correct connector.

CHECK THE CABLE

Make sure you are using the correct cable and that it is securely connected.

MAKE SURE THE NETWORK SOFTWARE IS CONFIGURED CORRECTLY

For information about installing software for network printing, see the Networking Guide on the Software and
Documentation CD

Solving paper feed problems

Paper frequently jams
These are possible solutions. Try one or more of the following:

CHECK THE PAPER

Use recommended paper and specialty media. For more information, see the chapter about paper and specialty
media guidelines.

MAKE SURE THERE IS NOT TOO MUCH PAPER IN THE PAPER TRAY

Make sure the stack of paper you load does not exceed the maximum stack height indicated in the tray or on the
multipurpose feeder.

CHECK THE PAPER GUIDES

Move the guides in the tray to the correct positions for the paper size loaded.

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.
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Paper jam message remains after jam is cleared

CHECK THE PAPER PATH

The paper path is not clear. Clear jammed paper from the entire paper path, and then touch Continue.

Page that jammed does not reprint after you clear the jam

TURN ON JAM RECOVERY

In the Setup menu, Jam Recovery is set to Off. Set Jam Recovery to Auto or On:

1 Make sure the printer is on and Ready appears.

2 On the home screen, touch .

3 Touch Settings.

4 Touch General Settings.

5 Touch the down arrow until Print Recovery appears.

6 Touch Print Recovery.

7 Touch the right arrow next to Jam Recovery until On or Auto appears.

8 Touch Submit.

9 Touch .

Solving print quality problems

Isolating print quality problems
To help isolate print quality problems, print the print quality test pages:

1 Turn the printer off.

2 Load Letter‑ or A4‑size paper in the tray.

3 Hold down  and 6MNO  while turning the printer on.

4 Release the buttons when the screen with the progress bar appears.

The printer performs a power‑on sequence, and then the Configuration menu appears.

5 Touch the down arrow until Print Quality Pages appears.

6 Touch Print Quality Pages.

The print quality test pages print.

7 Touch Back.

8 Touch Exit Configuration.
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Blank pages

These are possible solutions. Try one or more of the following:

PACKING MATERIAL MAY BE ON THE PRINT CARTRIDGE

Remove the print cartridge and make sure the packing material is properly removed. Reinstall the print cartridge.

THE TONER MAY BE LOW

When 88 Cartridge low appears, order a new print cartridge.

If the problem continues, the printer may need to be serviced. For more information, contact Customer Support.

Clipped images
These are possible solutions. Try one or more of the following:

CHECK THE GUIDES

Move the width and length guides in the tray to the correct positions for the paper size loaded.

CHECK THE PAPER SIZE SETTING

Make sure the paper size setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Size setting from the Paper menu.

2 Before sending the job to print, specify the correct size setting:

• For Windows users, specify the size from Print Properties.

• For Macintosh users, specify the size from the Page Setup dialog.

Ghost images

ABCDE
ABCDE
ABCDEABCDE
ABCDE
ABCDE

Troubleshooting 179



CHECK THE PAPER TYPE SETTING

Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Type setting from the Paper menu.

2 Before sending the job to print, specify the correct type setting:

• For Windows users, specify the type from Print Properties.

• For Macintosh users, specify the type from the Print dialog.

Gray background

ABCDE

ABCDE
ABCDE

CHECK THE TONER DARKNESS SETTING

Select a lighter Toner Darkness setting:

• From the printer control panel, change the setting from the Quality menu.

• For Windows users, change the setting from Print Properties.

• For Macintosh users, change the setting from the Print dialog.

Incorrect margins

ABCD
ABCD
ABCD

These are possible solutions. Try one or more of the following:

CHECK THE PAPER GUIDES

Move the guides in the tray to the correct positions for the paper size loaded.
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CHECK THE PAPER SIZE SETTING

Make sure the paper size setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Size setting from the Paper menu.

2 Before sending the job to print, specify the correct size setting:

• For Windows users, specify the size from Print Properties.

• For Macintosh users, specify the size from the Page Setup dialog.

Paper curl
These are possible solutions. Try one or more of the following:

CHECK THE PAPER TYPE SETTING

Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Type setting from the Paper menu.

2 Before sending the job to print, specify the correct type setting:

• For Windows users, specify the type from Print Properties.

• For Macintosh users, specify the type from the Print dialog.

THE PAPER HAS ABSORBED MOISTURE DUE TO HIGH HUMIDITY

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.

Print irregularities

These are possible solutions. Try one or more of the following:

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.
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CHECK THE PAPER TYPE SETTING

Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Type setting from the Paper menu.

2 Before sending the job to print, specify the correct type setting:

• For Windows users, specify the type from Print Properties.

• For Macintosh users, specify the type from the Print dialog.

CHECK THE PAPER

Avoid textured paper with rough finishes.

THE TONER MAY BE LOW

When 88 Cartridge low appears or when the print becomes faded, replace the print cartridge.

THE FUSER MAY BE WORN OR DEFECTIVE

Replace the fuser.

Print is too dark

These are possible solutions. Try one or more of the following:

CHECK THE DARKNESS, BRIGHTNESS, AND CONTRAST SETTINGS

The Toner Darkness setting is too dark, the Brightness setting is too dark, or the Contrast setting is too high.

• From the printer control panel, change these settings from the Quality menu.

• For Windows users, change these settings from Print Properties.

• For Macintosh users, change these settings from the Print dialog and pop‑up menus.

THE PAPER HAS ABSORBED MOISTURE DUE TO HIGH HUMIDITY

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.

CHECK THE PAPER

Avoid textured paper with rough finishes.
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CHECK THE PAPER TYPE SETTING

Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Type setting from the Paper menu.

2 Before sending the job to print, specify the correct type setting:

• For Windows users, specify the type from Print Properties.

• For Macintosh users, specify the type from the Print dialog.

THE PRINT CARTRIDGE MAY BE DEFECTIVE

Replace the print cartridge.

Print is too light

These are possible solutions. Try one or more of the following:

CHECK THE DARKNESS, BRIGHTNESS, AND CONTRAST SETTINGS

The Toner Darkness setting is too light, the Brightness setting is too light, or the Contrast setting is too low.

• From the printer control panel, change these settings from the Quality menu.

• For Windows users, change these settings from Print Properties.

• For Macintosh users, change these settings from the Print dialog and pop‑up menus.

THE PAPER HAS ABSORBED MOISTURE DUE TO HIGH HUMIDITY

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.

CHECK THE PAPER

Avoid textured paper with rough finishes.
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CHECK THE PAPER TYPE SETTING

Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Type setting from the Paper menu.

2 Before sending the job to print, specify the correct type setting:

• For Windows users, specify the type from Print Properties.

• For Macintosh users, specify the type from the Print dialog.

THE TONER IS LOW

When 88 Cartridge Low appears, order a new print cartridge.

THE PRINT CARTRIDGE MAY BE DEFECTIVE

Replace the print cartridge.

Repeating defects

) )

) )

REPEATING MARKS OCCUR EVENLY DOWN THE PAGE

Replace the charge roll assembly if the defects occur every 28.3 mm (1.11 in.).

Replace the transfer roll assembly if the defects occur every 51.7 mm (2.04 in.).

Replace the print cartridge if the defects occur every:

• 47.8 mm (1.88 in.)

• 96.8 mm (3.81 in.)

Replace the fuser if the defects occur every:

• 88.0 mm (3.46 in.)

• 95.2 mm (3.75 in.)

If after measuring, you find a defect that does not fit the preceding categories, replace the print cartridge.

Skewed print
These are possible solutions. Try one or more of the following:

CHECK THE PAPER GUIDES

Move the guides in the tray to the correct positions for the paper size loaded.
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CHECK THE PAPER

Make sure you are using paper that meets the printer specifications.

REPLACE THE PRINT CARTRIDGE

Install a new print cartridge in case your existing cartridge has become damaged.

Solid black or white streaks

ABC

DEF
ABC

DEF

These are possible solutions. Try one or more of the following:

MAKE SURE THE FILL PATTERN IS CORRECT

If the fill pattern is incorrect, then choose a different fill pattern from your software program or application.

CHECK THE PAPER TYPE

• Try a different type of paper.

• Use only transparencies recommended by the printer manufacturer.

• Make sure the Paper Type and Paper Texture settings match the paper loaded in the tray or feeder.

MAKE SURE THE TONER IS DISTRIBUTED EVENLY IN THE PRINT CARTRIDGE

Remove the print cartridge and shake it from side to side to redistribute the toner, and then reinstall it.

THE PRINT CARTRIDGE MAY BE DEFECTIVE OR LOW ON TONER

Replace the used print cartridge with a new one.

Solid color pages

These are possible solutions. Try one or more of the following:
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MAKE SURE THE PRINT CARTRIDGE IS PROPERLY INSTALLED

Remove the print cartridge and shake it from side to side to redistribute the toner, and then reinstall it.

THE PRINT CARTRIDGE MAY BE DEFECTIVE OR LOW ON TONER

Replace the used print cartridge with a new one. If the problem continues, the printer may need to be serviced. For
more information, contact Customer Support.

Streaked horizontal lines

ABCDE
ABCDE
ABCDE

These are the possible solutions. Try one or more of the following:

THE TONER IS SMEARED

Select another tray or feeder to feed the paper for the job:

• From the printer control panel, select the Default Source from the Paper Menu.

• For Windows users, select the paper source from Print Properties.

• For Macintosh users, select the paper source from the Print dialog and pop‑up menus.

THE PRINT CARTRIDGE MAY BE DEFECTIVE

Replace the print cartridge.

THE PAPER PATH MAY NOT BE CLEAR

Check the paper path around the print cartridge.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

Clear any paper you see.

THERE IS TONER IN THE PAPER PATH

Clean any visible toner from the paper path. If the problem persists, then contact Customer Support.
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Streaked vertical lines

ABCDE
ABCDE
ABCDE

These are possible solutions. Try one or more of the following:

THE TONER IS SMEARED

Select another tray or feeder to feed paper for the job:

• From the printer control panel, select the Default Source from the Paper Menu.

• For Windows users, select the paper source from Print Properties.

• For Macintosh users, select the paper source from the Print dialog and pop‑up menus.

THE PRINT CARTRIDGE IS DEFECTIVE

Replace the print cartridge.

THE PAPER PATH MAY NOT BE CLEAR

Check the paper path around the print cartridge.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

Clear any paper you see.

THERE IS TONER IN THE PAPER PATH

Clean any visible toner from the paper path. If the problem persists, then contact Customer Support.

Toner fog or background shading appears on the page
These are possible solutions. Try one or more of the following:

THE PRINT CARTRIDGE MAY BE DEFECTIVE

Replace the print cartridge.

THE CHARGE ROLL ASSEMBLY MAY BE DEFECTIVE

Replace the charge roll assembly.
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THERE IS TONER IN THE PAPER PATH

Clean any toner from the paper path. If the problem persists, then contact Customer Support.

Toner rubs off

These are possible solutions. Try one or more of the following:

CHECK THE PAPER TYPE SETTING

Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Type setting from the Paper menu.

2 Before sending the job to print, specify the correct type setting:

• For Windows users, specify the type from Print Properties.

• For Macintosh users, specify the type from the Print dialog.

CHECK THE PAPER TEXTURE SETTING

From the printer control panel Paper menu, make sure the Paper Texture setting matches the paper loaded in the
tray.

Toner specks

These are possible solutions. Try one or more of the following:

THE PRINT CARTRIDGE MAY BE DEFECTIVE

Replace the print cartridge.
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THERE IS TONER IN THE PAPER PATH

Clean any toner from the paper path. If the problem persists, then contact Customer Support.

Transparency print quality is poor
Try one or more of the following:

CHECK THE TRANSPARENCIES

Use only transparencies recommended by Lexmark.

CHECK THE PAPER TYPE SETTING

Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Type setting from the Paper menu.

2 Before sending the job to print, specify the correct type setting:

• For Windows users, specify the type from Print Properties.

• For Macintosh users, specify the type from the Print dialog.

Solving application problems

Forms are not available or are not working
These are possible solutions. Try one or more of the following:

MAKE SURE THE BOOKMARK POINTING TO THE FORM IS IN THE BOOKMARKS ROOT FOLDER

If the bookmark pointing to the form was created in a subfolder of the Bookmarks folder, it will not be available
under the Forms solution. Delete the bookmarks, and recreate them under the Bookmarks root folder.

For information on creating bookmarks, see “Configuring Forms on Demand.”

MAKE SURE THE BOOKMARK IS POINTING TO THE CORRECT LOCATION

Verify that the form resides in the correct network location. The printer will not validate the location that the
bookmark points to. As a result, if the URL or network location that was specified when the bookmark was created
is incorrect, the printer will not be able to access the document.

Contacting Customer Support
When you call Customer Support, describe the problem you are experiencing, the message on the display, and the
troubleshooting steps you have already taken to find a solution.

You need to know your printer model type and serial number. For more information, see the label inside the top front
cover of the printer. The serial number is also listed on the menu settings page.
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In the U.S. or Canada, call 1‑800‑539‑6275. For other countries/regions, visit the Lexmark Web site at
www.lexmark.com.
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Notices

Product information

Product name:

Lexmark T656dne

Machine type:

4062, 4864

Model(s):

630, dn1, dn2, dn3, gd1, gd2

Edition notice

August 2011

The following paragraph does not apply to any country where such provisions are inconsistent with local law:
LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions; therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the
information herein; these changes will be incorporated in later editions. Improvements or changes in the products or
the programs described may be made at any time.

References in this publication to products, programs, or services do not imply that the manufacturer intends to make
these available in all countries in which it operates. Any reference to a product, program, or service is not intended to
state or imply that only that product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification
of operation in conjunction with other products, programs, or services, except those expressly designated by the
manufacturer, are the user’s responsibility.

For Lexmark technical support, visit support.lexmark.com.

For information on supplies and downloads, visit www.lexmark.com.

If you don't have access to the Internet, you can contact Lexmark by mail:

Lexmark International, Inc.
Bldg 004-2/CSC
740 New Circle Road NW
Lexington, KY 40550
USA

© 2009 Lexmark International, Inc.

All rights reserved.

Notices 191

http://support.lexmark.com
http://www.lexmark.com


UNITED STATES GOVERNMENT RIGHTS

This software and any accompanying documentation provided under this agreement are commercial computer
software and documentation developed exclusively at private expense.

Trademarks

Lexmark and Lexmark with diamond design are trademarks of Lexmark International, Inc., registered in the United
States and/or other countries.

PCL® is a registered trademark of the Hewlett-Packard Company.

All other trademarks are the property of their respective owners.

Federal Communications Commission (FCC) compliance information statement
This product has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference when the equipment
is operated in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for radio or television interference caused by using other than recommended
cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could
void the user's authority to operate this equipment.

Note: To assure compliance with FCC regulations on electromagnetic interference for a Class B computing device,
use a properly shielded and grounded cable such as Lexmark part number 1021231 for parallel attach or 1021294 for
USB attach. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC
regulations.

Any questions regarding this compliance information statement should be directed to:

Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY 40550
(859) 232–3000

Modular component notice

This product may contain the following modular component(s):
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Lexmark Regulatory Type/Model LEX-M04-001; FCC ID: IYLLEXM04001; Industry Canada IC: 2376A-M04001

Temperature information

Ambient temperature 15–32° C (60–90° F)

Shipping temperature ‑40–60° C (‑40–140° F)

Storage temperature 1–60° C (34–140° F)

Noise emission levels

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

Note: Some modes may not apply to your product.

1-meter average sound pressure, dBA

Printing 56 dB(A)

Scanning N/A

Copying N/A

Ready 27 dB(A)

Values are subject to change. See www.lexmark.com for current values.

Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European
Union. We encourage the recycling of our products. If you have further questions about recycling options, visit the
Lexmark Web site at www.lexmark.com for your local sales office phone number.

Static sensitivity notice
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This symbol identifies static-sensitive parts. Do not touch in the areas near these symbols without first touching the
metal frame of the printer.

ENERGY STAR

Any Lexmark product bearing the ENERGY STAR emblem on the product or on a start-up screen is certified to comply
with Environmental Protection Agency (EPA) ENERGY STAR requirements as configured when shipped by Lexmark.

Laser notice

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR Subchapter J for Class I (1) laser
products, and elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1.

Class I laser products are not considered to be hazardous. The printer contains internally a Class IIIb (3b) laser that is
nominally a 7 milliwatt gallium arsenide laser operating in the wavelength of 655-675 nanometers. The laser system
and printer are designed so there is never any human access to laser radiation above a Class I level during normal
operation, user maintenance, or prescribed service condition.

Laser advisory label
A laser notice label may be affixed to this printer as shown:
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Power consumption

Product power consumption

The following table documents the power consumption characteristics of the product.

Note: Some modes may not apply to your product.

Mode Description Power consumption (Watts)

Printing The product is generating hard‑copy output from electronic inputs. 600 W duplex; 780 W simplex

Copying The product is generating hard‑copy output from hard‑copy original
documents.

N/A

Scanning The product is scanning hard‑copy documents. N/A

Ready The product is waiting for a print job. 100 W

Power Saver The product is in energy‑saving mode. 19 W

Off The product is plugged into a wall outlet, but the power switch is turned off. 0 W

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous
power draws may be substantially higher than the average.

Values are subject to change. See www.lexmark.com for current values.

Power Saver

This product is designed with an energy-saving mode called Power Saver. The Power Saver Mode is equivalent to the
Sleep Mode. The Power Saver Mode saves energy by lowering power consumption during extended periods of inactivity.
The Power Saver Mode is automatically engaged after this product is not used for a specified period of time, called the
Power Saver Timeout.

Factory default Power Saver Timeout for this product (in minutes): 30

By using the configuration menus, the Power Saver Timeout can be modified between 1 minute and 240 minutes.
Setting the Power Saver Timeout to a low value reduces energy consumption, but may increase the response time of
the product. Setting the Power Saver Timeout to a high value maintains a fast response, but uses more energy.

Off mode

If this product has an off mode which still consumes a small amount of power, then to completely stop product power
consumption, disconnect the power supply cord from the wall outlet.

Total energy usage

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in
power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in
order to calculate energy usage. The total product energy usage is the sum of each mode's energy usage.
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Industry Canada compliance statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Standard
ICES-003.

Avis de conformité aux normes de l’industrie du Canada

Cet appareil numérique de classe B est conforme aux exigences de la norme canadienne relative aux équipements
pouvant causer des interférences NMB-003.

European Community (EC) directives conformity

This product is in conformity with the protection requirements of EC Council directives 2004/108/EC and 2006/95/EC
on the approximation and harmonization of the laws of the Member States relating to electromagnetic compatibility
and safety of electrical equipment designed for use within certain voltage limits.

A declaration of conformity with the requirements of the directives has been signed by the Director of Manufacturing
and Technical Support, Lexmark International, Inc., S.A., Boigny, France.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Regulatory notices for wireless products

This section contains the following regulatory information pertaining to wireless products that contain transmitters,
for example, but not limited to, wireless network cards or proximity card readers.

Exposure to radio frequency radiation

The radiated output power of this device is far below the radio frequency exposure limits of the FCC and other regulatory
agencies. A minimum separation of 20 cm (8 inches) must be maintained between the antenna and any persons for
this device to satisfy the RF exposure requirements of the FCC and other regulatory agencies.

Notice to users in Brazil
Este equipamento opera em carater secundario, isto e, nao tem direito a protecao contra interferencia prejudicial,
mesmo de estacoes do mesmo tipo, e nao pode causar interferencia a sistemas operando em carater primario.
(Res.ANATEL 282/2001).

Industry Canada (Canada)

This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that
may cause undesired operation of the device.

This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly prohibited
per regulations of Industry Canada.
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To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.

The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit RF
fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health
Canada's Web site www.hc-sc.gc.ca/rpb.

The term "IC:" before the certification/registration number only signifies that the Industry Canada technical
specifications were met.

Industry Canada (Canada)

Cet appareil est conforme à la norme RSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions
suivantes :

(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence reçue, y compris celles
risquant d'altérer son fonctionnement.

Cet appareil a été conçu pour fonctionner uniquement avec l'antenne fournie. L'utilisation de toute autre antenne est
strictement interdite par la réglementation d'Industry Canada.

En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est strictement
interdite.

Pour empêcher toute interférence radio au service faisant l'objet d'une licence, cet appareil doit être utilisé à l'intérieur
et loin des fenêtres afin de garantir une protection optimale.

Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.

L'installateur de cet équipement radio doit veiller à ce que l'antenne soit implantée et dirigée de manière à n'émettre
aucun champ HF dépassant les limites fixées pour l'ensemble de la population par Santé Canada. Reportez-vous au
Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.

Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme
aux spécifications techniques d'Industry Canada.

Taiwan NCC RF notice statement

Notice to users in the European Union

Products bearing the CE mark are in conformity with the protection requirements of EC Council directives 2004/108/EC,
2006/95/EC, and 1999/5/EC on the approximation and harmonization of the laws of the Member States relating to
electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits and on radio
equipment and telecommunications terminal equipment.
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Compliance is indicated by the CE marking.

A declaration of conformity with the requirements of the directives is available from the Director of Manufacturing and
Technical Support, Lexmark International, S. A., Boigny, France. Refer to the table at the end of the Notices section for
further compliance information.

Products equipped with 2.4GHz Wireless LAN option are in conformity with the protection requirements of EC Council
directives 2004/108/EC, 2006/95/EC, and 1999/5/EC on the approximation and harmonization of the laws of the
Member States relating to electromagnetic compatibility, safety of electrical equipment designed for use within certain
voltage limits and on radio equipment and telecommunications terminal equipment.

Compliance is indicated by the CE marking.

Operation is allowed in all EU and EFTA countries, but is restricted to indoor use only.

A declaration of conformity with the requirements of the directives is available from the Director of Manufacturing and
Technical Support, Lexmark International, S. A., Boigny, France. Refer to the table at the end of the Notices section for
further compliance information.

Česky Společnost Lexmark International, Inc. tímto prohlašuje, že výrobek tento výrobek je ve shodě se základními
požadavky a dalšími příslušnými ustanoveními směrnice 1999/5/ES.

Dansk Lexmark International, Inc. erklærer herved, at dette produkt overholder de væsentlige krav og øvrige relevante
krav i direktiv 1999/5/EF.

Deutsch Hiermit erklärt Lexmark International, Inc., dass sich das Gerät dieses Gerät in Übereinstimmung mit den
grundlegenden Anforderungen und den übrigen einschlägigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

Ελληνική ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ Η LEXMARK INTERNATIONAL, INC. ΔΗΛΩΝΕΙ ΟΤΙ ΑΥΤΟ ΤΟ ΠΡΟΪΟΝ
ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ
ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.

English Hereby, Lexmark International, Inc., declares that this type of equipment is in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC.

Español Por medio de la presente, Lexmark International, Inc. declara que este producto cumple con los requisitos
esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.

Eesti Käesolevaga kinnitab Lexmark International, Inc., et seade see toode vastab direktiivi 1999/5/EÜ
põhinõuetele ja nimetatud direktiivist tulenevatele muudele asjakohastele sätetele.

Suomi Lexmark International, Inc. vakuuttaa täten, että tämä tuote on direktiivin 1999/5/EY oleellisten vaatimusten
ja muiden sitä koskevien direktiivin ehtojen mukainen.

Français Par la présente, Lexmark International, Inc. déclare que l'appareil ce produit est conforme aux exigences
fondamentales et autres dispositions pertinentes de la directive 1999/5/CE.

Magyar Alulírott, Lexmark International, Inc. nyilatkozom, hogy a termék megfelel a vonatkozó alapvetõ
követelményeknek és az 1999/5/EC irányelv egyéb elõírásainak.
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Íslenska Hér með lýsir Lexmark International, Inc. yfir því að þessi vara er í samræmi við grunnkröfur og aðrar
kröfur, sem gerðar eru í tilskipun 1999/5/EC.

Italiano Con la presente Lexmark International, Inc. dichiara che questo questo prodotto è conforme ai requisiti
essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Latviski Ar šo Lexmark International, Inc. deklarē, ka šis izstrādājums atbilst Direktīvas 1999/5/EK būtiskajām
prasībām un citiem ar to saistītajiem noteikumiem.

Lietuvių Šiuo Lexmark International, Inc. deklaruoja, kad šis produktas atitinka esminius reikalavimus ir kitas
1999/5/EB direktyvos nuostatas.

Malti Bil-preżenti, Lexmark International, Inc., jiddikjara li dan il-prodott huwa konformi mal-ħtiġijiet
essenzjali u ma dispożizzjonijiet oħrajn relevanti li jinsabu fid-Direttiva 1999/5/KE.

Nederlands Hierbij verklaart Lexmark International, Inc. dat het toestel dit product in overeenstemming is met de essentiële
eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.

Norsk Lexmark International, Inc. erklærer herved at dette produktet er i samsvar med de grunnleggende krav og
øvrige relevante krav i direktiv 1999/5/EF.

Polski Niniejszym Lexmark International, Inc. oświadcza, że niniejszy produkt jest zgodny z zasadniczymi
wymogami oraz pozostałymi stosownymi postanowieniami Dyrektywy 1999/5/EC.

Português A Lexmark International Inc. declara que este este produto está conforme com os requisitos essenciais e outras
disposições da Diretiva 1999/5/CE.

Slovensky Lexmark International, Inc. týmto vyhlasuje, že tento produkt spĺňa základné požiadavky a všetky
príslušné ustanovenia smernice 1999/5/ES.

Slovensko Lexmark International, Inc. izjavlja, da je ta izdelek v skladu z bistvenimi zahtevami in ostalimi
relevantnimi določili direktive 1999/5/ES.

Svenska Härmed intygar Lexmark International, Inc. att denna produkt står i överensstämmelse med de väsentliga
egenskapskrav och övriga relevanta bestämmelser som framgår av direktiv 1999/5/EG.

Statement of Limited Warranty

Lexmark T656dne

Lexmark International, Inc., Lexington, KY

This limited warranty applies to the United States and Canada. For customers outside the U.S., refer to the country-
specific warranty information that came with your product.

This limited warranty applies to this product only if it was originally purchased for your use, and not for resale, from
Lexmark or a Lexmark Remarketer, referred to in this statement as “Remarketer.”

Limited warranty

Lexmark warrants that this product:

—Is manufactured from new parts, or new and serviceable used parts, which perform like new parts

—Is, during normal use, free from defects in material and workmanship

If this product does not function as warranted during the warranty period, contact a Remarketer or Lexmark for repair
or replacement (at Lexmark's option).
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If this product is a feature or option, this statement applies only when that feature or option is used with the product
for which it was intended. To obtain warranty service, you may be required to present the feature or option with the
product.

If you transfer this product to another user, warranty service under the terms of this statement is available to that user
for the remainder of the warranty period. You should transfer proof of original purchase and this statement to that
user.

Limited warranty service

The warranty period starts on the date of original purchase as shown on the purchase receipt and ends 12 months later
provided that the warranty period for any supplies and for any maintenance items included with the printer shall end
earlier if it, or its original contents, are substantially used up, depleted, or consumed.

To obtain warranty service you may be required to present proof of original purchase. You may be required to deliver
your product to the Remarketer or Lexmark, or ship it prepaid and suitably packaged to a Lexmark designated location.
You are responsible for loss of, or damage to, a product in transit to the Remarketer or the Lexmark designated location.

When warranty service involves the exchange of a product or part, the item replaced becomes the property of the
Remarketer or Lexmark. The replacement may be a new or repaired item.

The replacement item assumes the remaining warranty period of the original product.

Replacement is not available to you if the product you present for exchange is defaced, altered, in need of a repair not
included in warranty service, damaged beyond repair, or if the product is not free of all legal obligations, restrictions,
liens, and encumbrances.

Before you present this product for warranty service, remove all print cartridges, programs, data, and removable storage
media (unless directed otherwise by Lexmark).

For further explanation of your warranty alternatives and the nearest Lexmark authorized servicer in your area contact
Lexmark on the World Wide Web at www.lexmark.com/support.

Remote technical support is provided for this product throughout its warranty period. For products no longer covered
by a Lexmark warranty, technical support may not be available or only be available for a fee.

Extent of limited warranty

Lexmark does not warrant uninterrupted or error-free operation of any product or the durability or longevity of prints
produced by any product.

Warranty service does not include repair of failures caused by:

—Modification or unauthorized attachments

—Accidents, misuse, abuse or use inconsistent with Lexmark user’s guides, manuals, instructions or guidance

—Unsuitable physical or operating environment

—Maintenance by anyone other than Lexmark or a Lexmark authorized servicer

—Operation of a product beyond the limit of its duty cycle

—Use of printing media outside of Lexmark specifications

—Refurbishment, repair, refilling or remanufacture by a third party of products, supplies or parts

—Products, supplies, parts, materials (such as toners and inks), software, or interfaces not furnished by Lexmark

TO THE EXTENT PERMITTED BY APPLICABLE LAW, NEITHER LEXMARK NOR ITS THIRD PARTY SUPPLIERS OR
REMARKETERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH
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RESPECT TO THIS PRODUCT, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND SATISFACTORY QUALITY. ANY WARRANTIES THAT
MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO
WARRANTIES, EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. ALL INFORMATION, SPECIFICATIONS, PRICES,
AND SERVICES ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE.

Limitation of liability

Your sole remedy under this limited warranty is set forth in this document. For any claim concerning performance or
nonperformance of Lexmark or a Remarketer for this product under this limited warranty, you may recover actual
damages up to the limit set forth in the following paragraph.

Lexmark's liability for actual damages from any cause whatsoever will be limited to the amount you paid for the product
that caused the damages. This limitation of liability will not apply to claims by you for bodily injury or damage to real
property or tangible personal property for which Lexmark is legally liable. IN NO EVENT WILL LEXMARK BE LIABLE FOR
ANY LOST PROFITS, LOST SAVINGS, INCIDENTAL DAMAGE, OR OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES.
This is true even if you advise Lexmark or a Remarketer of the possibility of such damages. Lexmark is not liable for any
claim by you based on a third party claim.

This limitation of remedies also applies to claims against any Suppliers and Remarketers of Lexmark. Lexmark's and its
Suppliers' and Remarketers' limitations of remedies are not cumulative. Such Suppliers and Remarketers are intended
beneficiaries of this limitation.

Additional rights

Some states do not allow limitations on how long an implied warranty lasts, or do not allow the exclusion or limitation
of incidental or consequential damages, so the limitations or exclusions contained above may not apply to you.

This limited warranty gives you specific legal rights. You may also have other rights that vary from state to state.

LEXMARK SOFTWARE LIMITED WARRANTY AND LICENSE AGREEMENT
PLEASE READ CAREFULLY BEFORE USING THIS PRODUCT: BY USING THIS PRODUCT, YOU AGREE TO BE BOUND BY ALL
THE TERMS AND CONDITIONS OF THIS SOFTWARE LIMITED WARRANTY AND LICENSE AGREEMENT. IF YOU DO NOT
AGREE WITH THE TERMS OF THIS SOFTWARE LIMITED WARRANTY AND LICENSE AGREEMENT, PROMPTLY RETURN THE
PRODUCT UNUSED AND REQUEST A REFUND OF THE AMOUNT YOU PAID. IF YOU ARE INSTALLING THIS PRODUCT FOR
USE BY OTHER PARTIES, YOU AGREE TO INFORM THE USERS THAT USE OF THE PRODUCT INDICATES ACCEPTANCE OF
THESE TERMS.

LEXMARK SOFTWARE LICENSE AGREEMENT

This License Agreement (“Software License Agreement”) is a legal agreement between you (either an individual or a
single entity) and Lexmark International, Inc. (“Lexmark”) that, to the extent your Lexmark product or Software Program
is not otherwise subject to a written software license agreement between you and Lexmark or its suppliers, governs
your use of any Software Program installed on or provided by Lexmark for use in connection with your Lexmark product.
The term “Software Program” includes machine-readable instructions, audio/visual content (such as images and
recordings), and associated media, printed materials and electronic documentation, whether incorporated into,
distributed with or for use with your Lexmark product.

1 STATEMENT OF SOFTWARE LIMITED WARRANTY. Lexmark warrants that the media (e.g., diskette or compact disk)
on which the Software Program (if any) is furnished is free from defects in materials and workmanship under normal
use during the warranty period. The warranty period is ninety (90) days and commences on the date the Software
Program is delivered to the original end-user. This limited warranty applies only to Software Program media
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purchased new from Lexmark or an Authorized Lexmark Reseller or Distributor. Lexmark will replace the Software
Program should it be determined that the media does not conform to this limited warranty.

2 DISCLAIMER AND LIMITATION OF WARRANTIES. EXCEPT AS PROVIDED IN THIS SOFTWARE LICENSE AGREEMENT
AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, LEXMARK AND ITS SUPPLIERS PROVIDE THE
SOFTWARE PROGRAM "AS IS" AND HEREBY DISCLAIM ALL OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, TITLE, NON-INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE, AND ABSENCE OF VIRUSES, ALL WITH REGARD TO THE SOFTWARE PROGRAM. TO THE
EXTENT LEXMARK CANNOT BY LAW DISCLAIM ANY COMPONENT OF THE IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, LEXMARK LIMITS THE DURATION OF SUCH
WARRANTIES TO THE 90-DAY TERM OF THE EXPRESS SOFTWARE LIMITED WARRANTY.

This Agreement is to be read in conjunction with certain statutory provisions, as that may be in force from time to
time, that imply warranties or conditions or impose obligations on Lexmark that cannot be excluded or modified.
If any such provisions apply, then to the extent Lexmark is able, Lexmark hereby limits its liability for breach of those
provisions to one of the following: providing you a replacement copy of the Software Program or reimbursement
of the price paid for the Software Program.

The Software Program may include internet links to other software applications and/or internet web pages hosted
and operated by third parties unaffiliated with Lexmark. You acknowledge and agree that Lexmark is not responsible
in any way for the hosting, performance, operation, maintenance, or content of, such software applications and/or
internet web pages.

3 LIMITATION OF REMEDY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, ANY AND ALL LIABILITY OF
LEXMARK UNDER THIS SOFTWARE LICENSE AGREEMENT IS EXPRESSLY LIMITED TO THE GREATER OF THE PRICE PAID
FOR THE SOFTWARE PROGRAM AND FIVE U.S. DOLLARS (OR THE EQUIVALENT IN LOCAL CURRENCY). YOUR SOLE
REMEDY AGAINST LEXMARK IN ANY DISPUTE UNDER THIS SOFTWARE LICENSE AGREEMENT SHALL BE TO SEEK TO
RECOVER ONE OF THESE AMOUNTS, UPON PAYMENT OF WHICH LEXMARK SHALL BE RELEASED AND DISCHARGED
OF ALL FURTHER OBLIGATIONS AND LIABILITY TO YOU.

IN NO EVENT WILL LEXMARK, ITS SUPPLIERS, SUBSIDIARIES, OR RESELLERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL,
INDIRECT, EXEMPLARY, PUNITIVE, OR CONSEQUENTIAL DAMAGES (INCLUDING BUT NOT LIMITED TO LOST PROFITS
OR REVENUES, LOST SAVINGS, INTERRUPTION OF USE OR ANY LOSS OF, INACCURACY IN, OR DAMAGE TO, DATA
OR RECORDS, FOR CLAIMS OF THIRD PARTIES, OR DAMAGE TO REAL OR TANGIBLE PROPERTY, FOR LOSS OF PRIVACY
ARISING OUT OR IN ANY WAY RELATED TO THE USE OF OR INABILITY TO USE THE SOFTWARE PROGRAM, OR
OTHERWISE IN CONNECTION WITH ANY PROVISION OF THIS SOFTWARE LICENSE AGREEMENT), REGARDLESS OF
THE NATURE OF THE CLAIM, INCLUDING BUT NOT LIMITED TO BREACH OF WARRANTY OR CONTRACT, TORT
(INCLUDING NEGLIGENCE OR STRICT LIABILITY), AND EVEN IF LEXMARK, OR ITS SUPPLIERS, AFFILIATES, OR
REMARKETERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY YOU BASED
ON A THIRD-PARTY CLAIM, EXCEPT TO THE EXTENT THIS EXCLUSION OF DAMAGES IS DETERMINED LEGALLY INVALID.
THE FOREGOING LIMITATIONS APPLY EVEN IF THE ABOVE-STATED REMEDIES FAIL OF THEIR ESSENTIAL PURPOSE.

4 U.S.A. STATE LAWS. This Software Limited Warranty gives you specific legal rights. You may also have other rights
that vary from state to state. Some states do not allow limitations on how long an implied warranty lasts or the
exclusion of limitation of incidental or consequential damages, so the above limitations may not apply to you.

5 LICENSE GRANT. Lexmark grants you the following rights provided you comply with all terms and conditions of this
License Agreement:

a Use. You may Use one (1) copy of the Software Program. The term “Use” means storing, loading, installing,
executing, or displaying the Software Program. If Lexmark has licensed the Software Program to you for
concurrent use, you must limit the number of authorized users to the number specified in your agreement with
Lexmark. You may not separate the components of the Software Program for use on more than one computer.
You agree that you will not Use the Software Program, in whole or in part, in any manner that has the effect of
overriding, modifying, eliminating, obscuring, altering or de-emphasizing the visual appearance of any
trademark, trade name, trade dress or intellectual property notice that appears on any computer display screens
normally generated by, or as a result of, the Software Program.
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b Copying. You may make one (1) copy of the Software Program solely for purposes of backup, archiving, or
installation, provided the copy contains all of the original Software Program’s proprietary notices. You may not
copy the Software Program to any public or distributed network.

c Reservation of Rights. The Software Program, including all fonts, is copyrighted and owned by Lexmark
International, Inc. and/or its suppliers. Lexmark reserves all rights not expressly granted to you in this License
Agreement.

d Freeware. Notwithstanding the terms and conditions of this License Agreement, all or any portion of the
Software Program that constitutes software provided under public license by third parties (“Freeware”) is
licensed to you subject to the terms and conditions of the software license agreement accompanying such
Freeware, whether in the form of a discrete agreement, shrink-wrap license, or electronic license terms at the
time of download. Use of the Freeware by you shall be governed entirely by the terms and conditions of such
license.

6 TRANSFER. You may transfer the Software Program to another end-user. Any transfer must include all software
components, media, printed materials, and this License Agreement and you may not retain copies of the Software
Program or components thereof. The transfer may not be an indirect transfer, such as a consignment. Prior to the
transfer, the end-user receiving the transferred Software Program must agree to all these License Agreement terms.
Upon transfer of the Software Program, your license is automatically terminated. You may not rent, sublicense, or
assign the Software Program except to the extent provided in this License Agreement, and any attempt to do so
shall be void.

7 UPGRADES. To Use a Software Program identified as an upgrade, you must first be licensed to the original Software
Program identified by Lexmark as eligible for the upgrade. After upgrading, you may no longer use the original
Software Program that formed the basis for your upgrade eligibility.

8 LIMITATION ON REVERSE ENGINEERING. You may not alter, decrypt, reverse engineer, reverse assemble, reverse
compile or otherwise translate the Software Program, except as and to the extent expressly permitted to do so by
applicable law for the purposes of inter-operability, error correction, and security testing. If you have such statutory
rights, you will notify Lexmark in writing of any intended reverse engineering, reverse assembly, or reverse
compilation. You may not decrypt the Software Program unless necessary for the legitimate Use of the Software
Program.

9 ADDITIONAL SOFTWARE. This License Agreement applies to updates or supplements to the original Software
Program provided by Lexmark unless Lexmark provides other terms along with the update or supplement.

10 TERM. This License Agreement is effective unless terminated or rejected. You may reject or terminate this license
at any time by destroying all copies of the Software Program, together with all modifications, documentation, and
merged portions in any form, or as otherwise described herein. Lexmark may terminate your license upon notice
if you fail to comply with any of the terms of this License Agreement. Upon such termination, you agree to destroy
all copies of the Software Program together with all modifications, documentation, and merged portions in any
form.

11 TAXES. You agree that you are responsible for payment of any taxes including, without limitation, any goods and
services and personal property taxes, resulting from this Agreement or your Use of the Software Program.

12 LIMITATION ON ACTIONS. No action, regardless of form, arising out of this Agreement may be brought by either
party more than two years after the cause of action has arisen, except as provided under applicable law.

13 APPLICABLE LAW. This Agreement is governed by the laws of the Commonwealth of Kentucky, United States of
America. No choice of law rules in any jurisdiction shall apply. The UN Convention on Contracts for the International
Sale of Goods shall not apply.

14 UNITED STATES GOVERNMENT RESTRICTED RIGHTS. The Software Program has been developed entirely at private
expense. Rights of the United States Government to use the Software Program is as set forth in this Agreement and
as restricted in DFARS 252.227-7014 and in similar FAR provisions (or any equivalent agency regulation or contract
clause).

15 CONSENT TO USE OF DATA. You agree that Lexmark, its affiliates, and agents may collect and use information you
provide in relation to support services performed with respect to the Software Program and requested by you.

Notices 203



Lexmark agrees not to use this information in a form that personally identifies you except to the extent necessary
to provide such services.

16 EXPORT RESTRICTIONS. You may not (a) acquire, ship, transfer, or reexport, directly or indirectly, the Software
Program or any direct product therefrom, in violation of any applicable export laws or (b) permit the Software
Program to be used for any purpose prohibited by such export laws, including, without limitation, nuclear, chemical,
or biological weapons proliferation.

17 AGREEMENT TO CONTRACT ELECTRONICALLY. You and Lexmark agree to form this License Agreement
electronically. This means that when you click the “Agree” or “Yes” button on this page or use this product, you
acknowledge your agreement to these License Agreement terms and conditions and that you are doing so with the
intent to “sign” a contract with Lexmark.

18 CAPACITY AND AUTHORITY TO CONTRACT. You represent that you are of the legal age of majority in the place you
sign this License Agreement and, if applicable, you are duly authorized by your employer or principal to enter into
this contract.

19 ENTIRE AGREEMENT. This License Agreement (including any addendum or amendment to this License Agreement
that is included with the Software Program) is the entire agreement between you and Lexmark relating to the
Software Program. Except as otherwise provided for herein, these terms and conditions supersede all prior or
contemporaneous oral or written communications, proposals, and representations with respect to the Software
Program or any other subject matter covered by this License Agreement (except to the extent such extraneous
terms do not conflict with the terms of this License Agreement, any other written agreement signed by you and
Lexmark relating to your Use of the Software Program). To the extent any Lexmark policies or programs for support
services conflict with the terms of this License Agreement, the terms of this License Agreement shall control.

ADOBE SYSTEMS INCORPORATED NOTICE

Contains Flash®, Flash® Lite™ and/or Reader® technology by Adobe Systems Incorporated

This Product contains Adobe® Flash® player software under license from Adobe Systems Incorporated, Copyright ©
1995-2007 Adobe Macromedia Software LLC. All rights reserved. Adobe, Reader and Flash are trademarks of Adobe
Systems Incorporated.
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printer  170
checking device status 

on Embedded Web Server  168
cleaning 

exterior of the printer  162
Clearing job accounting
statistics  145
Close door or insert cartridge  145
Close finisher side door  145
Confidential print jobs  78

printing from Macintosh
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display troubleshooting 
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setting up e‑mail alerts  168

emission notices  192, 193, 196, 197
Enabling Menus  146
Encrypting disk x/y XX%  146
Enter PIN  146
Envelope Enhance  96
envelopes 

loading  36
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Windows  49

Ethernet port  32
exit bins 

linking  41
exporting a configuration using the
Embedded Web Server  57
exterior of the printer 

cleaning  162
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factory defaults, restoring 
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canceling from Macintosh  82
canceling from Windows  82

print quality test pages, printing  82
print quality troubleshooting 

blank pages  179
clipped images  179
ghost images  179
gray background  180
poor transparency quality  189
print irregularities  181
print is too dark  182
print is too light  183
print quality test pages  178
repeating defects  184

skewed print  184
solid black streaks  185
solid color pages  185
solid white streaks  185
streaked horizontal lines  186
streaked vertical lines  187
toner fog or background

shading  187
toner rubs off  188
toner specks  188

print troubleshooting 
error reading USB drive  171
held jobs do not print  172
incorrect characters print  173
incorrect margins  180
jammed page does not

reprint  178
job prints from wrong tray  173
job prints on wrong paper  173
job takes longer than

expected  172
jobs do not print  171
Large jobs do not collate  174
multiple‑language PDFs do not

print  171
paper curl  181
paper frequently jams  177
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output expander  176
paper trays  175
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printer status 
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printing 
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Programming disk  150
Programming flash  150
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Reattach bin <x>  151
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Repeat print jobs  78

printing from Macintosh
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paper size  75
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paper type  75
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paper  70
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fuser  165
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maintenance kit  164
pick rollers  165
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system board 
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Toner Darkness  58
Too many failed panel logins  154
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ordering  166
transparencies 
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Tray <x> Empty  154
Tray <x> Low  154
Tray <x> Missing  154
trays 
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troubleshooting 
checking an unresponsive
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working  189

solving basic printer
problems  170

troubleshooting, display 
display is blank  170
display shows only diamonds  170

troubleshooting, paper feed 
message remains after jam is

cleared  178
troubleshooting, print 

error reading USB drive  171
held jobs do not print  172
incorrect characters print  173
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jammed page does not

reprint  178
job prints from wrong tray  173
job prints on wrong paper  173
job takes longer than

expected  172
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multiple‑language PDFs do not
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paper curl  181
paper frequently jams  177
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unexpected page breaks
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troubleshooting, print quality 

blank pages  179
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gray background  180
poor transparency quality  189
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print is too light  183
print quality test pages  178
repeating defects  184
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solid black streaks  185
solid color pages  185
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streaked horizontal lines  186
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flash memory card  176
hard disk with adapter  177
high capacity output stacker  176
Internal Solutions Port  177
memory card  176
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paper trays  175
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Universal Paper Size 

setting  74
Universal Setup menu  102
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Unsupported disk  154
Unsupported USB device, please
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Unsupported USB hub, please
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USB port  32
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printing from Macintosh
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reports  169
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Windows 
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using Windows  49
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Wireless menu  110
wireless network 

configuration information  44
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